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Getting Started

Getting Started

1.1 About this help

This help provides you with information and procedures for deploying and configuring your Information
platform services system. Procedures are provided for common tasks. Conceptual information and
technical details are provided for all advanced topics.

For daily maintenance tasks and procedures for working with the CMC, see the Information platform
services Administrator's Guide.

For information about installing this product, see the Information platform services Installation Guide.

1.1.1 Who should use this help?

This help covers deployment and configuration tasks. We recommend consulting this guide if you are:
+ planning your first deployment

-+ configuring your first deployment

» making significant changes to the architecture of an existing deployment

» improving your system's performance.

This help is intended for system administrators who are responsible for configuring, managing, and
maintaining an Information platform services installation. Familiarity with your operating system and
your network environment is beneficial, as is a general understanding of web application server
management and scripting technologies. However, to assist all levels of administrative experience, this

help aims to provide sufficient background and conceptual information to clarify all administrative tasks
and features.

1.1.2 Abhout Information platform services
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Getting Started

Information platform services is a flexible, scalable, and reliable solution for delivering powerful, interactive
reports to end users via any web application—intranet, extranet, Internet or corporate portal. Whether
it is used for distributing weekly sales reports, providing customers with personalized service offerings,
or integrating critical information into corporate portals, Information platform services delivers tangible
benefits that extend across and beyond the organization. As an integrated suite for reporting, analysis,
and information delivery, Information platform services provides a solution for increasing end-user
productivity and reducing administrative efforts.

1.1.3 Variables

The following variables are used throughout this guide.

<INSTALLDIR>

The directory where Information platform services is installed.

On a Windows computer, the default directory is C: \Program Files
(x86) \SAP BusinessObjects\.

<PLAT
FORM64DIR>

The name of your Unix operating system. Acceptable values are:
+ aix_rs6000_64

* linux_x64

» solaris_sparcv9

*  hpux_ia64

<SCRIPTDIR>

The directory where scripts for administering Information platform services are
located.

On a Windows computer, the directory is <INSTALLDIR>\SAP
BusinessObjects Enterprise XI 4.0\win64 x64\scripts

On a Unix computer, the directory is <INSTALLDIR>/sap_bobj/enter
prise xi140/<PLATFORM64DIR>/scripts.

1.2 Before you start
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1.2.1 Key concepts

SAP BusinessObjects Business Intelligence (Bl) platform uses the terms “service” and “server” to refer
to the two types of software running on a Bl platform computer.

A serviceis a server subsystem that performs a specific function. The service runs in the memory space
of its server, under the process ID of the parent container (server). For example, the SAP
BusinessObjects Web Intelligence Scheduling Service is a subsystem that runs on the Adaptive Job
Server.

A serveris a process at the operating system level (on some systems, called a daemon) that hosts one
or more services. For example, the Central Management Server (CMS) and Adaptive Processing Server
are servers. A server runs on a specific operating system account and has its own PID.

A nodeis a collection of Bl platform servers running on the same host and managed by the same Server
Intelligence Agent (SIA). One or more nodes can be on a single host.

Bl platform can be installed on one computer, spread across different computers on an intranet, or
separated over a wide area network (WAN).

1.2.2 Key administrative tools

1.2.2.1 Central Management Console (CMC)

The Central Management Console (CMC) is a web-based tool that you use to perform administrative
tasks (including user, content, and server management) and to configure security settings. Because
the CMC is a web-based application, you can perform all of the administrative tasks in a web browser
on any computer that can connect to the web application server.

All users can log on to the CMC to change their own preference settings. Only members of the
Administrators group can change management settings, unless a user is explicitly granted rights to do
so. Roles can be assigned in the CMC to grant user privileges to perform minor administrative tasks,
such as managing users in your group and managing reports in folders that belong to your team.
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1.2.2.2 Central Configuration Manager (CCM)

The Central Configuration Manager (CCM) is a server troubleshooting and node configuration tool
provided in two forms. In a Microsoft Windows environment, the CCM allows you to manage local and
remote servers through its graphical user interface (GUI) or command line.

You use the CCM to create and configure nodes and to start or stop your web application server, if it
is the default bundled Tomcat web application server. On Windows, it also allows you to configure
network parameters, such as Secure Socket Layer (SSL) encryption. These parameters apply to all
servers within a node.

Note:
Most server management tasks are now handled through the CMC, not through the CCM. The CCM
is now used for troubleshooting and node configuration.

1.2.2.3 Upgrade management tool

Upgrade management tool (formerly Import Wizard) is installed as a part of Information platform services,
and guides administrators through the process of importing users, groups, and folders from previous
versions of Information platform services. It also allows you to import and upgrade objects, events,
server groups, repository objects, and calendars.

For information on upgrading from a previous version of Information platform services, see the Information
platform services Upgrade Guide.

1.2.3 Key tasks

Depending on your situation, you may want to focus on specific sections of this help, and there may
be other resources available for you. For each of the following situations, there is a list of suggested
tasks and reading topics.

Related Topics

¢ Planning or performing your first deployment
» Configuring your deployment

* Improving your system's performance

» Central Management Console (CMC)
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1.2.3.1 Planning or performing your first deployment

If you are planning or performing your first deployment of Information platform services, perform the
following tasks and read the recommended topics:

+  “Architecture overview”

+ “Communication between Information platform services components”

+  “Security overview”

+ “Authentication options in Information platform services”, if you plan to use third-party authentication
+ After installation, “Server Administration”

For more information about installing this product, see the Information Platform Services Installation
Guide.

Related Topics

* Architecture overview

» Communication between Information platform services components
* Security overview

+ Authentication options in Information platform services

 Server Administration

1.2.3.2 Configuring your deployment

If you have just completed your installation of Information platform services and need to perform initial
configuration tasks, such as firewall configuration and user management, it is recommended that you
read the following sections.

Related Topics

» Server Administration
* Security overview

* About Monitoring
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1.2.3.3 Improving your system's performance

If you want to assess your deployment's efficiency and fine-tune it to maximize resources, read the
following sections and perform the tasks described:

+ “About Monitoring” if you want to monitor your existing system

+  “Server Administration” for daily maintenance tasks and procedures for working with servers in the
CMC

Related Topics
 About Monitoring
 Server Administration

1.2.3.4 Working with objects in the CNIC

If you are working with objects in the CMC, read the following sections:
+ For information about setting up users and groups in the CMC, see “Account Management Overview”.
» To set security on objects, see “How rights work in Information platform services”.

» For general information about working with objects, see the Information platform services CMC Help.

Related Topics
» Account management overview
* How rights work in Information platform services
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2.1 Architecture overview

This section outlines the overall platform architecture, system, and service components that make up
the Information platform services Business Intelligence (Bl) platform. The information helps administrators
understand the system essentials and help to form a plan for the system deployment, management,
and maintenance.

Information platform services is designed for high performance across a broad spectrum of user and
deployment scenarios. For example, specialized platform services handle either on-demand data access
and report generation, or report scheduling based on times and events. You can offload processor
intensive scheduling and processing by creating dedicated servers to host specific services. The
architecture is designed to meet the needs of virtually any Bl deployment, and is flexible enough to
grow from several users with a single tool, to tens of thousands of users with multiple tools and interfaces.

To provide flexibility, reliability, and scalability, Information platform services components can be installed
on one or across many machines. You can even install two different versions of Information platform
services simultaneously on the same computer, although this configuration is only recommended as
part of the upgrade process or testing purposes.

Server processes can be “vertically scaled” (where one computer runs several, or all, server-side
processes) to reduce cost, or “horizontally scaled” (where server processes are distributed between
two or more networked machines) to improve performance. It is also possible to run multiple, redundant,
versions of the same server process on more than one machine, so that processing can continue if the
primary process encounters a problem.

2.1.1 System overview

Information platform services is a Business Intelligence (BI) platform that provides enterprise level
analysis and reporting tools. Data can be analyzed from any of a large number of supported database
systems (including text or multi-dimensional OLAP systems) and Bl reports can be published in many
different formats to many different publishing systems.

The following diagram illustrates how Information platform services fits in with your organization's
infrastructure.
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Information platform services reports from a read-only connection to your organization's databases,
and uses its own databases for storing its configuration, auditing, and other operational information.
The Bl reports created by the system can be sent to a variety of destinations, including file systems,
and email, or accessed through web sites or portals.

Information platform services is a self-contained system that can exist on a single machine (for example,
as a small development or pre-production test environment) or can be scaled up into a cluster of many
machines that run different components (for example, as a large-scale production environment).

2.1.2 Datahases

Information platform services uses several different databases.
* Reporting database

This refers to your organization's information. It is the source information analyzed and reported on
by Information platform services. Most commonly, the information is stored within a relational
database, but it can also be contained within text files, Microsoft Office documents, or OLAP systems.

+  CMS system database

The CMS system database is used to store Information platform services information, such as user,
server, folder, document, configuration, authorization, and authentication details. It is maintained by
the Central Management Server (CMS), and is sometimes referred to as the system repository.

» Auditing Data Store
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The Auditing Data Store (ADS) is used to store information on trackable events that occur in
Information platform services. This information can be used to monitor the usage of system
components, user activity, or other aspects of day-to-day operation.

Lifecycle Management database

The Lifecycle Management database tracks configuration and version information related to an
Information platform services installation, as well as updates.

Monitoring database

Monitoring uses the Java Derby database to store system configuration and component information
for SAP supportability.

If you do not have a database server in place for use with the CMS system and Auditing Data Store
databases, the Information platform services installation program can install and configure one for you.
It is recommended that you evaluate your requirements against information from your database server
vendor to determine which supported database would best suit your organization's requirements.

2.1.3 Servers

Information platform services consists of collections of servers running on one or more hosts. Small
installations (such as test or development systems) can use a single host for a web application server,
database server, and all Information platform services servers.

Medium and large installations can have servers running on multiple hosts. For example, a web
application server host can be used in combination with an Information platform services server host.
This frees up resources on the Information platform services server host, allowing it to process more
information than if it also hosted the web application server.

Large installations can have several Information platform services server hosts working together in a
cluster. For example, if an organization has a large number of SAP Crystal Reports users, Crystal
Reports processing servers can be created on multiple Information platform services server hosts to
ensure that there are plenty of resources available to process requests from clients.
The advantages of having multiple servers include:

Improved performance

Multiple Information platform services server hosts can process a queue of reporting information
faster than a single Information platform services server host.

Load balancing

If a server is experiencing a higher load than the other servers in a cluster, the CMS automatically
sends new work to a server with better resources.

Improved availability

If a server encounters an unexpected condition, the CMS automatically re-routes work to different
servers until the condition is corrected.
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2.1.4 Web application servers

A web application server acts as the translation layer between a web browser or rich application, and
Information platform services. Web application servers running on Windows, Unix, and Linux are
supported.

The following web application servers are supported:

+ JBoss

» Oracle Application Server

+ SAP NetWeaver AS Java

* Tomcat

*  WebLogic

+ WebSphere

For a detailed list of supported web application servers, consult the Supported Platforms Guide available
at: http://service.sap.com/bosap-support.

If you do not have a web application server in place for use with Information platform services, the
installation program can install and configure a Tomcat 6 web application server for you. It is
recommended that you evaluate your requirements against information from your web application server
vendor to determine which supported web application server would best suit your organization's
requirements.

Note:

When configuring a production environment, it is recommended that the web application server is hosted
on a separate system. Running Information platform services and a web application server on the same
host in a production environment may decrease performance.

2.1.4.1 Web Application Container Service (WACS)

A web application server is required to host Information platform services web applications.

If you are an advanced Java web application server administrator with advanced administration needs,
use a supported Java web application server to host Information platform services web applications. If
you will be using a supported Windows operating system to host Information platform services, and
prefer a simple web application server installation process, or you do not have the resources to administer
a Java web application server, you can install the Web Application Container Service (WACS) when
installing Information platform services.

WACS is an Information platform services server that allows Information platform services web
applications, such as the Central Management Console (CMC) and Web Services, to run without the
need for a previously installed Java web application server.
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Using WACS to provides a number of advantages:

WACS requires a minimum effort to install, maintain, and configure. It is installed and configured by
the Information platform services installation program, and no additional steps are required to start
using it.

WACS removes the need for Java application server administration and maintenance skills.

WACS provides an administrative interface that is consistent with other Information platform services
servers.

Like other Information platform services servers, WACS can be installed on a dedicated host.

Note:
There are some limitations to using WACS instead of a dedicated Java web applications server:

WACS is only available on supported Windows operating systems.
Custom web applications cannot be deployed to WACS, as it only supports the web applications
installed with Information platform services.

WACS cannot be used with an Apache load balancer.

Itis possible to use a dedicated web application server in addition to WACS. This allows your dedicated
web application server to host custom web applications, while the CMC and other Information platform
services web applications are hosted by WACS.

2.1.5 Language support

Information platform services products are translated into many different languages and supports data
in an even broader selection of languages.

Product interfaces are available in the following languages:

Czech

Simplified Chinese
Traditional Chinese
Danish

Dutch

English

Finnish

French

German

Italian

Japanese

Korean

Norwegian Bokmal
Polish

Portuguese
Russian

23

2012-08-15



Architecture

+ Spanish
+  Swedish
*  Thai

In addition to supporting data in any of the languages available in the interface, the following character
sets are also supported:

* Greek

* Malaysian
* Hebrew

+ Arabic

* Romanian

*  Vietnamese
* Hungarian

«  Turkish

+  Hindi

2.1.6 Authentication and single sign-on

System security is managed by the Central Management Server (CMS), security plug-ins, and third-party
authentication tools, such as SiteMinder or Kerberos. These components authenticate users and
authorize user access for Information platform services, its folders, and other objects.

The following user authentication single sign-on security plug-ins are available:

+ Enterprise (default), including Trusted Authentication support for third-party authentication.
- LDAP

» Windows Active Directory (AD)

When using an Enterprise Resource Planning (ERP) system, single sign-on is used to authenticate
user access to the ERP system so that reports can be against ERP data. The following user
authentication single sign-on for ERP systems are supported:

+  SAP ERP and Business Warehouse (BW)

» Oracle E-Business Suite (EBS)

+ Siebel Enterprise

+ JD Edwards Enterprise One

»  PeopleSoft Enterprise

2.1.6.1 Security plug-ins
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Security plug-ins automate account creation and management by allowing you to map user accounts
and groups from third-party systems into Information platform services. You can map third-party user
accounts to existing Enterprise user accounts, or you can create new Enterprise user accounts that
correspond to each mapped entry in the external system.

The security plug-ins dynamically maintain third-party user and group listings. So, once you map a
Lightweight Directory Access Protocol (LDAP) or Windows Active Directory (AD) group to Information
platform services, all users who belong to that group can log into Information platform services.
Subsequent changes to the third-party group memberships are automatically propagated.

Information platform services supports the following security plug-ins:
* Enterprise security plug-in

The Central Management Server (CMS) handles security information, such as user accounts, group
memberships, and object rights that define user and group privileges. This is known as Enterprise
authentication.

Enterprise authentication is always enabled; it cannot be disabled. Use the system default Enterprise
Authentication if you prefer to create distinct accounts and groups for use with Information platform
services, or if you have not already set up a hierarchy of users and groups on an LDAP or Windows
AD server.

Trusted Authentication is a component of Enterprise authentication that integrates with third-party
single sign-on solutions, including Java Authentication and Authorization Service (JAAS). Applications
that have established trust with the Central Management Server can use Trusted Authentication to
allow users to log on without providing their passwords.

* LDAP security plug-in
+  Windows AD

Note:

Although a user can configure Windows AD authentication for Information platform services and
custom applications through the CMC, the CMC does not support Windows AD authentication with
NTLM. The only methods of authentication that the CMC support are Windows AD with Kerberos,
LDAP, Enterprise, and Trusted Authentication.

2.1.6.2 Enterprise Resource Planning (ERP) integration

An Enterprise Resource Planning (ERP) application supports the essential functions of an organization's
processes by collecting real-time information related to day-to-day operations. SAP BusinessObjects
Business Intelligence platform supports single sign-on and reporting from a number of ERP systems.
See the SAP BusinessObjects Bl 4.0 Product Availability Matrix (PAM) , available at http://ser
vice.sap.com/pam.

SAP ERP and BW support is installed by default. Use the Custom / Expand installation option to deselect
SAP integration support if you do not want support for SAP ERP or BW. Support for other ERP systems
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is not installed by default. Use the "Custom / Expand" installation option to select and install integration
for non-SAP ERP systems.

To configure ERP integration, see the SAP BusinessObjects Business Intelligence Platform Administrator
Guide.

2.1.7 SAP integration

Information platform services integrates with your existing SAP infrastructure with the following SAP
tools:

SAP System Landscape Directory (SLD)

The system landscape directory of SAP NetWeaver is the central source of system landscape
information relevant for the management of your software life-cycle. By providing a directory
comprising information about all installable software available from SAP and automatically updated
data about systems already installed in a landscape, you get the foundation for tool support to plan
software life-cycle tasks in your system landscape.

The Information platform services installation program registers the vendor and product names and
versions with the SLD, as well as server and front-end component names, versions, and location.

SAP Solution Manager

The SAP Solution Manager is a platform that provides the integrated content, tools, and methodologies
to implement, support, operate and monitor an organization's SAP and non-SAP solutions.

Non-SAP software with an SAP-certified integration is entered into a central repository and transferred
automatically to your SAP System Landscape Directories (SLD). SAP customers can then easily
identify which version of third-party product integration has been certified by SAP within their SAP
system environment. This service provides additional awareness for third-party products besides
our online catalogs for third-party products.

SAP Solution Manager is available to SAP customers at no extra charge, and includes direct access
to SAP support and SAP product upgrade path information. For more information on SLD, see
“Registration of Information platform services in the System Landscape” in the Information platform
services Administrator Guide.

CTS Transport (CTS+)

The Change and Transport System (CTS) helps you to organize development projects in ABAP
Workbench and in Customizing, and then transport the changes between the SAP systems in your
system landscape. As well as ABAP objects, you can also transport Java objects (J2EE, JEE) and
SAP-specific non-ABAP technologies (such as Web Dynpro Java or SAP NetWeaver Portal) in your
landscape.

Monitoring with CA Wily Introscope

CA Wily Introscope is a web application management product that delivers the ability to monitor and
diagnose performance problems that may occur within Java-based SAP modules in production,
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including visibility into custom Java applications and connections to back-end systems. It allows you
to isolate performance bottlenecks in NetWeaver modules including individual Servlets, JSPs, EJBs,
JCO'’s, Classes, Methods and more. It offers real-time, low-overhead monitoring, end-to-end
transaction visibility, historical data for analysis or capacity planning, customizable dashboards,
automated threshold alarms, and an open architecture to extend monitoring beyond NetWeaver
environments.

2.1.8 Lifecycle management (LCM)

Lifecycle management (LCM) refers to a set of processes involved in managing an installation's product
information. It establishes procedures for governing the installation of Information platform services to
development, test, production, or maintenance environments.

Information platform services Lifecycle Manager is a web-based tool that enables you to move Bl objects
from one system to another system, without affecting the dependencies of those objects. It also enables
you to manage different versions, manage dependencies, or roll back a promoted object to its previous
state.

The LCM tool is a plug-in for Information platform services. You can promote a Bl object from one
system to another system only if the same version of the application is installed on both the source and
destination systems.

For more information, see the Information platform services Lifecycle management console User's
Guide.

2.1.9 Integrated version control

The files that make up SAP BusinessObjects Business Intelligence platform on a server system are
now kept under version control. The installation program will install and configure the Subversion version
control system, or you can enter details to use an existing Subversion or ClearCase version control
system.

A version control system makes it possible to keep and restore different revisions of configuration and
other files, which means it is always possible to revert the system to a known state from any time in the
past.

2.1.10 Upgrade path
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It's possible to upgrade from a previous release of Information platform services, but you must first
install Information platform services 4.0, then migrate the settings and data from your existing system
with the Upgrade management tool.

For information on how to upgrade from a previous version, see the Information platform services
Upgrade Guide.

2.2 Conceptual tiers

Information platform services can be thought of as a series of conceptual tiers:

Web tier

Management tier Processing fier

Storage tier

Web tier

The web tier contains web applications deployed to a Java web application server. Web applications
provide Information platform services functionality to end users through a web browser. Examples
of web applications include the Central Management Console (CMC) administrative web interface
and Bl launch pad.

The web tier also contains Web Services. Web Services provides Information platform services
functionality to software tools via the web application server, such session authentication, user
privilege management, scheduling, search, administration, reporting, and query management.

Management tier

The management tier coordinates and controls all of the components that make up Information
platform services. It is comprised of the Central Management Server (CMS). The CMS provides
maintains security and configuration information, sends service requests to servers, manages
auditing, and maintains the CMS system database.

Processing tier
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The processing tier analyzes data and produces reports. This is the only tier that accesses the
databases that contain report data.

+ Storage tier

The storage tier is responsible to handling files, such as documents and reports. The Input File

Repository Server manages files that contain information to be used in reports. The Output File
Repository Server manages reports created by the system. The storage tier also handles report
caching to save system resources when users access reports.

2.3 Services and servers

Information platform services uses the terms “server” and “service” to refer to the two types of software
running on an Information platform services computer.

A service is a server subsystem that performs a specific function. The service runs within the memory
space of its server under the process ID of the parent container (server). For example, the Interactive
Analysis Scheduling and Publishing Service is a subsystem that runs on the Adaptive Job Server.

A server is used to describe an operating system level process (on some systems, this is referred to
as a daemon) hosting one or more services. For example, the Central Management Server (CMS) and
Adaptive Processing Server are servers. A server runs under a specific operating system account and
has its own PID.

A node is a collection of Information platform services servers running on the same host and managed
by the same Server Intelligence Agent (SIA). One or more nodes can be on a single host.

Information platform services can be installed on a single computer, spread across different computers
on an intranet, or separated over a wide area network (WAN).

Services, servers, nodes, and hosts

The following diagram shows a hypothetical installation of Information platform services. The number
of hosts, nodes, servers and services—and the type of servers and services—varies in actual
installations.
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Two hosts form the cluster named ProductionBISystem, which has two hosts:

«  The host named HostAlpha has Information platform services installed and is configured with two
nodes:

*  NodeMercury contains an Adaptive Job Server (NodeMercury.AJS) with services to schedule
and publish reports, an Input File Repository Server (NodeMercury . IFRS) with a service to
store input reports, and an Output File Repository Server (NodeMercury.OFRS) with a service
to store report output.

*  NodeVenus contains an Adaptive Processing Server (NodeVenus . APS) with services to provide
publishing, monitoring, and translation features, an Adaptive Processing Server (Node
Venus.APS2) with a service to provide client auditing, and a Central Management Server
(NodeVenus . CMS) with a service to provide the CMS services.

« The host named HostBeta has Information platform services installed and is configured with three
nodes:

*  NodeMars contains a Central Management Server (NodeMars .CMS) with a service to provide
the CMS services.

Having the CMS on two computers enables load balancing and mitigation and failover capabilities.
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+ Nodedupiter contains a Interactive Analysis Processing Server (NodeJupiter.Interactive
Analysis) with a service to provide Interactive Analysis reporting, and an Event Server (Node
Jupiter.EventServer) to provide report monitoring of files.

» NodeSaturn contains an Adaptive Processing Server (NodeSaturn.APS) with a service to
provide client auditing.

Related Topics
« Server Administration

2.3.1 Services

When adding servers, you must include some services on the Adaptive Job Server—for example, the
Destination Delivery Scheduling Service.

Note:
New services or server types may be added in future maintenance releases.

Service Service category Server type Service description

Provides synchroniza-
Core Services Adaptive Job Server tion of updates for third-
party security plugins

Authentication Update
Scheduling Service

Provides server, user,
session management,
and security (authoriza-
tion and authentication)
management. At least
one Central Manage-
ment Service must be
available in a cluster for
the cluster to operate.

Central Management . Central Management
. Core Services
Service Server

Runs scheduled jobs
and publishes the re-
sults to a given output
location, such as the
file system, FTP, email,
or a user's inbox

Destination Delivery

Scheduling Service Core Services Adaptive Job Server
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Input Filestore Service

Service category

Core Services

Server type

Input File Repository
Server

‘ Service description

Maintains published re-
port and program ob-
jects that can be used
in the generation of
new reports when an
input file is received

Lifecycle Management
ClearCase Service

Lifecycle Management
Services

Adaptive Processing
Server

Provides ClearCase
support for LCM

Lifecycle Management
Scheduling Service

Lifecycle Management
Services

Adaptive Job Server

Runs scheduled Lifecy-
cle Management jobs

Lifecycle Management
Service

Lifecycle Management
Services

Adaptive Processing
Server

Lifecycle Management
Core service

Monitoring Service

Core Services

Adaptive Processing
Server

Provides monitoring
functions

Multi Dimensional
Analysis Service

Advanced Analysis
Services

Adaptive Processing
Server

Provides access to
multi-dimensional On-
line Analytical Process-
ing (OLAP) data; con-
verts the raw data into
XML, which can be
rendered into Excel,
PDF, or Advanced
Analysis (formerly Voy-
ager) crosstabs and
charts

Output Filestore Ser-
vice

Core Services

Output File Repository
Server

Maintains collection of
completed documents

Probe Scheduling Ser-
vice

Core Services

Adaptive Job Server

Provides scheduled
Probe jobs and publish-
es the results to a given
output location

Program Scheduling
Service

Core Services

Adaptive Job Server

Runs programs that
have been scheduled
to run at a given time

RESTful Web Service

Core Services

Web Application Con-
tainer Server (WACS)

Provides session han-
dling for RESTful Web
Service requests.

Security Query
Scheduling Service

Core Services

Adaptive Job Server

Runs scheduled Securi-
ty Query jobs
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Service Service category Server type Service description

Security Token Service | Core Services Adaptive Processing SAP Single Sign-On
Server support

Web Services SDK and Core Services Web Application Con- | Web Services on

QaaWs tainer Server WACS

Related Topics

« Service categories
« Server types

2.3.2 Service categories

Note:
New services or server types may be added in future maintenance releases.

Service category Service Server type
Advanced Analysis Services \I\//ilggl Dimensional Analysis Ser- Adaptive Processing Server
Core Services Authentlgatlon Update Schedul- Adaptive Job Server
ing Service
Core Services Central Management Service Central Management Server
Core Services Client Auditing Proxy Service Adaptive Processing Server
Core Services Destl_natlon Delivery Scheduling Adaptive Job Server
Service
Core Services Input Filestore Service Input File Repository Server
Core Services Monitoring Service Adaptive Processing Server
Core Services Output Filestore Service Output File Repository Server
Core Services Probe Scheduling Service Adaptive Job Server
Core Services Program Scheduling Service Adaptive Job Server
. . Web Application Container
Core Services RESTful Web Service Server (WACS)
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Service category

Core Services

Service

Security Query Scheduling Ser-
vice

Server type

Adaptive Job Server

Core Services

Security Token Service

Adaptive Processing Server

Lifecycle Management Services

LifeCycle Management
ClearCase Service

Adaptive Processing Server

Lifecycle Management Services

Lifecycle Management
Scheduling Service

Adaptive Job Server

Lifecycle Management Services

Lifecycle Management Service

Adaptive Processing Server

Related Topics
+ Services
* Server types

2.3.3 Server types

Note:

New services or server types may be added in future maintenance releases.

Server type

Adaptive Job Server

Service

Authentication Update Schedul-
ing Service

Service category

Core Services

Adaptive Job Server

Destination Delivery Scheduling
Service

Core Services

Adaptive Job Server

Lifecycle Management
Scheduling Service

Lifecycle Management Services

Adaptive Job Server

Probe Scheduling Service

Core Services

Adaptive Job Server

Program Scheduling Service

Core Services

Adaptive Job Server

Security Query Scheduling Ser-
vice

Core Services

Adaptive Processing Server

Client Auditing Proxy Service

Core Services
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Server type Service Service category

Lifecycle Management

Adaptive Processing Server ClearCase Service

Lifecycle Management Services

Adaptive Processing Server Lifecycle Management Service | Lifecycle Management Services

Adaptive Processing Server Monitoring Service Core Services

Multi Dimensional Analysis Ser-

Adaptive Processing Server Advanced Analysis Services

vice
Adaptive Processing Server Security Token Service Core Services
Central Management Server Central Management Service Core Services
Dashboard Analytics Server Dashboard Analytics Service Core Services
Input File Repository Server Input Filestore Service Core Services
Output File Repository Server | Output Filestore Service Core Services
Web Application Container RESTful Web Service Core Services

Server (WACS)

Related Topics

» Services
+ Service categories

2.3.4 Server categories

Servers are collections of services running under a Server Intelligence Agent (SIA) on a host. The type
of server is denoted by the services running within it. Servers can be created in the Central Management
Console (CMC). The following table lists the different types of servers that can be created in the CMC.
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Adaptive Job Server General server that processes scheduled jobs. When you add a Job server

to the Information platform services system, you can configure the Job
server to process reports, documents, programs, or publications and send
the results to different destinations.

Adaptive Processing A generic server that hosts services responsible for processing requests
Server from a variety of sources.
Note:

The installation program installs one Adaptive Processing Server (APS) per
host system. Depending on the features that you've installed, this APS may
host a large number of services, such as the Monitoring Service, Lifecycle
Management Service, Multi-Dimensional Analysis Service (MDAS), Publish-
ing Service, and others.

If you are installing a production environment, do not use the default APS.
Instead, it is highly recommended that once the installation process is
complete, you perform a system sizing to determine:

+  The type and number of APS services.

» The distribution of services across multiple APS servers.

+  The optimal number of APS servers. Multiple APS servers provide re-
dundancy, better performance, and higher reliability.

« The distribution of APS servers across multiple nodes.

Create new APS server instances as determined by the sizing process.

For example, if the outcome of your sizing happens to suggest the creation
of one APS for each service category, then may end up creating eight APS
servers. One for each service category: Advanced Analysis Services,
Connectivity Services, Core Services, Crystal Reports Services, Dashboards
Services, Data Federation Services, Lifecycle Management Services, and
Interactive Analysis Services.

Central Management Maintains a database of information about your Information platform services
Server (CMS) system (in the CMS system database) and audited user actions (in the
Auditing Data Store). All platform services are managed by the CMS. The
CMS also controls access to the system files where documents are stored,
and information on users, user groups, security levels (including authenti-
cation and authorization), and content.

File Repository Server [ Responsible for the creation of file system objects, such as exported reports,
and imported files in non-native formats. An Input FRS stores report and
program objects that have been published to the system by administrators
or end users. An Output FRS stores all of the report instances generated
by the Job Server.
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2.4 Client applications

You can interact with Information platform services using two different types of desktop applications:

Desktop applications

These applications must be installed on a supported Microsoft Windows operating system, and can
process data and create reports locally.

Desktop clients allow you to offload some Bl report processing onto individual client computers.
Most desktop applications directly access your organization's data through drivers installed on the
desktop, and communicate with your Information platform services deployment through CORBA or
encrypted CORBA SSL.

Web applications

These applications are hosted by a web application server and can be accessed with a supported
web browser on Windows, Macintosh, Unix, and Linux operating systems.

This allows you to provide business intelligence (BI) access to large groups of users, without the
challenges of deploying desktop software products. Communication is conducted over HTTP, with
or without SSL encryption (HTTPS).

2.4.1 Central Configuration Manager (CCM)

The Central Configuration Manager (CCM) is a server troubleshooting and node configuration tool
provided in two forms. In a Microsoft Windows environment, the CCM allows you to manage local and
remote servers through its graphical user interface (GUI) or command line.

You use the CCM to create and configure nodes and to start or stop your web application server, if it
is the default bundled Tomcat web application server. On Windows, it also allows you to configure
network parameters, such as Secure Socket Layer (SSL) encryption. These parameters apply to all
servers within a node.

Note:
Most server management tasks are now handled through the CMC, not through the CCM. The CCM
is now used for troubleshooting and node configuration.

2.4.2 Upgrade management tool

Upgrade management tool (formerly Import Wizard) is installed as a part of Information platform services,
and guides administrators through the process of importing users, groups, and folders from previous
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versions of Information platform services. It also allows you to import and upgrade objects, events,
server groups, repository objects, and calendars.

For information on upgrading from a previous version of Information platform services, see the Information
platform services Upgrade Guide.

2.4.3 Webh application clients

Web application clients reside on a web application server, and are accessed on a client machine web
browser. Web applications are automatically deployed when you install Information platform services.

Web applications are easy for users to access from a web browser, and communication can be secured
with SSL encryption if you plan to allow users access from outside your organization's network.

Java web applications can also be reconfigured or deployed after the initial installation by using the
bundled WDeploy command-line tool, which allows you to deploy web applications to a web application
server in two ways:

1. Standalone mode

All web application resources are deployed to a web application server that serves both dynamic
and static content. This arrangement is suitable for small installations.

2. Split mode

The web application's static content (HTML, images, CSS) is deployed to a dedicated web server,
while dynamic content (JSPs) is deployed to a web application server. This arrangement is suitable
for larger installations that will benefit from the web application server being freed up from serving
static web content.

For more information about WDeploy, see the Information platform services Web Application Deployment
Guide.

2.4.3.1 Central Management Console (CNC)

The Central Management Console (CMC) is a web-based tool that you use to perform administrative
tasks (including user, content, and server management) and to configure security settings. Because
the CMC is a web-based application, you can perform all of the administrative tasks in a web browser
on any computer that can connect to the web application server.

All users can log on to the CMC to change their own preference settings. Only members of the
Administrators group can change management settings, unless a user is explicitly granted rights to do
so. Roles can be assigned in the CMC to grant user privileges to perform minor administrative tasks,
such as managing users in your group and managing reports in folders that belong to your team.
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2.5 Process Workflows

When tasks are performed such as logging in or scheduling an object, information flows through the
system and the servers communicate with each other. The following section describes some of the
process flows as they would happen in the Information platform services system.

2.5.1 Startup and authentication

2.5.1.1 Logging on to Information platform services

This workflow describes a user logging on to a Information platform services web application such as
the Central Management Console (CMC) from a web browser.

1.

The browser (web client) sends the login request via the web server to the web application server,
where the web application is running.

2. The web application server determines that the request is a logon request. The web application
server sends the username, password, and authentication type to the CMS for authentication.

3. The CMS validates the username and password against the appropriate database. In this case,
Enterprise authentication is used, and user credentials are authenticated against the CMS system
database).

4. Upon successful validation, the CMS creates a session for the user in memory.

5. The CMS sends a response to the web application server to let it know that the validation was
successful.

6. The web application server generates a logon token for the user session in memory. For the rest of
this session, the web application server uses the logon token to validate the user against the CMS.
The web application server generates the next web page to send to the web client.

7. The web application server sends the next web page to the web server.

8. The web server sends the web page to the web client where it is rendered in the user's browser.

2.5.1.2 SIA start-up
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A Server Intelligence Agent (SIA) can be configured to start automatically with the host operating system,
or can be started manually with Central Configuration Manager (CCM).

A SIA retrieves information about the servers it manages from a Central Management Server (CMS).
If the SIA uses a local CMS, and that CMS is not running, the SIA starts the CMS. If a SIA uses a remote
CMS, it attempts to connect to the CMS.

Once a SIA is started, the following sequence of events is performed.

1.

The SIA looks in its cache to locate a CMS.
a. If the SlA is configured to start a local CMS, and the CMS is not running, the SIA starts the CMS
and connects.

b. If the SIA is configured to use a running CMS (local or remote), it attempts to connect to the first
CMS in its cache. If the CMS is not currently available, it attempts to connect to the next CMS
in the cache. If none of the cached CMSs are available, the SIA waits for one to become available.

2. The CMS confirms the SIA's identity to ensure that it is valid.

3. Once the SIA has successfully connected to a CMS, it requests a list of servers to manage.
Note:

A SIA does not store information about the servers it manages. The configuration information that
dictates which server is managed by a SIA is stored in the CMS system database and is retrieved
from the CMS by the SIA when it starts.

4. The CMS queries the CMS system database for a list of servers managed by the SIA. The
configuration for each server is also retrieved.

5. The CMS returns the list of servers, and their configuration, to the SIA.

6. For each server configured to start automatically, the SIA starts it with the appropriate configuration
and monitors its state. Each server started by the SIA is configured to use the same CMS used by
the SIA.

Any servers not configured to start automatically with the SIA will not start.
2.5.1.3 SIA shutdown

You can automatically stop the Server Intelligence Agent (SIA) by shutting down the host operating
system, or you can manually stop the SIA in the Central Configuration Manager (CCM).

When the SIA shuts down, the following steps are performed.

The SIA tells the CMS that it is shutting down.

a. If the SIA is stopping because the host operating system is shutting down, the SIA requests its
servers to stop. Servers that do not stop within 25 seconds are forcefully terminated.

b. If the SIA is being stopped manually, it will wait for the managed server to finish processing
existing jobs. Managed servers will not accept any new jobs. Once all jobs are complete, the
servers stop. Once all servers have stopped, the SIA stops too.
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Note:
During a forced shutdown, the SIA tells all managed servers to stop immediately.

2.5.2 Program objects

2.5.2.1 A scheduled program ohject runs

This workflow describes the process of a scheduled program object running at a scheduled time.

1.

The Central Management Server (CMS) checks the CMS system database to determine if there is
any scheduled SAP Crystal report to be run at that time.

. When scheduled job time arrives, the CMS locates an available Program Scheduling Service running

on an Adaptive Job Server. The CMS sends the job information to the Program Scheduling Service.

. The Program Scheduling Service communicates with the Input File Repository Server (FRS) to

obtain the program object.

Note:
This step also requires communication with the CMS to locate the required server and objects.

The Program Scheduling Service launches the program.

The Program Scheduling Service updates the CMS periodically with the job status. The current
status is Processing.

. The Program Scheduling Service sends a log file to the Output FRS. The Output FRS notifies the

Program Scheduling Service that the object was scheduled successfully by sending an object log
file.

Note:
This step also requires communication with the CMS to locate the required server and objects.

. The Program Scheduling Service updates the CMS with the job status. The current status is Success.
. The CMS updates the job status in its memory and then writes the instance information to the CMS

system database.

2.5.2.2 Setting a schedule for a program ohject

This workflow describes the process of a user scheduling a program object to be run at a future time
from a web application such as the Central Management Console (CMC).
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. The user sends the schedule request from the web client via the the web server to the web application

server.

. The web application server interprets the request and determines that the request is a schedule

request. The web application server sends the schedule time, database login values, parameter
values, destination, and format to the specified Central Management Server (CMS).

. The CMS ensures that the user has rights to schedule the object. If the user has sufficient rights,

the CMS adds a new record to the CMS system database. The CMS also adds the instance to its
list of pending schedules.

. The CMS sends a response to the web application server to let it know that the schedule operation

was successful.

. The web application server generates the next HTML page and sends it via the web server to the

web client.
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Managing Licenses

3.1 Managing License keys

This section describes how to manage license keys for your Information platform services deployment.

Related Topics

* To add a license key

* To view license information

* To view current account activity

3.1.1 To view license information

The License Keys management area of the CMC identifies the number of role-based (Bl Viewer and
Bl Analyst), concurrent, named, and processor licenses that are associated with each key.

1. Go to the License Keys management area of the CMC.
2. Select a license key.

The details associated with the key appear in the License Key Information area. To purchase
additional license keys, contact your SAP sales representative.

Related Topics

* Managing License keys

» To add a license key

* To view license information

3.1.2 To add a license key
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If you are upgrading from a trial version of the product, be sure to delete the Evaluation key prior to
adding any new license keys or product activation keycodes.

1. Go to the License Keys management area of the CMC.
2. Type the key in the Add Key field.
3. Click Add.

The key is added to the list.

Related Topics

* To add a license key
* To view current account activity

3.1.3 To view current account activity

1. Go to the Settings management area of the CMC.
2. Click View global system metrics.

This section displays current license usage, along with additional job metrics.

Related Topics

* Managing License keys

» To add a license key

* To view license information

3.2 Measuring licenses

The BusinessObjects License Measurement Tool (BOLMT) is a java command-line utility used to collect
and store Information platform services licensing data. The output XML document contains license
deployment measurements and is sent to SAP Global License Auditing Services (GLAS) for consolidation
as part of a license audit.

The system administrator installs and runs BOLMT for every Information platform services cluster
whenever a license audit is requested. BOLMT collects usage measurements on role-based, named,
and concurrent user licenses.

The administrator can specify a particular output directory for the XML document, and configure the
output document to not contain any information that may be used to identify system users.
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3.2.1 To run a license audit

To perform a license audit, you will need administrator rights and access to the directory containing the
BOLMT. jar file in the Information platform services installation.

1. Open a command line console.

2. Change directories to the directory containing the java executables for your Information platform
services installation

By default the file is installed in the <INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\java\lib directory.

3. Execute the BOLMT .jar.
The execution command is entered in the following format: -jar BOLMT. jar [options] <outputFile>
The table below summarizes the available options:

-C --Cms Specifies the name identifier and port number for the Central Management
Server (CMS). Specified as cmsname:port number. By default, the CMS
settings for the local host are used if this setting is not specified.

-p --password Specifies the administrator account password used to connect to the CMS.

-a--auth Specifies the authentication method to connect user to the CMS. Default method
is Enterprise specified as secEnterprise.

-s--sanitize Specifies that the output audit document should filter out any personal informa-
tion that may be used to identify users.

Note:

The output file specification is always the last argument in the command line. It is an optional setting.
If no argument is specified, the output goes to the console's standard output. You can also pipe
output to script as a command line argument.

Example:

C:\Program Files (x86)\SAP

Business Objects\SAP BusinessObjects Enterprise XI 4.0\java\lib>"C:\Program Files
(x86) \SAP Business Objects\SAP BusinessObjects Enterprise XI 4.0\win64_x64\sapjvm\bin
\java.exe" -jar BOLMT.jar --cms=mycms:6400 -uAdministrator

-p=7juujg --auth=secEnterprise --sanitize audit.xml
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4.1 Account management overview

Account management involves all of the tasks related to creating, mapping, changing, and organizing
user and group information. The "Users and Groups" management area of the Central Management
Console (CMC) provides a central place to perform these tasks.

After the user accounts and groups have been created, you can add objects and specify rights to them.
When the users log on, they can view the objects using Bl launch pad or their custom web application.

4.1.1 User management

In the "Users and Groups" management area, you can specify everything required for a user to access
Information platform services. You can also view the two default user accounts summarized by the
“Default user accounts” table.

Table 4-1: Default user accounts

This user belongs to the Administrators and
Everyone groups. An administrator can perform
Administrator all tasks in all Information platform services appli-
cations (for example, the CMC, CCM, Publishing
Wizard, and Bl launch pad).

This user belongs to the Everyone group. This
account is enabled by default, and is not assigned

Guest a password by the system. If you assign it a
password, the single sign-on to Bl launch pad will
be broken.

This is a read-only account used by SAP Solution
SMAdmin Manager to access Information platform services
components.
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4.1.1.1 Role-hased licensing

Under the user-role based licensing scheme, there are two roles which can be assigned to Information
platform services users:

+ Bl Analyst
* Bl Viewer

Each role is bundled with specific access levels to Information platform services applications. You
cannot modify or override the access level to either user role. User roles apply to new user accounts
created in Information platform services or existing users imported from third party directory services
such as Windows AD or LDAP.

Note:

User roles should not be confused with group membership. When you assign a user one of the two
available roles, the user is automatically assigned predefined rights to applications. To associate a user
with specific group access levels, you must add the user to the desired group.

Click License Key in the CMC for more information on your licensing scheme, or contact your SAP
Business Objects account manager for further information on access rights for each user role.

4.1.1.1.1 Bl Analyst role

The Bl Analyst role is designed for users who create content in the Information platform services system.
Users who edit or create reports, design and manage universes, or perform any administrative tasks
in the CMC should be assigned the Bl Analyst role.

4.1.1.1.2 Bl Viewer role

The Bl Viewer role is designed primarily for content consumers. These users only view reports but do
not modify content.

Users assigned to the Bl Viewer role will be prevented by the system from creating content, modifying
reports and performing general administrative tasks in the system. The Bl Viewer role should not be
assigned to users who need to:

+ Create reports

» Update or modify reports

»  Perform administrative tasks using the CMC

Note:
Bl Viewer users cannot access the CMC.
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4.1.2 Group management

Groups are collections of users who share the same account privileges; therefore, you may create
groups that are based on department, role, or location. Groups enable you to change the rights for
users in one place (a group) instead of modifying the rights for each user account individually. Also,
you can assign object rights to a group or groups.

In the "Users and Groups" area, you can create groups that give a number of people access to the
report or folder. This enables you to make changes in one place instead of modifying each user account
individually. You can also view the several default group accounts summarized by the “Default group
accounts” table.

To view available groups in the CMC, click Group List in the Tree panel. Alternatively, you can click
Group Hierarchy to display a hierarchal list of all available groups.

Table 4-2: Default group accounts

Members of this group can perform all tasks in all
of the Information platform services applications
Administrators (CMC, CCM, Publishing Wizard, and BI launch
pad). By default, the Administrators group con-
tains only the Administrator user.

Everyone Each user is a member of the Everyone group.

Members of this group have access to Query as

QaaWs Group Designer 2 Web Service.

Members of this group have access to the Report

Report Conversion Tool Users ) L
Conversion Tool application.

Members of this group have access to the

Translators Translation Manager application.
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Universe Designer Users

Users who belong to this group are granted ac-
cess to the Universe Designer folder and the
Connections folder. They can control who has
access rights to the Designer application. You
must add users to this group as needed. By de-
fault, no user belongs to this group.

Related Topics
* How rights work in Information platform services

» Granting access to users and groups

4.1.3 Available authentication types

Before setting up user accounts and groups within Information platform services, decide which type of
authentication you want to use. The “Authentication types” table summarizes the authentication options
which may be available to you, depending on the security tools your organization uses.

Table 4-3: Authentication types

Enterprise

Use the system default Enterprise Authentication
if you prefer to create distinct accounts and
groups for use with Information platform services,
or if you have not already set up a hierarchy of
users and groups in an LDAP directory server, or
a Windows AD server.

LDAP

If you set up an LDAP directory server, you can
use existing LDAP user accounts and groups in
Information platform services. When you map
LDAP accounts to Information platform services,
users are able to access Information platform
services applications with their LDAP user name
and password. This eliminates the need to recre-
ate individual user and group accounts within In-
formation platform services.
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You can use existing Windows AD user accounts
and groups in Information platform services. When
you map AD accounts to Information platform
services, users are able to log on to Information
platform services applications with their AD user
name and password. This eliminates the need to
recreate individual user and group accounts
within Information platform services.

Windows AD

You can map existing SAP roles into Information
platform services accounts. After you map SAP
roles, users are able to log on to Information
SAP platform services applications with their SAP
credentials. This eliminates the need to recreate
individual user and group accounts within Informa-
tion platform services.

You can map existing Oracle EBS roles into Infor-
mation platform services accounts. After you map
Oracle EBS roles, users are able to log on to In-
Oracle EBS formation platform services applications with their
Oracle EBS credentials. This eliminates the need
to recreate individual user and group accounts
within Information platform services.

You can map existing Siebel roles into Information
platform services accounts. After you map Siebel
roles, users are able to log on to Information
Siebel platform services applications with their Siebel
credentials. This eliminates the need to recreate
individual user and group accounts within Informa-
tion platform services.

You can map existing PeopleSoft roles into Infor-
mation platform services accounts. After you map
PeopleSoft roles, users are able to log on to Infor-
PeopleSoft Enterprise mation platform services applications with their
PeopleSoft credentials. This eliminates the need
to recreate individual user and group accounts
within Information platform services.

You can map existing JD Edwards roles into Infor-
mation platform services accounts. After you map
JD Edwards roles, users are able to log on to In-
JD Edwards EnterpriseOne formation platform services applications with their
JD Edwards credentials. This eliminates the need
to recreate individual user and group accounts
within Information platform services.
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4.2 Managing Enterprise and general accounts

Since Enterprise authentication is the default authentication method for Information platform services,
it is automatically enabled when you first install the system. When you add and manage users and
groups, Information platform services maintains the user and group information within its database.

Note:

When a user logs off their web session on Information platform services by navigating to a
non-Information platform services page or closing their web browser, their Enterprise session is not
logged off and they still hold a license. The Enterprise session will time out after approximately 24 hours.
To end the user's Enterprise session and free the license for use by others, the user must log out of
Information platform services.

4.2.1 To create a user account

When you create a new user, you specify the user's properties and select the group or groups for the
user.
1. Go to the "Users and Groups" management area of the CMC.
2. Click Manage > New > New User.
The "New User" dialog box appears.

3. To create an Enterprise user,
a. Select Enterprise from the Authentication Type list.
b. Type the account name, full name, email, and description information.
Tip:
Use the description area to include extra information about the user or account.

c. Specify the password information and settings.

4. To create a user that will logon using a different authentication type, select the appropriate option
from the Authentication Type list, and type the account name.

5. Specify how to designate the user account according to options stipulated by your Information
platform services license agreement.

If your license agreement is based on user roles, select one of the following options:

- Bl Viewer: access to Information platform services applications for all accounts under the Bl
Viewer role is defined in the license agreement. Users are restricted to access application
workflows that are defined for the Bl Viewer role. Access rights are generally limited to viewing
business intelligence documents. This role is typically suitable for users who consume content
through Information platform services applications.

- Bl Analyst: access to Information platform services applications for all accounts under the Bl
Analyst role is defined in the license agreement. Users can access all applications workflows
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that are defined for the Bl Analyst role. Access rights include viewing and modifying business
intelligence documents. This role is typically suitable for users who create and modify content
for Information platform services applications

If your license agreement is not based on user roles, specify a connection type for the user account.
+  Choose Concurrent User if this user belongs to a license agreement that states the number of
users allowed to be connected at one time.

+  Choose Named User if this user belongs to a license agreement that associates a specific user
with a license. Named user licenses are useful for people who require access to Information
platform services regardless of the number of other people who are currently connected.

. Click Create & Close.

The user is added to the system and is automatically added to the Everyone group. An inbox is
automatically created for the user, together with an Enterprise alias. You can now add the user to
a group or specify rights for the user.

Related Topics

* How rights work in Information platform services
* Role-based licensing

4.2.2 To modify a user account

Use this procedure to modify a user's properties or group membership.

Note:
The user will be affected if he or she is logged on when you are making the change.

1.
2.
3.

5.

Go to the "Users and Groups" management area of the CMC.
Select the user whose properties you want to change.

Click Manage > Properties.

The "Properties" dialog box for the user appears.

. Modify the properties for the user.

In addition to all of the options that were available when you initially created the account, you now
can disable the account by selecting the Account is disabled check box.

Note:
Any changes you make to the user account do not appear until the next time the user logs on.

Click Save & Close.

Related Topics

* To create a new alias for an existing user
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4.2.3 To delete a user account

Use this procedure to delete a user's account. The user might receive an error if they are logged on
when their account is deleted. When you delete a user account, the Favorites folder, personal categories,
and inbox for that user are deleted as well.

If you think the user might require access to the account again in the future, select the Account is
disabled check box in the "Properties" dialog box of the selected user instead of deleting the account.

Note:

Deleting a user account won't necessarily prevent the user from being able to log on to Information
platform services again. If the user account also exists in a third-party system, and if the account belongs
to a third-party group that is mapped to Information platform services, the user may still be able to log

on.
1.
2,
3.

Go to the "Users and Groups" management area of the CMC.
Select the user you want to delete.
Click Manage > Delete.

The delete confirmation dialog box appears.

. Click OK.

The user account is deleted.

Related Topics

» To modify a user account
* To disable an alias

4.2.4 To create a new group

3.
4,

. Go to the "Users and Groups" management area of the CMC.
. Click Manage > New > New Group.

The "Create New User Group" dialog box appears.

Enter the group name and description.
Click OK.

After creating a new group, you can add users, add subgroups, or specify group membership so that
the new group is actually a subgroup. Because subgroups provide you with additional levels of
organization, they are useful when you set object rights to control users' access to your Information
platform services content.
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4.2.5 To modify a group's properties

You can modify a group's properties by making changes to any of the settings.

Note:
The users who belong to the group will be affected by the modification the next time they log on.

1.
2,

In the "Users and Groups" management area of the CMC, select the group.
Click Manage > Properties.
The "Properties" dialog box appears.

. Modify the properties for the group.

Click the links from the navigation list to access different dialog boxes and modify different properties.
+ If you want to change the title or description for the group, click Properties.

- If you want to modify the rights that principals have to the group, click User Security.

+ If you want to modify profile values for group members, click Profile Values.

- If you want to add the group as a subgroup to another group, click Member Of.

. Click Save.

4.2.6 To view group members

You can use this procedure to view the users who belong to a specific group.

1.
2,
3.

Go to the "Users and Groups" management area of the CMC.
Expand Group Hierarchy in the Tree panel.

Select the group in the Tree panel.

Note:

It may take a few minutes for your list to display if you have a large number of users in the group or
if your group is mapped to a third-party directory.

The list of users who belong to the group is displayed.

4.2.7 To add subgroups

You can add a group to another group. When you do this, the group that you added becomes a subgroup.
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Note:
Adding a subgroup is similar to specifying group membership.

1.

4,

In the "Users and Groups" management area of the CMC, select the group that you want to add as
a subgroup to another group.

. Click Actions > Join Group.

The "Join Group" dialog box appears.

Move the group that you want to add the first group to from the Available Groups list to the
Destination Group(s) list.

Click OK.

Related Topics
* To specify group membership

4.2.8 To specify group membership

You can make a group a member of another group. The group that becomes a member is referred to
as a subgroup. The group that you add the subgroup to is the parent group. A subgroup inherits the
rights of the parent group.

1.

In the "Users and Groups" management area of the CMC, click the group that you want to add to
another group.

. Click Actions > Member Of.

The "Member Of" dialog box appears.

. Click Join Group.

The "Join Group" dialog box appears.

. Move the group that you want to add the first group to from the Available Groups to the Destination

Group(s) list.

Any rights associated with the parent group will be inherited by the new group you have created.

. Click OK.

You return to the "Member Of" dialog box, and the parent group appears in the parent groups list.

4.2.9 To delete a group

You can delete a group when that group is no longer required. You cannot delete the default groups
Administrator and Everyone.
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Note:

+  The users who belong to the deleted group will be affected by the change the next time they log on.
+  The users who belong to the deleted group will lose any rights they inherited from the group.

To delete a third-party authentication group, such as the SAP BusinessObjects Windows AD Users
group, use the "Authentication” management area in CMC.

1. Go to the "Users and Groups" management area of the CMC.
2. Select the group you want to delete.
3. Click Manage > Delete.

The delete confirmation dialog box appears.

4. Click OK.
The group is deleted.

4.2.10 To enable the Guest account

The Guest account is disabled by default to ensure that no one can log on to Information platform
services with this account. This default setting also disables the anonymous single sign-on functionality
of Information platform services, so users will be unable to access Bl launch pad without providing a
valid user name and password.

Perform this task if you want to enable the Guest account so that users do not require their own accounts
to access Bl launch pad.

1. Go to the "Users and Groups" management area of the CMC.
2. Click User List in the Navigation panel.
3. Select Guest.
4. Click Manage > Properties.
The "Properties" dialog box appears.

o

Clear the Account is disabled check box.
6. Click Save & Close.

4.2.11 Adding users to groups

You can add users to groups in the following ways:

+ Select the group, and then click Actions > Add Members to Group.
+ Select the user, and then click Actions > Member Of.

» Select the user, and then click Actions > Join Group.
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The following procedures describe how to add users to groups using these methods.

Related Topics
* To specify group membership

4.2.11.1 To add a user to one or more groups

. Go to the "Users and Groups" management area of the CMC.
. Select the user that you want to add to a group.
. Click Actions > Join Group.

Note:
All Information platform services users of the system are part of the Everyone group.

The "Join Group" dialog box appears.

. Move the group that you want to add the user to from the Available Groups list to the Destination

Group(s) list.

Tip:
Use SHIFT + click or CTRL + click to select multiple groups.

. Click OK.

4.2.11.2 To add one or more users to a group

. In the "Users and Groups" management area of the CMC, select the group.
. Click Actions > Add Members to Group.

The "Add" dialog box appears.

. Click User list.

The Available users/groups list refreshes and displays all user accounts in the system.

. Move the user that you want to add to the group from the Available users/groups list to the Selected

users/groups list.
Tip:

+ To select multiple users, use the SHIFT + click or CTRL + click combination.
» To search for a specific user, use the search field.

+ If there are many users on your system, click the Previous and Next buttons to navigate through
the list of users.

. Click OK.
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4.2.12 Changing password settings

Within the CMC, you can change the password settings for a specific user or for all users in the system.
The various restrictions listed below apply only to Enterprise accounts—that is, the restrictions do not
apply to accounts that you have mapped to an external user database (LDAP or Windows AD). Generally,
however, your external system will enable you to place similar restrictions on the external accounts.

4.2.12.1 To change user password settings

1. Go to the "Users and Groups" management area of the CMC.

2. Select the user whose password settings you want to change.

3. Click Manage > Properties.
The "Properties" dialog box appears.

4. Select or clear the check box associated with the password setting you want to change.
The available options are:

- Password never expires
+ User must change password at next logon
- User cannot change password

5. Click Save & Close.

4.2.12.2 To change general password settings

1. Go to the "Authentication" management area of the CMC.
2. Double-click Enterprise.
The "Enterprise" dialog box appears.
3. Select the check box for each password setting that you want to use, and provide a value if necessary.

The following table identifies the minimum and maximum values for each of the settings you can
configure.
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Table 4-4: Password settings

Password setting Minimum Recommended Maximum
Enforce mixed-case pass- N/A N/A

words

Must contain at least N 0 characters 64 characters
Characters

Must change password every

N day(s) 1 day 100 days
Cannot reuse the N most re- 1 password 100 passwords
cent password(s)

Must wait N minute(s) to 0 minutes 100 minutes
change password

Dl_sable account after N 1 failed 100 failed
failed attempts to log on

Reset feluled logon count af- 1 minute 100 minutes
ter N minute(s)

Rt_e-enable account after N 0 minutes 100 minutes
minute(s)

4. Click Update.

4.2.13 Granting access to users and groups

You can grant users and groups administrative access to other users and groups. Administrative rights
include: viewing, editing, and deleting objects; viewing and deleting object instances; and pausing object
instances. For example, for troubleshooting and system maintenance, you may want to grant your IT
department access to edit and delete objects.
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Related Topics
* To assign principals to an access control list for an object

4.2.14 Controlling access to user inboxes

When you add a user, the system automatically creates an inbox for that user. The inbox has the same

name as the user. By default, only the user and the administrator have the right to access a user's
inbox.

Related Topics

- Setting a schedule for a program object
» Managing security settings for objects in the CMC

4.2.15 Configuring Bl launch pad options

Administrators can configure the way users access the Bl launch pad applications. By configuring
properties in the BOE.war file, you can specify what information is available on the user's logon screen.
You can also use the CMC to set Bl launch pad preferences for specific groups.

4.2.15.1 Configuring the Bl launch pad logon screen

By default, the Bl launch pad logon screen prompts users for their user name and password. You can
also prompt them for the CMS name and the authentication type. To change this setting, you need to
edit the Bl launch pad properties for the BOE.war file.

4.2.15.1.1 To configure the Bl launch pad logon screen
To modify Bl launch pad default settings, you need to set custom Bl launch pad properties for the
BOE.war file. This file deployed on the machine hosting your web application server.

1. Go to the following directory in your Information platform services installation:

<INSTALLDIR>\Information platform services  MINI-BOE-VERSION \warfiles\we
bapps\BOE\WEB-INF\config\custom\
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Note:

If you are using the Tomcat version installed with Information platform services, you can also access
the following directory: C: \Program Files (x86)\SAP BusinessObjects\Tomcat6\we
bapps\BOE\WEB-INF\config\custom

+ If you are using any other supported web application server, consult the documentation for your
web application server to determine the appropriate path.

2. Create a new file.

Note:
Use Notepad or any other text-editing utility.

3. Save the file under the following name:
Bllaunchpad.properties
4. To include the authentication options on the Bl launch pad logon screen add the following:

authentication.visible=true

5. To change the default authentication type add the following:

authentication.default=<authentication>

Replace <authentication> with any of the following options

Authentication Type <authentication> value
Enterprise secEnterprise
LDAP secLDAP

Windows AD secWinAD

SAP secSAPR3

6. To prompt users for the CMS name on the Bl launch pad logon screen :

cms.visible=true

7. Save and close the file.
8. Restart your web application server.

Use WDeploy to redeploy the BOE.war file on the web application server. For more information on
using WDeploy, see the Information Platform Services Web Application Deployment Guide.

4.2.15.2 Configuring Bl launch pad Preferences for groups

Administrators can set Bl launch pad preferences for specific user groups. These preferences serve
as default Bl launch pad preferences for all users in the group.
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Note:

If users have set their own preferences, any administrator-defined settings will not be reflected in their
view of Bl launch pad. Users can always switch from their own preferences to the administrator-defined
preferences at any time and use the updated settings.

By default no Bl launch pad preferences are set for any user groups. Administrators can specify
preferences for the following:

Home tab

Documents - start location

Folders

Categories

Number of objects per page

Columns displayed in the "Document" tab

How to display documents in Bl launch pad - through tabs or a new window

4.2.15.2.1 To set Bl launch pad Preferences for a group

1.
2.
3.

Go to the "Users and Groups" management area of the CMC.
Select the group from the Group List.

Click Actions > Bl launch pad Preferences

The "Bl launch pad Preferences" dialog box appears

Unselect No Preferences Defined.

. To set a user's initial view:

+ To display the Home tab when the user first log on, click Home tab and choose one of the
following options:

Default Home tab Displays the default Home tab provided with Information platform
services will be used.

Select Home tab Displays a specific website as the home tab.
Click Browse Home tab. In the "Select a Custom Home tab"
window, select a repository object and click Open.

Note:
you can only select an object that has already been added to
the repository.

+ To display the Documents tab when the user first log on, click Documents, and then specify
which drawer and node are open by default. You can select from the following
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My Documents | Choose from one of the following to display in the Documents tab:
* My Favorites

+ Personal Categories

* My Inbox

Folders Choose from one of the following:
+ Public Folders: this will display the public folders in the Documents tab
+ Select Public folder

Click Browse Folder to select a specific public folder to display in the Doc-
uments tab.

Categories Choose from one of the following:

+ Corporate Categories: this will display the corporate categories in the
Documents tab

+ Select Corporate Category

Click Browse Folder to select a specific corporate category to display in
the Documents tab.

For example, if you want the My Documents drawer to be open to the user's Bl Inbox when they
first log on, click My Documents and click My Inbox.

6. Under "Choose columns displayed in Documents tab", select the summary information that you want
to see for each object in the user's List panel:
+ Type
+ Last Run
* Instances
- Description
+ Created By
+ Created On
+ Location (Categories)
> Received On (Inbox)

*  From (Inbox)

7. Under "Set document viewing location", choose how you want users to view their documents.
Users can open documents for viewing in new tabs within Bl launch pad or in new web browser
windows.

8. Enter a number in the Set the maximum number of items per page field to specify the maximum
number of objects displayed per page when a user views lists of objects.

9. Click Save & Close.

The specified preferences will serve as defaults for users in the group you selected in Step 2. Users
will however be able to create their own Bl launch pad preferences, if they have the right to set their
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preferences. If you do not want users to modify the preferences, you should not grant users the right
to set preferences.

4.3 Managing aliases

If a user has multiple accounts in Information platform services, you can link the accounts using the
Assign Alias feature. This is useful when a user has a third-party account that is mapped to Enterprise
and an Enterprise account.

By assigning an alias to the user, the user can log on using either a third-party user name and password
or an Enterprise user name and password. Thus, an alias enables a user to log on via more than one
authentication type.

In the CMC, the alias information is displayed at the bottom of the "Properties" dialog box for a user. A
user can have any combination of Information platform services, LDAP or Windows AD aliases.

4.3.1 To create a user and add a third-party alias

When you create a user and select an authentication type other than Enterprise, the system creates
the new user in Information platform services and creates a third-party alias for the user.

Note:
For the system to create the third-party alias, the following criteria must be met:

+ The authentication tool needs to have been enabled in the CMC.
+  The format of the account name must agree with the format required for the authentication type.

»  The user account must exist in the third-party authentication tool, and it must belong to a group that
is already mapped to Information platform services.

1. Go to the "Users and Groups" management area of the CMC.

Click Manage > New > New User.

The "New User" dialog box appears.

A

Select the authentication type for the user, for example, Windows AD.
Type in the third-party account name for the user, for example, bsmith .
Select the connection type for the user.

Click Create & Close.

o0~ w

The user is added to Information platform services and is assigned an alias for the authentication
type you selected, for example, secWindowsAD:ENTERPRISE:bsmith. If required, you can add,
assign, and reassign aliases to users.
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4.3.2 To create a new alias for an existing user

You can create aliases for existing Information platform services users. The alias can be an Enterprise
alias, or an alias for a third-party authentication tool.

Note:
For the system to create the third-party alias, the following criteria must be met:

¥

No ok~

The authentication tool needs to have been enabled in the CMC.
The format of the account name must agree with the format required for the authentication type.

The user account must exist in the third-party authentication tool, and it must belong to a group that
is mapped to Information platform services.

. Go to the "Users and Groups" management area of the CMC.
. Select the user that you want to add an alias to.

Click Manage > Properties.

The "Properties" dialog box appears.
Click New Alias.

Select the authentication type.

Type in the account name for the user.
Click Update.

An alias is created for the user. When you view the user in the CMC, at least two aliases are shown,
the one that was already assigned to the user and the one you just created.

. Click Save & Close to exit the "Properties" dialog box.

4.3.3 To assign an alias from another user

When you assign an alias to a user, you move a third-party alias from another user to the user you are
currently viewing. You cannot assign or reassign Enterprise aliases.

Note:

If a user has only one alias and you assign that last alias to another user, the system will delete the

user account, and the Favorites folder, personal categories, and inbox for that account.
1.

2. Select the user you want to assign an alias to.
3. Click Manage > Properties.

Go to the "Users and Groups" management area of the CMC.

The "Properties" dialog box appears.
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Click Assign Alias.

Enter the user account that has the alias you want to assign, and click Find Now.

Move the alias you want to assign from the Available aliases list to the Aliases to be added to
Username list.

Here Username represents the name of the user you are assigning an alias to.

Tip:
To select multiple aliases, use the SHIFT + click or CTRL + click combination.

. Click OK.

4.3.4 To delete an alias

When you delete an alias, the alias is removed from the system. If a user has only one alias and you
delete that alias, the system automatically deletes the user account and the Favorites folder, personal
categories, and inbox for that account.

Note:

Deleting a user's alias does not necessarily prevent the user from being able to log on to Information
platform services again. If the user account still exists in the third-party system, and if the account
belongs to a group that is mapped to Information platform services, then Information platform services
will still allow the user to log on. Whether the system creates a new user or assigns the alias to an
existing user, depends on which update options you have selected for the authentication tool in the
"Authentication" management area of CMC.

1.
2,
3.

Go to the "Users and Groups" management area of the CMC.
Select the user whose alias you want to delete.

Click Manage > Properties.

The "Properties" dialog box appears.

Click the Delete Alias button next to the alias that you want to delete.
If prompted for confirmation, click OK.
The alias is deleted.

Click Save & Close to exit the "Properties” dialog box.

4.3.5 To disable an alias

You can prevent a user from logging on to Information platform services using a particular authentication
method by disabling the user's alias associated with that method. To prevent a user from accessing
Information platform services altogether, disable all aliases for that user.
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Note:

Deleting a user from the system does not necessarily prevent the user from being able to log on to
Information platform services again. If the user account still exists in the third-party system, and if the
account belongs to a group that is mapped to Information platform services, then the system will still
allow the user to log on. To ensure a user can no longer use one of his or her aliases to log on to
Information platform services, it is best to disable the alias.

1.
2,
3.

Go to the "Users and Groups" management area of the CMC.
Select the user whose alias you want to disable.

Click Manage > Properties.

The "Properties" dialog box appears.

. Clear the Enabled check box for the alias you want disable.

Repeat this step for each alias you want to disable.

. Click Save & Close.

The user can no longer log on using the type of authentication that you just disabled.

Related Topics
* To delete an alias
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Setting Rights

5.1 How rights work in Information platform services

Rights are the base units for controlling user access to the objects, users, applications, servers, and
other features in Information platform services. They play an important role in securing the system by
specifying the individual actions that users can perform on objects. Besides allowing you to control
access to your Information platform services content, rights enable you to delegate user and group
management to different departments, and to provide your IT people with administrative access to
servers and server groups.

It is important to note that rights are set on objects such as reports and folders rather than on the
“principals” (the users and groups) who access them. For example, to give a manager access to a
particular folder, in the "Folders" area, you add the manager to the “access control list” (the list of
principals who have access to an object) for the folder. You cannot give the manager access by
configuring the manager's rights settings in the "Users and Groups" area. The rights settings for the
manager in the "Users and Groups" area are used to grant other principals (such as delegated
administrators) access to the manager as an object in the system. In this way, principals are themselves
like objects for others with greater rights to manage.

Each right on an object can be granted, denied, or unspecified. The Information platform services
security model is designed such that, if a right is left unspecified, the right is denied. Additionally, if
settings result in a right being both granted and denied to a user or group, the right is denied. This
“denial-based” design helps ensure that users and groups do not automatically acquire rights that are
not explicitly granted.

There is an important exception to this rule. If a right is explicitly set on a child object that contradicts
the rights inherited from the parent object, the right set on the child object overrides the inherited rights.
This exception applies to users who are members of groups as well. If a user is explicitly granted a right
that the user's group is denied, the right set on the user overrides the inherited rights.

5.1.1 Access levels

“Access levels” are groups of rights that users frequently need. They allow administrators to set common
security levels quickly and uniformly rather than requiring that individual rights be set one by one.
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Information platform services comes with several predefined access levels. These predefined access
levels are based on a model of increasing rights: Beginning with View and ending with Full Control,
each access level builds upon the rights granted by the previous level.

However, you can also create and customize your own access levels; this can greatly reduce
administrative and maintenance costs associated with security. Consider a situation in which an
administrator must manage two groups, sales managers and sales employees. Both groups need to
access five reports in the Information platform services system, but sales managers require more rights
than sales employees. The predefined access levels do not meet the needs of either group. Instead of
adding groups to each report as principals and modifying their rights in five different places, the
administrator can create two new access levels, Sales Managers and Sales Employees. The administrator
then adds both groups as principals to the reports and assigns the groups their respective access levels.
When rights need to be modified, the administrator can modify the access levels. Because the access
levels apply to both groups across all five reports, the rights those groups have to the reports are quickly
updated.

Related Topics
» Working with access levels

5.1.2 Advanced rights settings

To provide you with full control over object security, the CMC allows you to set “advanced rights”. These
advanced rights provide increased flexibility as you define security for objects at a granular level.

Use advanced rights settings, for instance, if you need to customize a principal's rights to a particular
object or set of objects. Most importantly, use advanced rights to explicitly deny a user or group any
right that should not be permitted to change when, in the future, you make changes to group memberships
or folder security levels.

The following table summarizes the options that you have when you set advanced rights.

Table 5-1: Rights options

Icon Rights option Description
L] Granted The right is granted to a principal.
(>} Denied The right is denied to a principal.
N - The right is unspecified for a principal. By default, rights
' Not Specified set to Not Specified are denied.
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icon Rights option Description
. The right applies to the object. This option becomes
O Apply to Object available when you click Granted or Denied.
. The right applies to sub-objects. This option becomes
= Apply to Sub Object available when you click Granted or Denied.

Related Topics
* Type-specific rights

5.1.3 Inheritance

Rights are set on an object for a principal in order to control access to the object; however, it is impractical
to set the explicit value of every possible right for every principal on every object. Consider a system
with 100 rights, 1000 users, and 10,000 objects: to set rights explicitly on each object would require the
CMS store billions of rights in its memory, and, importantly, require that an administrator manually set
each one.

Inheritance patterns resolve this impracticality. With inheritance, the rights that users have to objects
in the system come from a combination of their memberships in different groups and subgroups and
from objects which have inherited rights from parent folders and subfolders. These users can inherit
rights as the result of group membership; subgroups can inherit rights from parent groups; and both

users and groups can inherit rights from parent folders.

By default, users or groups who have rights to a folder will inherit the same rights for any object that
are subsequently published to that folder. Consequently, the best strategy is to set the appropriate
rights for users and groups at the folder level first, then publish objects to that folder.

Information platform services recognizes two types of inheritance: group inheritance and folder
inheritance.

5.1.3.1 Group inheritance

Group inheritance allows principals to inherit rights as the result of group membership. Group inheritance
proves especially useful when you organize all of your users into groups that coincide with your
organization's current security conventions.
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In “Group inheritance example 1”, you can see how group inheritance works. Red Group is a subgroup
of Blue Group, so it inherits Blue Group's rights. In this case, it inherits right 1 as granted, and the rest
of the rights as unspecified. Every member of Red Group inherits these rights. In addition, any other
rights that are set on the subgroup are inherited by its members. In this example, Green User is a
member of Red Group, and thus inherits right 1 as granted, rights 2, 3, 4, and 6 as not specified, and
Right 5 as denied.
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Figure 5-1: Group inheritance example 1
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When group inheritance is enabled for a user who belongs to more than one group, the rights of all
parent groups are considered when the system checks credentials. The user is denied any right that
is explicitly denied in any parent group, and the user is denied any right that remains completely not
specified; thus, the user is granted only those rights that are granted in one or more groups (explicitly
or through access levels) and never explicitly denied.

In “Group inheritance example 2”7, Green User is a member of two unrelated groups. From Blue Group,
he inherits rights 1 and 5 as "granted" and the rest as not specified; however, because Green User also
belongs to Red Group, and Red Group has been explicitly denied right 5, Green User's inheritance to
right 5 from Blue Group is overridden.

Figure 5-2: Group inheritance example 2

Related Topics
* Rights override
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5.1.3.2 Folder inheritance

Folder inheritance allows principals to inherit any rights that they have been granted on an object's
parent folder. Folder inheritance proves especially useful when you organize Information platform
services content into a folder hierarchy that reflects your organization's current security conventions.
For example, suppose that you create a folder called Sales Reports, and you provide your Sales group
with View On Demand access to this folder. By default, every user that has rights to the Sales Reports
folder will inherit the same rights to the reports that you subsequently publish to this folder. Consequently,
the Sales group will have View On Demand access to all of the reports, and you need set the object
rights only once, at the folder level.

In “Folder inheritance example”, rights have been set for Red Group on a folder. Rights 1 and 5 have
been granted, while the rest have been left unspecified. With folder inheritance enabled, members of
Red Group have rights on the object level identical to the rights of the group on the folder level. Rights
1 and 5 are inherited as granted, while the rest have been left unspecified.
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Figure 5-3: Folder inheritance example

Related Topics
* Rights override

5.1.3.3 Rights override
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“Rights override” is a rights behavior in which rights that are set on child objects override the rights set
on parent objects. Rights override occurs under the following circumstances:

+ In general, the rights that are set on child objects override the corresponding rights that are set on
parent objects.

* In general, the rights that are set on subgroups or members of groups override the corresponding
rights that are set on groups.

You do not need to disable inheritance to set customized rights on an object. The child object inherits
the rights settings of the parent object except for the rights that are explicitly set on the child object.
Also, any changes to rights settings on the parent object apply to the child object.

“Rights override example 1” illustrates how rights override works on parent and child objects. Blue User
is denied the right to edit a folder's contents; the rights setting is inherited by the subfolder. However,
an administrator grants Blue User Edit rights to a document in the subfolder. The Edit right that Blue
User receives on the document overrides the inherited rights that come from the folder and subfolder.

Figure 5-4: Rights override example 1

“Rights override example 2” illustrates how rights override works on members and groups. Blue Group
is denied the right to edit a folder; Blue Subgroup inherits this rights setting. However, an administrator
grants Blue User, who is a member of Blue Group and Blue Subgroup, Edit rights on the folder. The
Edit rights that Blue User receives on the folder override the inherited rights that come from Blue Group
and Blue Subgroup.
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Figure 5-5: Rights override example 2
“Complex rights override” illustrates a situation where the effects of rights override are less obvious.

Purple User is a member of subgroups 1A and 2A, which are in Groups 1 and 2, respectively. Groups
1 and 2 both have Edit rights on the folder. 1A inherits the Edit rights that Group 1 has, but an
administrator denies Edit rights to 2A. The rights settings on 2A override the rights settings on Group
2 because of rights override. Therefore, Purple User inherits contradictory rights settings from 1A and
2A. 1A and 2A do not have a parent-child relationship, so rights override does not occur; that is, one
sub-group's rights settings do not override another's because they have equal status. In the end, Purple
User is denied Edit rights because of the “denial-based” rights model in Information platform services.
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Figure 5-6: Complex rights override

Rights override lets you make minor adjustments to the rights settings on a child object without discarding
all inherited rights settings. Consider a situation in which a sales manager needs to view confidential
reports in the Confidential folder. The sales manager is part of the Sales group, which is denied access
to the folder and its contents. The administrator grants the manager View rights on the Confidential
folder and continues to deny the Sales group access. In this case, the View rights granted to the sales
manager override the denied access that the manager inherits from membership in the Sales group.

5.1.3.4 Scope of rights

“Scope of rights” refers to the ability to control the extent of rights inheritance. To define the scope of
a right, you decide whether the right applies to the object, its sub-objects, or both. By default, the scope

of a right extends to both objects and sub-objects.
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Scope of rights can be used to protect personal content in shared locations. Consider a situation in
which the finance department has a shared Expense Claims folder that contains Personal Expense
Claims subfolders for each employee. The employees want to be able to view the Expense Claims
folder and add objects to it, but they also want to protect the contents of their Personal Expense Claims
subfolders. The administrator grants all employees View and Add rights on the Expense Claims folder,
and limits the scope of these rights to the Expense Claims folder only. This means that the View and
Add rights do not apply to sub-objects in the Expense Claims folder. The administrator then grants
employees View and Add rights on their own Personal Expense Claims subfolders.

Scope of rights can also limit the effective rights that a delegated administrator has. For example, a
delegated administrator may have Securely Modify Rights and Edit rights on a folder, but the scope
of these rights is limited to the folder only and does not apply to its sub-objects. The delegated
administrator cannot grant these rights to another user on one of the folder's sub-objects.

5.1.4 Type-specific rights

“Type-specific rights” are rights that affect specific object types only, such as Crystal reports, folders,
or access levels. Type-specific rights consist of the following:

» General rights for the object type

These rights are identical to general global rights (for example, the right to add, delete, or edit an
object), but you set them on specific object types to override the general global rights settings.

+  Specific rights for the object type

These rights are available for specific object types only. For example, the right to export a report's
data appears for Crystal reports but not for Word documents.

The diagram “Type-specific rights example” illustrates how type-specific rights work. Here right 3
represents the right to edit an object. Blue Group is denied Edit rights on the top-level folder and granted
Edit rights for Crystal reports in the folder and subfolder. These Edit rights are specific to Crystal reports
and override the rights settings on a general global level. As a result, members of Blue Group have
Edit rights for Crystal reports but not the XLF file in the subfolder.
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Figure 5-7: Type-specific rights example

Type-specific rights are useful because they let you limit the rights of principals based on object type.
Consider a situation in which an administrator wants employees to be able to add objects to a folder
but not create subfolders. The administrator grants Add rights at the general global level for the folder,
and then denies Add rights for the folder object type.

Rights are divided into the following collections based on the object types they apply to:

General
These rights affect all objects.
Content

These rights are divided according to particular content object types. Examples of content object
types include Crystal reports, and Adobe Acrobat PDFs.

Application

These rights are divided according to which Information platform services application they affect.
Examples of applications include the CMC and BI launch pad.

System

These rights are divided according to which core system component they affect. Examples of core
system components include Calendars, Events, and Users and Groups.

Type-specific rights are in the Content, Application, and System collections. In each collection, they
are further divided into categories based on object type.

5.1.5 Determining effective rights
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Keep these considerations in mind when you set rights on an object:

Each access level grants some rights, denies some rights, and leaves the other rights unspecified.
When a user is granted several access levels, the system aggregates the effective rights and denies
any unspecified rights by default.

When you assign multiple access levels to a principal on an object, the principal has the combination
of each access level's rights. The user in “Multiple access levels” is assigned two access levels.
One access level grants the user rights 3 and 4, while the other access level grants right 3 only. The
effective rights for the user are 3 and 4.

Figure 5-8: Multiple access levels

Advanced rights can be combined with access levels to customize the rights settings for a principal
on an object. For example, if an advanced right and an access level are both assigned explicitly to
a principal on an object, and the advanced right contradicts a right in the access level, the advanced
right will override the right in the access level.

Advanced rights can override their identical counterparts in access levels only when they are set on
the same object for the same principal. For example, an advanced Add right set at the general global
level can override the general Add right setting in an access level; it cannot override a type-specific
Add right setting in an access level.

However, advanced rights do not always override access levels. For example, a principal is denied
an Edit right on a parent object. On the child object, the principal is assigned an access level that
grants him the Edit right. In the end, the principal has Edit rights on the child object because the
rights set on the child object override rights that are set on the parent object.

Rights override makes it possible for rights set on a child object to override rights that are inherited
from the parent object.

5.2 Managing security settings for ohjects in the CNC

You can manage security settings for most objects in the CMC with the security options on the Manage
menu. These options let you assign principals to the access control list for an object, view the rights
that a principal has, and modify the rights that the principal has to an object.

The specific details of security management vary according to your security needs and the type of
object you are setting rights for. However, in general, the workflows for the following tasks are very
similar:

Viewing rights for a principal on an object.
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» Assigning principals to an access control list for an object, and specifying which rights and access
levels those principals have.

+ Setting rights on a top-level folder in Information platform services.

5.2.1 To view rights for a principal on an ohbject

In general, you follow this workflow to view rights for a principal on an object.

1. Select the object for which you want to view security settings.
2. Click Manage > User Security.
The "User Security" dialog box appears and displays the access control list for the object.

3. Select a principal from the access control list, and click View Security

The "Permissions Explorer" launches and displays a list of effective rights for the principal on the
object. In addition, the "Permissions Explorer" lets you do the following:

»  Browse for another principal whose rights you want to view.

+ Filter the rights displayed according to these criteria:

+ assigned rights
» granted rights
* unassigned rights
» from access level
+ object type
+ the name of the right
» Sort the list of rights displayed in ascending or descending order according to these criteria:

+ collection

* type

* right name

+ right status (granted, denied, or unspecified)

Additionally, you can click one of the links in the "Source" column to display the source of inherited
rights.

5.2.2 To assign principals to an access control list for an object

An access control list specifies the users that are granted or denied rights on an object. In general, you
follow this workflow to assign a principal to an access control list, and to specify the rights that the
principal has to the object.

1. Select the object to which you want to add a principal.

2. Click Manage > User Security.
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The "User Security" dialog box appears and displays the access control list.
3. Click Add Principals.
The "Add Principals" dialog box appears.

4. Move the users and groups you want to add as principals from the Available users/groups list to
the Selected users/groups list.

5. Click Add and Assign Security.
6. Select the access levels you want to grant the principal.
7. Choose whether to enable or disable folder or group inheritance.

If necessary, you can also modify rights at a granular level to override certain rights in an access level.

Related Topics
» To modify security for a principal on an object

5.2.3 To modify security for a principal on an ohject

In general, it is recommended that you use access levels to assign rights to a principal. However, you
may need to override certain granular rights in an access level sometimes. Advanced rights let you
customize the rights for a principal on top of the access levels the principal already has. In general, you
follow this workflow to assign advanced rights to a principal on an object.

1. Assign the principal to the access control list for the object.

2. When the principal has been added, go to Manage > User Security to display the access control
list for the object.

3. Select the principal from the access control list, and click Assign Security.
The "Assign Security" dialog box appears.

4. Click the Advanced tab.

5. Click Add/Remove rights.

6. Modify the rights for the principal.
All the available rights are summarized in the Rights Appendix.

Related Topics
* To assign principals to an access control list for an object

5.2.4 To set rights on a top-level folder in Information platform services
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In general, you follow this workflow to set rights on a top-level folder in Information platform services.

Note:

For this release, principals require View rights on a container folder to be able to navigate in that folder
and view its sub-objects. This means that principals require View rights on the top-level folder to view
objects that are in folders. If you want to limit View rights for a principal, you can grant a principal View
rights on a specific folder and set the scope of rights to apply to that folder only.

1. Go to the CMC area that has the top-level folder you want to set rights for.

2. Click Manage > Top-Level Security > All objects.

Here Objects represents the contents of the top-level folder. If you are prompted for confirmation,
click OK.

The "User Security" dialog box appears and displays the access control list for the top-level folder.
3. Assign the principal to the access control list for the top-level folder.

4. If necessary, assign advanced rights to the principal.

Related Topics
* To assign principals to an access control list for an object

5.2.5 Checking security settings for a principal

In some cases, you may want to know the objects to which a principal has been granted or denied
access. You can use a security query to do this. Security queries let you determine which objects a
principal has certain rights to and manage user rights. For each security query, you provide the following
information:

*  Query principal

You specify the user or group that you want to run the security query for. You can specify one
principal for each security query.

*  Query permission

You specify the right or rights you want to run the security query for, the status of these rights, and
the object type these rights are set on. For example, you can run a security query for all reports that
a principal can refresh, or for all reports that a principal cannot export.

*  Query context

You specify the CMC areas that you want the security query to search. For each area, you can
choose whether to include sub-objects in the security query. A security query can have a maximum
of four areas.

When you run a security query, the results appear in the "Query Results" area in the Tree panel under
Security Queries. If you want to refine a security query, you can run a second query within the results
from the first query.
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Security queries are useful because they allow you to see the objects that a principal has certain rights
to, and they provide the locations of these objects if you want to modify those rights. Consider a situation
in which a sales employee is promoted to sales manager. The sales manager needs Schedule rights
for Crystal reports that he only had View rights to previously, and these reports are in different folders.
In this case, the administrator runs a security query for the sales manager's right to view Crystal reports
in all folders and includes sub-objects in the query. After the security query runs, the administrator can
see all Crystal reports that the sales manager has View rights for in the "Query Results" area. Because

the Details panel displays the location of each Crystal report, the administrator can browse for each
report and modify the sales manager's rights on it.

5.2.5.1 To run a security query

1. Inthe "Users and Groups" area, in the Details panel, select the user or group that you want to run
a security query for.

2. Click Manage > Tools > Create Security Query.

Create Security Query: Nina

7 X
ré& Query Principal
This query will search for objects for the following principal:
Mina Browse
rée Query Permission
This query will search for objects where the above principal has all of the following permissions:
" Do not query by permissions Browss
Collection Type Right Name ﬂ
General General Add objects to folders that the user owns ] ﬂ
General General Add objects to the folder (] ﬂ
r Query Context
This query will search for objects in the following section(s) of the CHC only:
~ IFUIders j Browse =
(el ¥ Query sub ohject
O |FOIder9 j Erawee,
OK | Cancel

The "Create Security Query" dialog box appears.

3. Ensure that the principal in the Query Principal area is correct.

If you decide to run a security query for a different principal, you can click Browse to select another
principal. In the "Browse for Query Principal" dialog box, expand User List or Groups List to browse
for the principal, or search for the principal by name. When you are finished, click OK to return to
the "Create Security Query" dialog box.

4. In the "Query Permission" area, specify the rights and the status of each right for which you want to

run the query..
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5.

If you want to run a query for specific rights that the principal has on objects, click Browse, set
the status of each right that you want to run the security query for, and click OK.

Tip:
You can delete specific rights from the query by clicking the delete button next to the right, or
delete all rights from the query by clicking the delete button in the header row.

If you want to run a general security query, select the Do not query by permissions check box.

When you do this, Information platform services runs a general security query for all objects that
have the principal in their access control lists regardless of the permissions that the principal has
on the objects.

In the "Query Context" area, specify the CMC areas that you want to query.
a. Select a check box next to a list.
b. On the list, select a CMC area that you want to query.

If you want to query a more specific location within an area (for example, a particular folder under
Folders), click Browse to open the "Browse for Query Context" dialog box. In the details pane,

select the folder you want to query, and click OK. When you return to the Security Query dialog
box, the folder you specified appears in the box under the list.

Select Query sub object.

. Repeat the steps above for each CMC area that you want to query.

Note:
You can query a maximum of four areas.

6. Click OK.
The security query runs and you are taken to the "Query Results" area.

To view the query results, in the Tree panel, expand Security Queries and click a query result.

Tip:
Query results are listed according to the names of principals.

The query results are displayed in the Details panel.

The "Query Results" area retains all security query results from a single user session until the user logs
off. If you want to run the query again but with new specifications, click Actions > Edit Query. You can
also rerun the exact same query by selecting the query and clicking Actions > Rerun Query. If you
want to keep your security query results, click Actions > Export to export your security query results
as a CSV file.

5.3 Working with access levels

You can do the following with access levels:
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+  Copy an existing access level, make changes to the copy, rename it, and save it as a new access

level.

- Create, rename, and delete access levels.

* Modify the rights in an access level.

+ Trace the relationship between access levels and other objects in the system.

* Replicate and manage access levels across sites.

+ Use one of the predefined access levels in Information platform services to set rights quickly and

uniformly for many principals.

The following table summarizes the rights that each predefined access level contains.

Table 5-2: Predefined access levels

Access level Description Rights involved
If set on the folder level, a princi-
pal can view the folder, objects
within the folder, and each ob- [ . yjew objects
View ject's generated instances. If set | | View document instances
at the object level, a principal
can view the object, its history,
and its generated instances.
View access level rights, plus:
» Schedule the document to
A principal can generate in- run
stances by scheduling an object | <+ Define server groups to pro-
to run against a specified data cess jobs
source once oron a recurring . Copy objects to another
basis. The principal can view, folder
delete, and pause the schedul- | . gchedule to destinations
Schedule ing of instances that they own. | . pyint the report's data

They can also schedule to differ-
ent formats and destinations,
set parameters and database
logon information, choose
servers to process jobs, add
contents to the folder, and copy
the object or folder.

»  Export the report's data

+ Edit objects that the user
owns

* Delete instances that the us-
er owns

+ Pause and resume docu-
ment instances that the user
owns

View On Demand

A principal can refresh data on
demand against a data source.

Schedule access level rights,
plus:
+ Refresh the report's data
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Access level Description Rights involved

All available rights, including:
+ Add objects to the folder

- Edit objects

* Modify rights users have to
objects

+ Delete objects

» Delete instances

A principal has full administra-

Full Control tive control of the object.

The following table summarizes the rights required to perform certain tasks on access levels.

Access level task Rights required

Create an access level - Add right on the Access Levels top-level folder

View granular rights in an access |. vijew right on the access level
level

Assign an access level to a princi-|.  view right on the access level
pal on an object + Use the Access Level for Security Assignment right on the
access level

+  Modify Rights right on the object, or Securely Modify Rights
right on the object and the principal

Note:

Users who have the Securely Modify Rights right and want to
assign an access level to a principal must have that same access
level assigned to themselves.

Modify an access level - View and Edit rights on the access level
Delete an access level - View and Delete rights on the access level
Clone an access level + View right on the access level

« Copy right on the access level
- Add right on the Access Levels top-level folder

5.3.1 Choosing between View and View On Demand access levels

When reporting over the web, the choice to use live or saved data is one of the most important decisions
you'll make. Whichever choice you make, however, Information platform services displays the first page
as quickly as possible, so you can see your report while the rest of the data is being processed. This
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section explains the difference between two predefined access levels that you can use to make this
choice.

View On Demand access level

On-demand reporting gives users real-time access to live data, straight from the database server. Use
live data to keep users up-to-date on constantly changing data, so they can access information that's
accurate to the second. For instance, if the managers of a large distribution center need to keep track
of inventory shipped on a continual basis, then live reporting is the way to give them the information
they need.

Before providing live data for all your reports, however, consider whether or not you want all of your
users hitting the database server on a continual basis. If the data isn't rapidly or constantly changing,
then all those requests to the database do little more than increase network traffic and consume server
resources. In such cases, you may prefer to schedule reports on a recurrent basis so that users can
always view recent data (report instances) without hitting the database server.

Users require View On Demand access to refresh reports against the database.

View access level

To reduce the amount of network traffic and the number of hits on your database servers, you can
schedule reports to be run at specified times. When the report has been run, users can view that report
instance as needed, without triggering additional hits on the database.

Report instances are useful for dealing with data that isn't continually updated. When users navigate
through report instances, and drill down for details on columns or charts, they don't access the database
server directly; instead, they access the saved data. Consequently, reports with saved data not only
minimize data transfer over the network, but also lighten the database server's workload.

For example, if your sales database is updated once a day, you can run the report on a similar schedule.
Sales representatives then always have access to current sales data, but they are not hitting the
database every time they open a report.

Users require only View access to display report instances.

5.3.2 To copy an existing access level

This is the best way to create an access level if you want an access level that differs slightly from one
of the existing access levels.

1. Go to the "Access Levels" area.
2. In the Details panel, select an access level.
Tip:
Select an access level that contains rights that are similar to what you want for your access level.

3. Click Organize > Copy.
A copy of the access level you selected appears in the Details panel.
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5.3.3 To create a new access level

This is the best way to create an access level if you want an access level that differs greatly from one
of the existing access levels.

1.
2,

Go to the "Access Levels" area.
Click Manage > New > Create Access Level.
The "Create New Access Level" dialog box appears.

Enter a title and description for your new access level, and then click OK.
You return to the "Access Levels" area, and the new access level appears in the Details panel.

5.3.4 To rename an access level

In the "Access Levels" area, in the Details panel, select the access level that you want to rename.

. Click Manage > Properties.

The "Properties" dialog box appears.
In the Title field, enter a new name for your access level, and then click Save & Close.
You return to the "Access Levels" area.

5.3.5 To delete an access level

1.

In the "Access Levels" area, in the Details panel, select the access level that you want to delete.

2. Click Manage > Delete Access Level.

Note:
You cannot delete predefined access levels.

A dialog box appears with information about the objects that this access level affects. If you do not
want to delete the access level, click Cancel to exit the dialog box.

. Click Delete.

The access level is deleted, and you return to the "Access Levels" area.
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5.3.6 To modify rights in an access level

To set rights for an access level, you first set general global rights that apply to all objects regardless
of type, and then you specify when you want to override the general settings based on the specific
object type.

1. Inthe Access Levels area, in the Details panel, select the access level that you want to modify the
rights for.

2. Click Actions > Included Rights.
The Included Rights dialog box appears and displays a list of effective rights.

3. Click Add/Remove Rights.

Included Rights: Production Department 2 0Ox%
Rights Collections ¥General Global Rights ] [x] A O O
¥Gereral Add ohijects to folders that the user owns [l [ (o ~ ¥ =
. An acd abjects o the folder & ¢ o F F
»System Change password for users that the user owns i« [ * F F
>Content Change user password i« [ * F F

Copy objects that the user owns to another folder i« [ * F F
Copy objects to another folder i« [ * F F
Define server groups to process jobs i« [ * F F
Define server groups 1o process jobs for objects that the user owns i« o o F F
Delete instances o o ® F F
Delete instances that the user owns i« o i« F F
Delete objects o o * F F
Delete objects that the user owns i« o * F F
Edit objects ol ol [Cl F F Ll
M Cancel

The Included Rights dialog box displays the rights collections for the access level in the navigation
list. The General Global Rights section is expanded by default.

4. Set your general global rights.
Each right can have a status of Granted, Denied, or Not Specified. You can also choose whether
to apply that right to the object only, to apply it to sub-objects only, or both.

5. To set type-specific rights for the access level, in the navigation list, click the rights collection, and
then click the sub-collection that applies to the object type you want to set the rights for.

6. When you have finished, click OK.
You return to the list of effective rights.

Related Topics
* Managing security settings for objects in the CMC
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* Type-specific rights

5.3.7 Tracing the relationship between access levels and objects

Before you modify or delete an access level, it is important to confirm that any changes you make to
the access level will not impact objects in the CMC negatively. You can do this by running a relationship
query on the access level.

Relationship queries are useful for rights management because they allow you to see objects impacted
by an access level in one convenient location. Consider a situation in which a company restructures
its organization and merges two departments, Department A and Department B, into Department C.
The administrator decides to delete the access levels for Department A and Department B because
these departments no longer exist. The administrator runs relationship queries for both access levels
before deleting them. In the "Query Results" area, the administrator can see the objects that will be
affected if the administrator deletes the access levels. The Details panel also shows the administrator
the location of the objects in the CMC if the rights on the objects must be modified before the access
levels are deleted.

Note:

+  To view the list of affected objects, you must have View rights on those objects.

+ Relationship query results for an access level only yield objects on which the access level is explicitly
assigned. If an object uses an access level because of inheritance settings, that object does not
appear in the query results.

5.3.8 Managing access levels across sites

Access levels are one of the objects that you can replicate from an Origin site to Destination sites. You
can choose to replicate access levels if they appear in a replication object's access control list. For
example, if a principal is granted access level A on a Crystal report and the Crystal report is replicated
across sites, access level A is also replicated.

Note:
If an access level with the same name exists in the Destination site, the access level replication will
fail. You or the Destination site administrator must rename one of the access levels before replication.

After you replicate an access level across sites, keep the administration considerations in this section
in mind.
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Modifying replicated access levels in the Origin site

If a replicated access level is modified in the Origin site, the access level in the Destination site will be
updated the next time the replication is scheduled to run. In two-way replication scenarios, if you modify
a replicated access level in the Destination site, the access level in the Origin site changes.

Note:

Ensure that changes to an access level in one site do not affect objects in other sites negatively. Consult
your site administrators and advise them to run relationship queries for the replicated access level
before you make any changes.

Modifying replicated access levels in the Destination site

Note:
This applies to one-way replication only.

Any changes to replicated access levels made in a Destination site are not reflected in the Origin site.
For example, a Destination site administrator can grant the right to schedule Crystal reports in the
replicated access level even though this right was denied in the Origin site. As a result, although the
access level names and replicated object names remain the same, the effective rights that principals
have on objects may differ from Destination site to Destination site.

If the replicated access level differs between the Origin and Destination sites, the difference in effective
rights will be detected the next time a Replication Job is scheduled to run. You can force the Origin site
access level to override the Destination site access level, or allow the Destination site access level to
remain intact. However, if you do not force the Origin site access level to override the Destination site
access level, any objects pending Replication that use that access level will fail to replicate.

To restrict users from modifying replicated access levels in the Destination site, you can add Destination
site users to the access level as principals, and grant those users View rights only. This means that
Destination site users can view the access level but are unable to modify its rights settings or assign it
to other users.

Related Topics
» Tracing the relationship between access levels and objects

5.4 Breaking inheritance

Inheritance lets you manage your security settings without setting rights for each individual object.
However, in some cases, you may not want rights to be inherited. For example, you may want to
customize rights for each object. You can disable inheritance for a principal in an object's access control
list. When you do this, you can choose whether to disable group inheritance, folder inheritance, or both.

Note:
When inheritance is broken, it is broken for all rights; it is not possible to turn off inheritance for some
rights but not for others.
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In the diagram “Breaking inheritance”, group and folder inheritance are initially in effect. Red User
inherits rights 1 and 5 as granted, rights 2, 3, and 4 as unspecified, and right 6 as explicitly denied.
These rights, set on the folder level for the group, mean that Red User, and every other member of the
group, has these rights on the folder's objects, A and B. When inheritance is broken on the folder level,
Red User's set of rights to the objects in that folder is cleared until an administrator assigns new rights
to him.
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Figure 5-9: Breaking inheritance

5.4.1 To disable inheritance

This procedure lets you disable group or folder inheritance, or both, for a principal on an object's access
control list.

1. Select the object that you want to disable inheritance for.
2. Click Manage > User Security.
The "User Security" dialog box appears.

3. Select the principal that you want to disable inheritance for, and click Assign Security.
The "Assign Security" dialog box appears.
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4. Configure your inheritance settings.
+ If you want to disable group inheritance (the rights that the principal inherits from group
membership), clear the Inherit From Parent Group check box.
- If you want to disable folder inheritance (the rights settings that the object inherits from the folder),
clear the Inherit From Parent Folder check box.

5. Click OK.

5.5 Using rights to delegate administration

Besides allowing you to control access to objects and settings, rights allow you to divide administrative
tasks between functional groups within your organization. For example, you may want people from
different departments to manage their own Information platform services users and groups. Or you may
have one administrator who handles high-level management of Information platform services, but you
want all server management to be handled by people in your IT department.

Assuming that your group structure and folder structure align with your delegated-administration security
structure, you should grant your delegated administrator rights to entire user groups, but grant the
delegated administrator less than full rights on the users he controls. For example, you might not want
the delegated administrator to edit user attributes or reassign them to different groups.

The “Rights for delegated administrators” table summarizes the rights required for delegated
administrators to perform common actions.

Table 5-3: Rights for delegated administrators

Rights required by the delegated administra-

Action for delegated administrator

Create new users

Add right on the top-level Users folder

Create new groups

Add right on the top-level User Groups folder

Delete any controlled groups, as well as individual
users in those groups

Delete right on relevant groups

Delete only users that the delegated administrator
creates

Owner Delete right on the top-level Users folder

Delete only users and groups that the delegated
administrator creates

Owner Delete right on the top-level User Groups
folder
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Action for delegated administrator

Manipulate only users that the delegated creates
(including adding those users to those groups)

Rights required by the delegated administra-
tor

Owner Edit and Owner Securely Modify Rights
right on the top-level Users folder

Manipulate only groups that the delegated admin-
istrator creates (including adding users to those

groups)

Owner Edit and Owner Securely Modify Rights
on the top-level User Groups folder

Modify passwords for users in their controlled
groups

Edit Password right on relevant groups

Modify passwords only for principals the delegat-
ed administrator creates

Owner Edit Password right on top-level Users
folder, or on relevant groups

Note:

Setting the Owner Edit Password right on a
group takes effect on a user only when you add
the user to the relevant group.

Modify user names, description, other attributes,
and reassign users to different groups

Edit right on relevant groups

Modify user names, description, other attributes,
and reassign users to different groups, but only
for users that the delegated administrator creates

Owner Edit right on top-level Users folder, or on
relevant groups

Note:

Setting the Owner Edit right on relevant groups
takes effect on a user only when you add the user
to the relevant group.

5.5.1 Choosing hetween “Modify the rights users have to ohjects” options

When you set up delegated administration, give your delegated administrator rights on the principals
he will control. You may want to give her all rights (Full Control); however, it is good practice to use
advanced rights settings to withhold the Modify Rights right and give your delegated administrator the
Securely Modify Rights right instead. You may also give your administrator the Securely Modify

93

2012-08-15



Setting Rights

Rights Inheritance Settings right instead of the Modify Rights Inheritance Settings right. The
differences between these rights are summarized below.

Modify the rights users have to ohjects

This right allows a user to modify any right for any user on that object. For example, if user A has the
rights View objects and Modify the rights users have to object on an object, user A can then change
the rights for that object so he or any other user has full control of this object.

Securely modify the rights users have to objects

This right allows a user to grant, deny, or revert to unspecified only the rights he is already granted. For
example, if user A has View and Securely modify the rights users have to objects rights, user A
can not give herself any more rights and can grant or deny to other users only these two rights (View
and Securely Modify Rights). Additionally, user A can change only the rights for users on objects for
which he has the Securely Modify Rights right.

These are all the conditions that must exist for user A to modify the rights for user B on object O:
* User A has the Securely Modify Rights right on object O.

+ Each right or access level that user A is changing for user B is granted to A.
* User A has the Securely Modify Rights right on user B.

+ If an access level is being assigned, User A has Assign Access Level right on the access level
that is changing for user B.

Scope of rights can further limit the effective rights that a delegated administrator can assign. For
example, a delegated administrator may have Securely Modify Rights and Edit rights on a folder, but
the scope of these rights is limited to the folder only and does not apply to its sub-objects. Effectively,
the delegated administrator can grant the Edit right on the folder (but not on its sub-objects) only, and
with an “Apply to objects” scope only. On the other hand, if the delegated administrator is granted the
Edit right on a folder with a scope of “Apply to sub-objects” only, she can grant other principals the
Edit right with both scopes on the folder's sub-objects, but on the folder itself, she can only grant the
Edit right with an “Apply to sub-objects” scope.

In addition, the delegated administrator will be restricted from modifying rights on those groups for other
principals that she doesn't have the Securely Modify Rights right on. This is useful, for example, if you
have two delegated administrators responsible for granting rights to different user groups for the same
folder, but you don't want one delegated administrator to be able to deny access to the groups controlled
by the other delegated administrator. The Securely Modify Rights right ensures this, since delegated
administrators generally won't have the Securely Modify Rights right on each other.

Securely modify rights inheritance settings

This right allows a delegated administrator to modify inheritance settings for other principals on the
objects that the delegated administrator has access to. To successfully modify the inheritance settings
of other principals, a delegated administrator must have this right on the object and on the user accounts
for the principals.
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5.5.2 Owner rights

Owner rights are rights that apply only to the owner of the object on which rights are being checked. In
Information platform services, the owner of an object is the principal who created the object; if that
principal is ever deleted from the system, ownership reverts to the Administrator.

Owner rights are useful in managing owner-based security. For example, you may want to create an
folder or hierarchy of folders in which various users can create and view documents, but can only modify
or delete their own documents. In addition, owner rights are useful for allowing users to manipulate
instances of reports they create, but not others' instances. In the case of the scheduling access level,
this permits users to edit, delete, pause and reschedule only their own instances.

Owner rights work similarly to their corresponding regular rights. However, owner rights are effective
only when the principal has been granted owner rights but regular rights are denied or not specified.

5.6 Summary of recommendations for rights administration

Keep these considerations in mind for rights administration:

» Use access levels wherever possible. These predefined sets of rights simplify administration by
grouping together rights associated with common user needs.

- Setrights and access levels on top-level folders. Enabling inheritance will allow these rights to be
passed down through the system with minimal administrative intervention.

+ Avoid breaking inheritance whenever possible. By doing so, you can reduce the amount of time it
takes to secure the content that you have added to Information platform services.

+ Set appropriate rights for users and groups at the folder level, then publish objects to that folder. By
default, users or groups who have rights to a folder will inherit the same rights for any object that
you subsequently publish to that folder.

» Organize users into user groups, assign access levels and rights to the entire group, and assign
access levels and rights to specific members when necessary.

+ Create individual administrator accounts for each administrator in the system and add them to the
Administrators group to improve accountability for system changes.

- By default, the Everyone group is granted very limited rights to top-level folders in Information
platform services. After installation, it is recommended that you review the rights of Everyone group
members and assign security accordingly.
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Securing Information platform services

6.1 Security overview

This section details the ways in which Information platform services addresses enterprise security
concerns, thereby providing administrators and system architects with answers to typical questions
regarding security.

The Information platform services architecture addresses the many security concerns that affect today's
businesses and organizations. The current release supports features such as distributed security, single
sign-on, resource access security, granular object rights, and third-party authentication in order to
protect against unauthorized access.

Because Information platform services provides the framework for an increasing number of components
from the Enterprise family of SAP BusinessObjects products, this section details the security features
and related functionality to show how the framework itself enforces and maintains security. As such,
this section does not provide explicit procedural details; instead, it focuses on conceptual information
and provides links to key procedures.

After a brief introduction to security concepts for the system, details are provided for the following topics:
*  How to use encryption and data processing security modes to protect data.

+ How to set up the Secure Sockets Layer for Information platform services deployments.

» Guidelines for setting up and maintaining firewalls for Information platform services.

+ Configuring reverse proxy servers.

6.2 Disaster recovery planning

Certain steps must be taken to protect your organization's investment in Information platform services
to ensure maximum continuity of function lines of business in the event of a disaster. This section
provides guidelines for drafting a disaster recovery plan for your organization.

General guidelines
+ Perform regular system backups and send copies of some of the backup media offsite if necessary.

- Safely store all software media.
- Safely store all license documentation.
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Specific guidelines
There are three system resources that require specific attention in terms of disaster recovery planning:

Content in the file repository servers: this includes proprietary content such as reports. You should
regularly backup this content - in the event of a disaster there is no way to regenerate such content
without a regular backup process in place.

The system database used by the CMS: this resource contains all the crucial metadata for your
deployment such as user information, reports and other sensitive information that is particular to
your organization.

Database information key file (.dbinfo file): this resource contains the master key to the system
database. If for some reason this key is not available, you will not be able to access the system
database. It is highly recommended after deploying Information platform services you store the
password for this resource in a safe and known location. Without the password you will not be able
to regenerate the file and therefore lose access to the system database.

6.3 General recommendations for securing your deployment

The following are recommended guidelines for securing your Information platform services deployments.

Use firewalls to protect the communication between the CMS and other system components. If
possible, always hide your CMS behind the firewall. At the very least, ensure that the system database
is safely behind the firewall.

Add additional encryption to the File Repository Servers. Once the system is up and running,
proprietary content will be stored in these servers. Add additional encryption through the OS or use
a third party tool.

Deploy a reverse proxy server in front of the web application servers in order to hide them behind
a single IP address. This configuration routes all Internet traffic that is addressed to private web
application servers through the reverse proxy server, therefore hiding private IP addresses.
Strictly enforce corporate password policies. Ensure that user passwords are routinely changed.

If you have opted to install the system database and web application server provided with Information
platform services, you should access the relevant documentation to ensure these components are
deployed with adequate security configurations.

Use the Secure Sockets Layer (SSL) protocol for all network communication between clients and
servers in your deployment.

Access to the Central Management Console (CMC) should be restricted to local access only. For
information on deployment options for the CMC see the SAP BusinessObjectes Enterprise Web
Application Deployment Guide.

Related Topics

» Configuring the SSL protocol

» Password restrictions

» Configuring security for bundled third-party servers
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6.4 Configuring security for bundied third-party servers

If you have opted to install third-party server components that are bundled with Information platform
services, it is recommended that you access and review the documentation for the following bundled
components:

»  Microsoft SQL Server 2008 Express Edition: For detailed information on securing this system
database for Windows platforms see http://msdn.microsoft.com/en-us/li
brary/bb283235%28v=sql.100%29.aspx.

- IBM DB2 Workgroup Edition: For detailed information on securing this system database for UNIX
platforms see http://publib.boulder.ibm.com/infocenter/db2luw/vOr7/index.jsp?nav=/2_ .

» Apache Tomcat 6.0: For detailed information on security for this web application server see
http://tomcat.apache.org/tomcat-6.0-doc/index.html.

6.5 Active trust relationship

In a networked environment, a trust relationship between two domains is generally a connection that
allows one domain accurately to recognize users who have been authenticated by the other domain.
While maintaining security, the trust relationship allows users to access resources in multiple domains
without repeatedly having to provide their credentials.

Within the Information platform services environment, the active trust relationship works similarly to
provide each user with seamless access to resources across the system. Once the user has been
authenticated and granted an active session, all other Information platform services components can
process the user's requests and actions without prompting for credentials. As such, the active trust
relationship provides the basis for Information platform services's distributed security.

6.5.1 Logon tokens

A logon token is an encoded string that defines its own usage attributes and contains a user's session
information. The logon token's usage attributes are specified when the logon token is generated. These
attributes allow restrictions to be placed upon the logon token to reduce the chance of the logon token
being used by malicious users. The current logon token usage attributes are:

* Number of minutes

This attribute restricts the lifetime of the logon token.

> Number of logons
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This attribute restricts the number of times that the logon token can be used to log on to Information
platform services .

Both attributes hinder malicious users from gaining unauthorized access to Information platform services
with logon tokens retrieved from legitimate users.

Note:

Storing a logon token in a cookie is a potential security risk if the network between the browser and
application or web server is insecure — for example if the connection is made over a public network and
is not using SSL or Trusted Authentication. It is good practice to use Secure Sockets Layer (SSL) to
reduce security risk between the browser and application or web server.

When the logon cookie has been disabled, and the web server or web browser times out, the user is
presented with the logon screen. When the cookie is enabled, and the server or browser times out, the
user is seamlessly logged back onto the system. However, because state information is tied to the web
session, the user's state is lost. For example, if the user had a navigation tree expanded and a particular
item selected, the tree is reset.

For Information platform services, the default is to have logon tokens enabled in the web client, however,
you can disable logon tokens for Bl launch pad. When you disable the logon tokens in the client, the
user session will be limited by the web server or web browser timeout. When that session expires, the
user will be required to log in to Information platform services again.

6.5.2 Ticket mechanism for distributed security

Enterprise systems dedicated to serving a large number of users typically require some form of distributed
security. An enterprise system may require distributed security to support features such the transfer of
trust (the ability to allow another component to act on behalf of the user).

Information platform services addresses distributed security by implementing a ticket mechanism (one
that is similar to the Kerberos ticket mechanism). The CMS grants tickets that authorize components
to perform actions on behalf of a particular user. In Information platform services, the ticket is referred
to as the logon token.

This logon token is most commonly used over the Web. When users are first authenticated by Information
platform services they receive logon tokens from the CMS. The user's web browser caches this logon
token. When the user makes a new request, other Information platform services components can read
the logon token from the user's web browser.

6.6 Sessions and session tracking

In general, a session is a client-server connection that enables the exchange of information between
the two computers. A session's state is a set of data that describes the session's attributes, its
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configuration, or its content. When you establish a client-server connection over the Web, the nature
of HTTP limits the duration of each session to a single page of information; thus, your web browser
retains the state of each session in memory only for as long as any single Web page is displayed. As
soon as you move from one web page to another, the state of the first session is discarded and replaced
with the state of the next session. Consequently, Web sites and Web applications must somehow store
the state of one session if they need to reuse its information in another.

Information platform services uses two common methods to store session state:

+ Cookies—A cookie is a small text file that stores session state on the client side: the user's web
browser caches the cookie for later use. The Information platform services logon token is an example
of this method.

- Session variables—A session variable is a portion of memory that stores session state on the server
side. When Information platform services grants a user an active identity on the system, information
such as the user's authentication type is stored in a session variable. So long as the session is
maintained, the system neither has to prompt the user for the information a second time nor has to
repeat any task that is necessary for the completion of the next request.

For Java deployments, the session is used to handle .jsp requests; for .NET deployments, the
session is used to handle .aspx requests.

Note:

Ideally, the system should preserve the session variable while the user is active on the system. And,
to ensure security and to minimize resource usage, the system should destroy the session variable as
soon as the user has finished working on the system. However, because the interaction between a web
browser and a web server can be stateless, it can be difficult to know when users leave the system, if
they do not log off explicitly. To address this issue, Information platform services implements session
tracking.

6.6.1 CMS session tracking

The CMS implements a simple tracking algorithm. When a user logs on, the user is granted a CMS
session, which the CMS preserves until the user logs off, or until the web application server session
variable is released.

The web application server session is designed to notify the CMS on a recurring basis that it is still
active, so the CMS session is retained so long as the web application server session exists. If the web
application server session fails to communicate with the CMS for a ten-minute time period, the CMS
destroys the CMS session. This handles scenarios where client-side components shut down irregularly.

6.7 Environment protection
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Environment protection refers to the security of the overall environment in which client and server
components communicate. Although the Internet and web-based systems are increasingly popular due
to their flexibility and range of functionality, they operate in an environment that can be difficult to secure.
When you deploy Information platform services, environment protection is divided into two areas of
communication: web browser to web server, and web server to Information platform services.

6.7.1 Web browser to weh server

When data is transmitted between the web browser and the web server, some degree of security is
usually required. Relevant security measures usually involve two general tasks:

+ Ensuring that the communication of data is secure.

+ Ensuring that only valid users retrieve information from the web server.

Note:

These tasks are typically handled by web servers through various security mechanisms, including the
Secure Sockets Layer (SSL) protocol, and other such mechanisms. It is good practice to use Secure
Sockets Layer (SSL) to reduce security risk between the browser and application or web server.

You must secure communication between the web browser and the web server independently of
Information platform services. For details on securing client connections, refer to your web server
documentation.

6.7.2 Web server to Information platform services

Firewalls are commonly used to secure the area of communication between the web server and the
rest of the corporate intranet (including Information platform services). Information platform services
supports firewalls that use IP filtering or static network address translation (NAT). Supported environments
can involve multiple firewalls, web servers, or application servers.

6.8 Auditing security configuration modifications

Any changes to default security configurations for the following will not be audited by SAP
BusinessObjects Enterprise:

+ Properties files for the web applications (BOE, web services)

»  TrustedPrincipal.conf

*  Customization performed on Bl launch pad and Open Document
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In general, any security configuration modifications performed outside the CMC will not be audited.
This also applies to modifications performed though the Central Configuration Manager (CCM). Changes
committed through the CMC can be audited.

6.9 Auditing web activity

Information platform services provides insight into your system by recording web activity and allowing
you to inspect and to monitor the details. The web application server allows you to select the web
attributes—such as time, date, IP address, port number, and so on—that you want to record. The
auditing data is logged to disk and stored in comma-delimited text files, so you can easily report off the
data or import it into other applications.

6.9.1 Protection against malicious logon attempts

No matter how secure a system is, there is often at least one location that is vulnerable to attack: the
location where users connect to the system. It is nearly impossible to protect this location completely,
because the process of simply guessing a valid user name and password remains a viable way to
attempt to "crack” the system.

Information platform services implements several techniques to reduce the probability of a malicious
user achieving access to the system. The various restrictions listed below apply only to Enterprise
accounts—that is, the restrictions do not apply to accounts that you have mapped to an external user
database (LDAP or Windows AD). Generally, however, your external system will enable you to place
similar restrictions on the external accounts.

6.9.2 Password restrictions

Password restrictions ensure that users authenticating the default Enterprise authentication create
passwords that are relatively complex. You can enable the following options:

» Enforce mixed-case passwords

This option ensures that passwords contain at least two of the following character classes: upper
case letters, lower case letters, numbers, or punctuation.

» Must contain at least N characters

By enforcing a minimum complexity for passwords, you decrease a malicious user's chances of
simply guessing a valid user's password.
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6.9.3 Logon restrictions

Logon restrictions serve primarily to prevent dictionary attacks (a method whereby a malicious user
obtains a valid user name and attempts to learn the corresponding password by trying every word in a
dictionary). With the speed of modern hardware, malicious programs can guess millions of passwords
per minute. To prevent dictionary attacks, Information platform services has an internal mechanism
that enforces a time delay (0.5-1.0 second) between logon attempts. In addition, Information platform
services provides several customizable options that you can use to reduce the risk of a dictionary attack:

- Disable accounts after N failed attempts to log on
* Reset failed logon count after N minute(s)

* Re-enable account after N minute(s)

6.9.4 User restrictions

User restrictions ensure that users authenticating the default Enterprise authentication create new
passwords on a regular basis. You can enable the following options:

» Must change password every N day(s)

» Cannot reuse the N most recent password(s)

* Must wait N minute(s) to change password

These options are useful in a number of ways. Firstly, any malicious user attempting a dictionary attack
will have to recommence every time passwords change. And, because password changes are based
on each user's first logon time, the malicious user cannot easily determine when any particular password

will change. Additionally, even if a malicious user does guess or otherwise obtain another user's
credentials, they are valid only for a limited time.

6.9.5 Guest account restrictions

The Information platform services authentication provider supports anonymous single sign-on for the
Guest account. Thus, when users connect to Information platform services without specifying a user
name and password, the system logs them on automatically under the Guest account. If you assign a
secure password to the Guest account, or if you disable the Guest account entirely, you disable this
default behavior.
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6.10 Processing extensions

Information platform services allows you to further secure your reporting environment through the use
of customized processing extensions. A processing extension is a dynamically loaded library of code
that applies business logic to particular Information platform services view or schedule requests before
they are processed by the system.

Through its support for processing extensions, the Information platform services administration SDK
essentially exposes a "handle" that allows developers to intercept the request. Developers can then
append selection formulas to the request before the report is processed.

A typical example is a report-processing extension that enforces row-level security. This type of security
restricts data access by row within one or more database tables. The developer writes a dynamically
loaded library that intercepts view or schedule requests for a report (before the requests are processed
by a Job Server, Processing Server, or Report Application Server). The developer's code first determines
the user who owns the processing job; then it looks up the user's data-access privileges in a third-party
system. The code then generates and appends a record selection formula to the report in order to limit
the data returned from the database. In this case, the processing extension serves as a way to incorporate
customized row-level security into the Information platform services environment.

Tip:

By enabling processing extensions, you configure the appropriate Information platform services server
components to dynamically load your processing extensions at runtime. Included in the SDK is a fully
documented API that developers can use to write processing extensions. For more information, see
the developer documentation available on your product distribution.

6.11 Overview of Information platform services data security

Administrators of Information platform services systems manage the way sensitive data is secured
through the following:

+ A security setting at the cluster level that determines which applications and clients can access the
CMS. This setting is managed through the Central Configuration Manager.

+ A two-key cryptography system that controls both access to the CMS repository, and keys used to
encrypt/decrypt objects within the repository. Access to the CMS repository is set via the Central
Configuration Manager, while the Central Management Console has a dedicated management area
for cryptographic keys.

These features allow administrators to set Information platform services deployments to particular data
security compliance levels and to manage encryption keys used to encrypt and decrypt data within the
CMS repository.
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6.11.1 Data processing security modes

Information platform services can operate in two possible data processing security modes:

+  The default data processing security mode. In certain instances, systems running in this mode will
use hard-coded encryption keys and do not follow a specific standard. The default mode enables
backward compatibility with previous versions of Information platform services client tools and
applications.

» A data security mode designed to meet guidelines stipulated by the Federal Information Processing
Standard (FIPS) - specifically FIPS 140-2. In this mode FIPS-compliant algorithms and cryptographic
modules are used to protect sensitive data. When Information platform services runs in FIPS-compliant
mode, all clients tools and applications that do not meet FIPS guidelines are automatically disabled.
Information platform services 4.0 client tools and applications are designed to meet the FIPS 140-2
standard. Older clients and applications will not work when Information platform services 4.0 is
running in FIPS-compliant mode.

The data processing mode is transparent to system users. In both data processing security modes,
sensitive data is encrypted and decrypted in the background by an internal encryption engine.

It is recommended that you use the FIPS-compliant mode in the following circumstances:

* Your Information platform services deployment will not need to use or interact with any legacy client
tools or applications.

* Your organization's data processing standards and guidelines prohibit the use of hard-coded
encryption keys.

* Your organization is required to secure sensitive data according to FIPS 140-2 regulations.

The data processing security mode is set through the Central Configuration Manager on both Windows
and UNIX platforms. Every node in a clustered environment must bet set to the same mode.

6.11.1.1 To turn on FIPS-compliant mode on Windows

By default, FIPS-compliant mode is off after Information platform services is installed. Use the instructions
below to turn on the FIPS-compliant setting for all nodes in your deployment.

1. To start the CCM, choose Programs > SAP BusinessObjects Bl platform 4 > SAP
BusinessObjects Bl platform > Central Configuration Manager.

2. In the CCM, right-click the Server Intelligence Agent (SIA) and choose Stop.
Caution:
Do not proceed to step 3 until the SIA status is marked as Stopped.

3. Right-click the SIA and choose Properties.
The "Properties" dialog box appears, displaying the Properties tab.
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4. Add -fips to the Command field, and click Apply.
5. Click OK to close the "Properties" dialog box.
6. Restart the SIA.

The SIA is operating in FIPS-complaint mode.

You must turn on the FIPS-compliant setting on all SIAs in your Information platform services deployment.

6.11.1.2 To turn on FIPS-compliant mode on Unix

All nodes in your Information platform services deployment must be stopped before attempting the
following procedure.

By default, FIPS-compliant mode is off after Information platform services is installed. Use the instructions
below to turn on the FIPS-compliant setting for all nodes in your deployment.
1. Go to the directory where Information platform services is installed on your Unix computer.
2. Change to the sap bobj directory.
3. Type ccm.config and press Enter.
The ccm. config file is loaded.
4. Add -fips to the to the node launch command parameter.
The node launch command parameter appears as [node namelaunch].

5. Save your changes and Exit.
6. Restart the node.

The node is now operating in FIPS-complaint mode.

You must turn on the FIPS-compliant setting on all the nodes in your Information platform services
deployment.

6.11.1.3 To turn off FIPS-compliant mode on Windows

All servers in your Information platform services deployment must be stopped before attempting the
following procedure.

If your deployment is running on FIPS-compliant mode, use the following instructions to turn off the
setting.
1. In the CCM, right-click the Server Intelligence Agent (SIA) and choose Stop.

Caution:

Do not proceed to step 2 until the node status is marked as Stopped.
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2. Right-click the SIA and choose Properties.
The "Properties" dialog box appears, displaying the Properties tab.

3. Remove -fips from the "Command" field and click Apply.
4. Click OK to close the "Properties" dialog box.
5. Restart the SIA.

6.12 Cryptography in Information platform services

Sensitive Data

Information platform services cryptography is designed to protect sensitive data stored in the CMS
repository. Sensitive data includes user credentials, data source connectivity data, and any other info
objects that store passwords. This data is encrypted to ensure privacy, keep it free from corruption,
and maintain access control. All the requisite encryption resources (including the encryption engine,
RSA libraries) are installed by default on each Information platform services deployment.

Information platform services uses a two-key cryptography system.

Cryptographic Keys
Encryption and decryption of sensitive data is handled in the background through the SDK interacting

with the internal encryption engine. System administrators manage data security through symmetric
encryption keys without directly encrypting or decrypting specific data blocks.

In the Information platform services system, symmetric encryption keys known as Cryptographic Keys
are used to encrypt/decrypt sensitive data. The Central Management Console has a dedicated
management area for cryptographic keys. Use the "Cryptographic Keys" to view, generate, deactivate,
revoke, and delete keys. The system ensures that any key required to decrypt sensitive data cannot
be deleted.

Cluster Keys

Cluster keys are symmetric key wrapping keys that protect cryptographic keys stored in the CMS
repository. Using symmetric key algorithms, cluster keys maintain a level of access control to the CMS
repository. Each Information platform services node is assigned a cluster key during installation setup.
System administrators can use the CCM to reset the cluster key.

6.12.1 Working with cluster keys

During the installation setup for Information platform services, an eight character cluster key is created
for the Server Intelligence Agent. This key is used to encrypt all the cryptographic keys in the CMS
repository. Without the correct cluster key you cannot access the CMS. The cluster key is stored in
encrypted format in the dbinfo file. In a default Windows installation the file is stored in the following
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directory: C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects
Enterprise XI 4.0\win64 x64 .On Unix systems, the file is stored in the platform directory under
<INSTALLDIR>/sap bobj/enterprise xi40/.

Unix platform Path

AIX <INSTALLDIR>/sap bobj/enterprise xi40/ aix rs6000/
Solaris <INSTALLDIR>/sap bobj/enterprise xi40/ solaris sparc/
Linux <INSTALLDIR>/sap bobj/enterprise xi40/ linux x86/
HP_UX <INSTALLDIR>/sap bobj/enterprise xi40/ hpux pa-risc/

The file is name in based on the following convention: boe <sia name>.dbinfo, where <sia_name>
is the name of the server intelligence agent for the cluster.

Note:
The cluster key for any given node cannot be retrieved from the dbinfo file. It is recommended that
system administrators take considered and careful measures to protect cluster keys.

Only users with administrative privileges can reset cluster keys. When required, use the CCM to reset
the eight-character cluster key for every node your deployment. New cluster keys are automatically
used to wrap the cryptographic keys within the CMS repository.

6.12.1.1 To reset the cluster key on Windows

Before resetting the cluster key for make sure all servers managed by the Server Intelligence Agent
are stopped.

Use the following procedure to reset the cluster key for your node.

1. To start the CCM, choose Programs > SAP BusinessObjects Bl platform 4 > SAP
BusinessObjects Bl platform > Central Configuration Manager.

2. In the CCM, right-click the Server Intelligence Agent (SIA) and choose Stop.

Caution:
Do not proceed to step 3 until the SIA status is marked as Stopped.

3. Right-click the Server Intelligence Agent (SIA) and choose Properties.
The "Properties" dialog box appears.

4. Click the Configuration tab.

5. Under "CMS Cluster Key Configuration”, click Change.
A warning message appears.

6. Click Yes to continue.
The "Change Cluster Key" dialog box appears.
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Type the same eight-character key in the New Cluster Key box and the Confirm New Cluster Key
box.

On Windows, cluster keys must contain a combination of uppercase and lowercase characters.
Note:
Users can optionally generate a random key. A random key is required to be FIPS-compliant.

Click OK to submit the new cluster key to the system.
A message appears, confirming that the cluster key has been reset successfully.

Restart the SIA.

In a multi-node cluster, you must reset the cluster keys for all SIAs in your Information platform services
deployment to the new key.

6.12.1.2 To reset the cluster key on UNIX

Before resetting the cluster key for a node, make sure all servers managed by the node have been
stopped.

1.
2,
3.

Go to the directory where Information platform services is installed on your UNIX machine.
Change to the sap bobj directory.

Type cmsdbsetup.sh and press Enter.

The "CMS Database Setup" screen appears.

Type the name of the node and press Enter.

Type 2 to change the cluster key.

A warning message appears.

Select Yes to continue.

In the field provided, type an eight-character new cluster key and press Enter.

Note:

On UNIX platforms, a valid cluster key contains any combination of eight characters without
restrictions.

Re-enter the new cluster key in the field provided and press Enter.

A message appears, informing you that the cluster key has been successfully reset.

Restart the node.

You must reset all the nodes in your Information platform services deployment to use the same cluster
key.
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6.12.2 Cryptographic Officers

To manage cryptographic keys in the CMC you must be a member of the Cryptographic Officers group.
The default administrator account created for Information platform services is also a member of the
Cryptographic Officers group. Use this account to add users to the Cryptographic Officers group as
required. It is recommended that membership to the group be restricted to a limited number of users.

Note:
When users are added to the Administrators group, they do not inherit the rights required to perform
management tasks on cryptographic keys.

6.12.2.1 To add a user to the Cryptographic Officers group

A user account must exist in the Information platform services system before it can be added to the
Cryptographic Officers group.

Note:
You must be a member of both of the Administrators and Cryptographic Officers groups to add a user
to the Cryptographic Officers group.

1. Inthe "Users and Groups" management area of the CMC, select the Cryptographic Officers group.
2. Click Actions > Add Members to Group.
The "Add" dialog box appears.

3. Click User list.
The Available users/groups list refreshes and displays all user accounts in the system.

4. Move the user account that you want to add to the Cryptographic Officers group from the Available
users/groups list to the Selected users/groups list.

Tip:
To search for a specific user, use the search field.

5. Click OK.

As a member of the Cryptographic Officers group, the newly added account will have access to the
"Cryptographic Keys" management area in the CMC.

6.12.2.2 To view cryptographic keys in the CMC
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The CMC application contains a dedicated management area for cryptographic keys used by the
Information platform services system. Access to this area is restricted to members of the Cryptographic
Officers group.

1. To start the CMC, choosePrograms > SAP BusinessObjects Bl platform 4 > SAP
BusinessObjects Bl platform > SAP BusinessObjects Bl platform Central Management Console.

The CMC home page opens.

2. Click the Cryptographic Keys tab.
The "Cryptographic Keys" management area appears.

3. Double-click the cryptographic key for which you want to see details.

Related Topics
* To view objects associated with a cryptographic key

6.12.3 Managing cryptographic keys in the CMC

Cryptographic officers use the "Cryptographic Keys" management area to review, generate, deactivate,
revoke, and delete keys used to protect sensitive data stored in the CMS repository.

All cryptographic keys currently defined in the system are listed on the "Cryptographic Keys" management
area . Basic information for each key is provided under the headings described in the following table:

Title Name identifier of the cryptographic key

Status The key's current status

Last Change Date and time stamp for the last change associated with the cryptographic
key

Objects Number of objects associated with the key

Related Topics

* Cryptographic key status

 To create a new cryptographic key

* To delete a cryptographic key from the system

* To revoke a cryptographic key

» To view objects associated with a cryptographic key
» To mark cryptographic keys as compromised
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6.12.3.1 Cryptographic key status

The following table lists all the possible status options for cryptographic keys in the Information platform
services system:

Active Only one cryptographic key can be designated by Active status in the system.
This key is used to encrypt current sensitive data that will be stored in the
CMS database and to decrypt all objects that appear in its Object List. Once
a new cryptographic key is created, the currently active key reverts to the
Deactivated status. An key with an Active status cannot be deleted from the
system.

Deactivated A deactivated key can no longer be used to encrypt data. It can, however,
be used to decrypt all objects in its Object List. You cannot reactivate a key
once it has been deactivated. A key with a Deactivated status cannot be
deleted from the system. You must changed a key's status to Revoked before
it can be deleted.

Compromised A cryptographic key that is deemed to be insecure can be assigned the
Compromised status. After flagging the key, you can later re-encrypt data
objects that are still associated with the key. Once a key is marked as com-
promised, it must be revoked before it can be deleted from the system.

Revoked When a cryptographic key is revoked, a process is launched in which all ob-
jects currently associated with the key are re-encrypted with the current Active
cryptographic key. Once a key is revoked it can safely be deleted from the
system. The revocation mechanism ensures that data in the CMS database
can always be decrypted. There is no way to reactivate a key once it has
been revoked.
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Deactivated: Rekeying- | Indicates that the cryptographic key is in the process of being revoked. Once
in process the process is complete, the key will have a Revoked status.

Deactivated: Rekeying- | Indicates that the process for revoking a cryptographic key has been suspend-
suspended ed. This usually occurs if the process has been deliberately suspended or if
a data object associated with the key is not available.

Revoked-Compromised | A key has a Revoked-Compromised status if it has been marked as compro-
mised and all data previously associated with it has been encrypted with an-
other key. When a Deactivated key is marked as compromised, you can not
take action or revoke the key. Once a compromised key is revoked, it can be
deleted.

6.12.3.2 To view ohjects associated with a cryptographic key

1. Select the key in the "Cryptographic Keys" management area of the CMC.
2. Click Manage > Properties.
The cryptographic key's "Properties" dialog box appears.

3. Click Object List in the navigation pane on the left of the "Properties” dialog box.
All the objects associated with the cryptographic key are listed to the right of the navigation pane.

Tip:
Use the search functions to look for a specific object.

6.12.3.3 To create a new cryptographic key

Caution:
When you create a new cryptographic key, the system automatically deactivates the current "Active"
key. Once a key has been deactivated it cannot be restored as the "Active" key.

1. In the "Cryptographic Keys "management area of the CMC, click Manage > New > Cryptographic
Key.
The "Create New Cryptographic Key" dialog box opens displaying a warning message.

2. Click Continue to create the new cryptographic key.

3. Type the name and a description of the new cryptographic key; click OK to save your information.

The new key is listed as the only active key in the "Cryptographic Keys" management area. The
previously "Active" key is now marked as "Deactivated."
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All new sensitive data generated and stored in the CMS database will now be encrypted with the new
cryptographic key. You have the option to revoke the previous key and re-encrypt all its data objects
with the new active key.

6.12.3.4 To mark cryptographic keys as compromised

You can mark a cryptographic key as compromised if for some reason a cryptographic key is considered
to no longer be secure. This is useful for tracking purposes and you can proceed to identify which data
objects are associated with the key. A cryptographic key must be deactivated before it can marked as
compromised.

Note:
You can also mark a key as compromised after it has been revoked.
1. Go to the "Cryptographic Keys " management area of the CMC.
2. Select the cryptographic key you want to mark as compromised.
3. Click Actions > Mark as Compromised.
The "Mark as Compromised" dialog box displays a warning message.

4. Click Continue.
5. Select one of following options from the "Mark as Compromised" dialog:

» Yes: launches the process to re-encrypt all data objects that are associated with the compromised
key.

* No: the "Mark as Compromised" dialog box is closed and the cryptographic key is marked as
"Compromised" in the "Cryptographic Keys" management area.
Note:

If you select No, sensitive data will continue to be associated with the compromised key. The
compromised key will be used by the system to decrypt the associated objects.

Related Topics

* To revoke a cryptographic key

* Cryptographic key status

* To view objects associated with a cryptographic key

6.12.3.5 To revoke a cryptographic key

A Deactivated cryptographic key can still be used by data objects associated with it. To break the
association between the encrypted objects and the deactivated key, you must revoke the key using the
following instructions.
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1. In the "Cryptographic Keys" management area of the CMC, select the key you want to revoke.
2. Click Actions > Revoke.
The "Revoke key" dialog box appears, displaying a warning message.

3. Click OK to revoke the cryptographic key.

A process starts that encrypts all key objects with the active key. If the key is associated with many
data objects, it is marked as Deactivated: Rekeying-In Process, until the re-encryption process is
complete.

Once a cryptographic key is revoked, it can be safely removed from the system because no sensitive
data objects require the key for decryption.

6.12.3.6 To delete a cryptographic key from the system

Before you can delete a cryptographic key from the Information platform services system, you must
ensure that no data objects in the system require the key. This restriction ensures that all sensitive data
stored in the CMS repository can always be decrypted.

After you have successfully revoked a cryptographic key, use the following instructions to delete the
key from the system.

1. Go to the "Cryptographic Keys " management area of the CMC.
2. Select the cryptographic key you want to delete.
3. Click Manage > Delete .

The "Delete key " dialog box displays a warning message.

4. Click Delete to remove the cryptographic key from the system.
The deleted key no longer appears in the "Cryptographic Keys "management area of the CMC.

Note:
Once a cryptographic key is deleted from the system, it cannot be restored.

Related Topics
* To revoke a cryptographic key
* Cryptographic key status

6.13 Configuring servers for SSL

You can use the Secure Sockets Layer (SSL) protocol for all network communication between clients
and servers in your Information platform services deployment.
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To set up SSL for all server communication, you need to perform the following steps:
+ Deploy Information platform services with SSL enabled.

+ Create key and certificate files for each machine in your deployment.

+ Configure the location of these files in the Central Configuration Manager (CCM) and your web
application server.

Note:

If you are using thick clients, such as Crystal Reports or Designer, you also need to configure them for
SSL if you will be connecting to the CMS from these thick clients. Otherwise, you will get errors when
you attempt to connect to a CMS that has been configured for SSL from a thick client that has not been
configured the same way.

6.13.1 Creating key and certificate files

To set up SSL protocol for your server communication, use the SSLC command line tool to create a
key file and a certificate file for each machine in your deployment.

Note:

* You need to create certificates and keys for all machines in the deployment, including machines
running thick client components such as Crystal Reports. For these client machines, use the
sslconfig command line tool to do the configuration.

» For maximum security, all private keys should be protected and should not be transferred through
unsecured communication channels.

+ Certificates created for previous versions of Information platform services will not work with this
release. These certificates will need to be re-created.

6.13.1.1 To create key and certificate files for a machine

1. Run the SS1.C.exe command line tool.

The SSLC tool is installed with your Information platform services software. (On Windows, for
example, it is installed by default in <INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\win64 x64.)

2. Type the following command:

sslc req -config sslc.cnf -new -out cacert.req

This command creates two files, a Certificate Authority (CA) certificate request (cacert.req) and a
private key (privkey.pem).

3. To decrypt the private key, type the following command:
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sslc rsa -in privkey.pem -out cakey.pem

This command creates the decrypted key, cakey.pem.

. To sign the CA certificate, type the following command:

sslc x509 -in cacert.reqg -out cacert.pem -req -signkey cakey.pem -days
365

This command creates a self-signed certificate, cacert.pem, that expires after 365 days. Choose
the number of days that suits your security needs.

. Using a text editor, open the ss1c. cnf file, which is stored in the same folder as the SSLC command

line tool.

Note:
Using a text editor is highly recommended for Windows because Windows Explorer may not properly
recognize and display files with the .cnf extension.

. Perform the following steps based on settings in the ss1c.cnf file.

Place the cakey.pem and cacert.pem files in the directories specified by sslc.cnf file's
certificate and private key options.

By default, the settings in the sslc.cnf file are:

Sdir/cacert.pem

certificate
private key = Sdir/private/cakey.pem
Create a file with the name specified by the ss1c.cnf file's database setting.

Note:
By default, this file is Sdir/index. txt. The file should be empty.

Create a file with the name specified by the ss1c.cnf file's serial setting.
Ensure that this file provides an octet-string serial number (in hexadecimal format).

Note:
To ensure that you can create and sign more certificates, choose a large hexadecimal number
with an even number of digits, such as 11111111111111111111111111111111.

Create the directory specified by the sslc.cnf file's new certs dir setting.

. To create a certificate request and a private key, type the following command:

sslc req -config sslc.cnf -new -out servercert.req

The certificate and key files generated are placed under the current working folder.

. Run the following command to decrypt the key in the privkey.pem file.

sslc rsa -in privkey.pem -out server.key

. To sign the certificate with the CA certificate, type the following command:

sslc ca -config sslc.cnf -days 365 -out servercert.pem -in servercert.req

2012-08-15



Securing Information platform services

10.

1.

12.

This command creates the servercert.pem file, which contains the signed certificate.

Use the following commands to convert the certificates to DER encoded certificates:
sslc x509 -in cacert.pem -out cacert.der -outform DER
sslc x509 -in servercert.pem -out servercert.der -outform DER

Note:

The CA certificate (cacert.der) and its corresponding private key (cakey.pem) need to be
generated only once per deployment. All machines in the same deployment must share the same
CA certificates. All other certificates need to be signed by the private key of any of the CA certificates.

Create a textfile (passphrase. txt) for storing the plain text passphrase used for decrypting the
generated private key.

Store the following key and certificate files in a secure location (under the same directory (d:/ss1))
that can be accessed by the machines in your Information platform services deployment:

+ the trusted certificate file (cacert.der)
» the generated server certificate file (servercert.der)
» the server key file (server. key)

» the passphrase file

This location will be used to configure SSL for the CCM and your web application server.

6.13.2 Configuring the SSL protocol

After you create keys and certificates for each machine in your deployment, and store them in a secure
location, you need to provide the Central Configuration Manager (CCM) and your web application server
with the secure location.

You also need to implement specific steps for configuring the SSL protocol for the web application
server and for any machine running a thick-client application.

6.13.2.1 To configure the SSL protocol in the CCM

A\

In the CCM, right-click the Server Intelligence Agent and choose Properties.

In the Properties dialog box, click the Protocol tab.

Make sure Enable SSL is selected.

Provide the file path for the directory where you stored the key and certificate files.
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SSL Certificates Folder |Folder where all the required SSL certificates and files are stored. For
example: d:\ssl.

Server SSL Certificate [ Name of the file used to store the server SSL certificate. By default,

File servercert.der.
SSL Trusted Certificates | Name of the file with the SSL trusted certificate. By default, cac
File ert.der.

SSL Private Key File Name of the SSL private key file used to access the certificate. By de-
fault, server.key.

SSL Private Key Name of the text file containing the passphrase used to access the pri-
Passphrase File vate key. By default, passphrase.txt.
Note:

Make sure you provide the directory for the machine that the server is running on.

6.13.2.2 To configure the SSL protocol for the web application server

1. If you have a J2EE web application server, run the Java SDK with the following system properties
set. For example:

-Dbusinessobjects.orb.oci.protocol=ssl -DcertDir=d:\ssl -DtrustedCert=cacert.der -DsslCert=clientcert.der
-DsslKey=client.key
-Dpassphrase=passphrase.txt

The following table shows the descriptions that correspond to these examples:

The directory to store all the certificates and

DcertDir=d:\ssl
keys.

Trusted certificate file. If specifying more than

DtrustedCert=cacert.der . .
one, separate with semicolons.

DsslCert=clientcert.der Certificate used by the SDK.

DsslKey=client.key Private key of the SDK certificate.
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The file that stores the passphrase for the pri-

D h = h .txt
passphrase=passphrase.tx vate key.

2. Ifyou have an IIS web application server, run the ss1config tool from the command line and follow
the configuration steps.

6.13.2.3 To configure the thick client

Before performing the following procedure you need to create and save all the required SSL resources
(for example, certificates and private keys) in a known directory.

In the procedure below it is assumed that you have followed the instructions for creating the following
SSL resources:

SSL certificates folder d:\ssl

Server SSL certificate file name servercert.der
SSL trusted certificate or root certificate file name cacert.der

SSL private key file name server.key

File containing passphrase for accessing the SSL private key file passphrase.txt

Once the above resources have been created, use the following instructions to configure thick client
applications such as the Central Configuration Manager (CCM) or the upgrade management tool.

1. Make sure the thick-client application is not in operation.

Note:
Make sure you provide the directory for the machine that the server is running on.

2. Run the sslconfig.exe command line tool.

The SSLC tool is installed with your software. (On Windows, for example, it is installed by default
in <INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win64 x64.)

3. Type the following command:

sslconfig.exe -dir d:\SSL -mycert servercert.der -rootcert cacert.der -mykey server.key
-passphrase passphrase.txt -protocol ssl

4. Restart the thick client application.
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Related Topics
* To create key and certificate files for a machine

6.13.2.3.1 To configure SSL login for translation management tool

To enable users to use SSL login with the translation management tool, information about the SSL

resources must be added to the tool's configuration (. ini) file.

1. Locate the TransMgr. ini file in the following directory: <INSTALLDIR>\SAP BusinessObjects

Enterprise XI 4.0\win32_x86.
2. Using a text editor, open the TransMgr. ini.
3. Add the following parameters:

-Dbusinessobjects.orb.oci.protocol=ssl -DcertDir=D:\SSLCert

-DtrustedCert=cacert.der -DsslCert=servercert.der -DsslKey=server.key

-Dpassphrase=passphrase.txt -jar program.jar

4. Save the file and close the text editor.

Users can now use SSL to log into the translation management tool.

6.13.2.3.2 To configure SSL for report conversion tool

Before performing the following procedure you need to create and save all the required SSL resources
(for example, certificates and private keys) in a known directory. In addition, the report conversion tool

must be installed as part of your SAP BusinessObjects Enterprise deployment.

In the procedure below it is assumed that you have followed the instructions for creating the following

SSL resources:

SSL certificates folder

d:\ssl

Server SSL certificate file name

servercert.der

SSL trusted certificate or root certificate file name

cacert.der

SSL private key file name

server.key

File containing passphrase for accessing the SSL private key file

passphrase.ixt

Once the above resources have been created, use the following instructions to configure SSL to work

with the report conversion tool.

1. Create a Windows environment variable BOBJ MIGRATION on the machine hosting the report

conversion tool.

Tip:
The variable can be set to any value.

2. Using a text editor, open the migration.bat in the following directory:

<INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win32 x86\scripts\.
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5.

Users can now use SSL to access the report conversion tool.

6.14 Understanding communication between Information platform services

Located the following line:

start "" "$JRE%\bin\javaw" -Xmx512m -XsslOm -jar "$SHAREDIR%\lib\migration.jar"

. Add the following after the -Xss10m parameter:

-Dbusinessobjects.orb.oci.protocol=ssl
-DcertDir=C:/ssl
-DtrustedCert=cacert.der
-DsslCert=servercert.der
-DsslKey=server.key
-Dpassphrase=passphrase.txt
-Dbusinessobjects.migration

Note:
Ensure there is a space between each parameter.

Save the file and close the text editor.

components

If your Information platform services system is deployed entirely on the same secured subnet, there
is no need to perform any special configuration of your firewalls. However, you might choose to deploy

some components on different subnets separated by one or more firewalls.

It is important to understand the communication between Information platform services servers, rich
clients, and the web application server hosting the Information platform services SDK before configuring
your system to work with firewalls.

Related Topics

+ Configuring Bl platform for firewalls
» Examples of typical firewall scenarios

6.14.1 Overview of Information platform services servers and communication ports

Itis important to understand Information platform services servers and their communication ports if the

Information platform services system is deployed with firewalls.
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6.14.1.1 Each Information platform services server binds to a Request Port

An Information platform services server, the Input File Repository Server for example, binds to a Request
Port when it starts. Other Information platform services components including servers, rich clients, and
the SDK hosted in the web application server can use this Request Port to communicate with the server.

A server will select its Request Port number dynamically when the server starts or restarts, unless it is
configured to use a specific port number. A specific Request Port number must be configured for servers
that communicate with other Information platform services components across a firewall.

6.14.1.2 Each Information platform services server registers with the CMS

Information platform services servers register with the CMS when they start. When a server registers,
the CMS records:

*  The hostname (or IP address) of the server's host machine.
« The server's Request Port number.

6.14.1.3 Central Management Server provides a directory of registered services

The Central Management Server (CMS) provides a directory of the Information platform services services
that have registered with it. Other Information platform services components such as services, rich
clients, and the SDK hosted in the web application server can contact the CMS and request a reference
to a particular service. A service's reference contains the service's Request Port number and the host
name (or IP address) of the server's host computer and service ID.

Information platform services components might reside on a different subnet than the server they are
using. The host name (or IP address) contained in the service's reference must be routable from the
component's computer.

Note:

The reference to an Information platform services server will contain the server computer's host name
by default. (If a computer has more than one hostname, the primary hostname is chosen). You can
configure a server so that its reference contains the IP address instead.

Related Topics
+ Communication between Information platform services components
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6.14.1.4 The CMS uses two ports

The CMS uses two ports: the Request Port and the Name Server Port. The Request Port is selected
dynamically by default. The Name Server Port is 6400 by default.

All Information platform services servers and client applications will initially contact the CMS on its
Name Server port. The CMS will respond to this initial contact by returning the value of its Request
Port. The servers will use this Request Port for subsequent communication with the CMS.

6.14.1.5 Server Intelligence Agents (SIA) communicate with the Central
Management Server (CMS)

Your deployment will not work if the Server Intelligence Agent (SIA) and Central Management Server
(CMS) cannot communicate with each other. Ensure that your firewall ports are configured to allow
communication between all SIAs and all CMSs in the cluster.

6.14.1.6 Jobh server child processes communicate with the data tier and the CMS

Most job servers create a child process to handle a task such as generating a report. The job server
will create one or more child processes. Each child process has its own Request Port.

By default, a job server will dynamically select a Request Port for each child process. You can specify
a range of port numbers that the job server can select from.

All child processes communicate with the CMS. If this communication crosses a firewall, you must:

- Specify the range of port numbers that the job server can select from by adding the -re
questJSChildPorts<lowestport><highestport>and -requestPort<port>parameters
to the server's command line. Note that the port range should be large enough to allow the maximum
number of child process as specified by -maxJobs.

+ Open the specified port range on the firewall.

Many child processes communicate with the data tier. For example, a child process might connect to
a reporting database, extract data, and calculate values for a report. If the job server child process
communicates with the data tier across a firewall, you must:

+  Open a communicate path on the firewall from any port on the job server machine to the database
listen port on the database server machine.
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Related Topics

« Command lines overview

6.14.2 Communication between Information platform services components

Information platform services components, such as browser clients, rich clients, servers, and the SDK
hosted in the web application server, communicate with each other across the network during typical
workflows. You must understand these workflows to deploy SAP BusinessObjects products across
different subnets that are separated by a firewall.

6.14.2.1 Requirements for communication hetween Information platform
services components

Deployments of Information platform services must conform to these general requirements.

1.

Every server must be able to initiate communication with every other Information platform services
server on that server's Request Port.

. The CMS uses two ports. Every Information platform services server, Information platform services

rich client, and the web application server that hosts the Information platform services SDK must
be able to initiate communication with the Central Management Server (CMS) on both of its ports.

. Every job server child process must be able to communicate with the CMS.
. Thick clients must be able to initiate communication with the Request Port of the Input and Output

File Repository Servers

If auditing is enabled for thick clients and web applications they must be able to initiate communication
with the Request Port of the Adaptive Processing Servers that hosts the Client Auditing Proxy
Service.

In general, the web application server that hosts the Information platform services SDK must be
able to communicate with the Request Port of every Information platform services server.

Note:

The web application server only needs to communicate with Information platform services servers
that are used in the deployment. For example, if Crystal Reports is not being used, the web application
server does not need to communicate with the Crystal Reports Cache Servers.

. Job Servers use the port numbers that are specified with the —-requestJsChildPorts <port

range>command. If no range is specified in the command line, the servers use random port
numbers. To allow a job server to communicate with a CMS, FTP, or mail server on another machine
open all of the ports in the range specified by ~-requestJsSChildPorts on your firewall.

. The CMS must be able to communicate with the CMS database listen port.
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9. The Connection Server, most Job Server child process, and every system database and auditing
Processing Server must be able to initiate communication with the reporting database listen port.

Related Topics
« Information platform services port requirements

6.14.2.2 Information platform services port requirements

This section lists the communication ports used by Information platform services servers, thick clients,
the web application server hosting the SDK, and third-party software applications. If you deploy

Information platform services with firewalls, you can use this information to open the minimum number
of ports in those firewalls.

6.14.2.2.1 Port Requirements for Information platform services applications

This table lists the servers and port numbers used by Information platform services applications.

Associated Servers

Server Port Requirements

Crystal Re-
ports

SAP Crystal
Reports
2011 design-
er

CMS
Input FRS
Output FRS

Crystal Reports 2011 Report
Application Server (RAS)

Crystal Reports 2011 Process-
ing Server

Crystal Reports Cache Server

CMS Name Server Port (6400 by de-
fault)

CMS Request Port
Input FRS Request Port
Output FRS Request Port

Crystal Reports 2011 Report Applica-
tion Server Request Port

Crystal Reports 2011 Processing
Server Request Port

Crystal Reports Cache Server Request
Port
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Associated Servers

Server Port Requirements

CMS Name Server Port (6400 by de-
fault)

CMS
CMS Request Port
Input FRS
SAP Crystal Input FRS Request Port
Crystal Re- | Reports for | Output FRS
ports Enterprise Output FRS Request Port
designer Crystal Reports Processing
Server Crystal Reports Processing Server
Request Port
Crystal Reports Cache Server
Crystal Reports Cache Server Request
Port
CMS
Input FRS CMS Name Server Port (6400 by de-
fault)
SAP Busi- Output FRS CMS Request Port
Dashboards | nessObjects | Web Services provider appli-
Dashboards | cation (dswsbobje.war)that Input FRS Request Port
hosts the Dashboards, Live | Output FRS Request Port
Office, and QaaWS web ser-
vices required for certain data | HTTP port (80 by default)
source connections
Web Services provider appli-
. ) Live Office cation (dswsbobje.war) that
Live Office Client hosts the Live Office web HTTP port (80 by default)
service
SAP Busi- CMS Name Server Port (6400 by de-
Information | nessObjects | cms fault)
platform ser- [ Web Intelli- CMS Request Port
vices gence Desk- | Input FRS q
top Input FRS Request Port
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Associated Servers

Server Port Requirements

CMS Name Server Port (6400 by de-
fault)

. CMS

Information Universe de-

platform ser- sign tool Input FRS CMS Request Port

vices Connection Server Input FRS Request Port
Connection Server port
CMS Name Server Port (6400 by de-

Information | Business CMS fault)

platform ser- | View Manag-

vices or Input FRS CMS Request Port
Input FRS Request Port
The following ports must be open to
allow CCM to manage remote Informa-
tion platform services servers:
CMS Name Server Port (6400 by de-
fault)
CMS Request Port
The following ports must be open to
allow CCM to manage remote SIA
processes:

. Central Con- | cMS . ) .

Information figuration Microsoft Directory Services (TCP port

platform ser- Manager Server Intelligence Agent 445)

vices (CCM) (SlA)

NetBIOS Session Service (TCP port
139)

NetBIOS Datagram Service (UDP port
138)

NetBIOS Name Service (UDP port 137)
DNS (TCP/UDP port 53)

(Note that some ports listed above may
not be required. Consult your Windows
administrator).
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Associated Servers

Server Port Requirements

SIA Request Port (6410 by default)

Information Server Inteli- Every Information platform
gence Agent ry on plat CMS Name Server Port (6400 by de-
platform ser- services server including the
. (SIA fault)
vices CMS
) CMS Request Port
CMS Name Server Port (6400 by de-
i fault
’
vices version Tool Input FRS CMS Request Port
Input FRS Request Port
CMS Name Server Port (6400 by de-
CMS fauIt)
SAP Busi- Repository
ness Object- | Diagnostic | Input FRS CMS Request Port
sEnterprise | Tool Output FRS Input FRS Request Port
Output FRS Request Port
All Information platform ser-
vices servers required by the | CMS Name Server Port (6400 by de-
SAP Busi- Information dep|oyed products. faUIt)
ness Ob- platform ser-
jects Infor- | vices SDK | For example, communication CMS Request Port
mation plat- | hostedinthe | With the Crystal Reports 2011 | Request Port for each server that is
form ser- web applica- | Processing Server Request | o jired. For example, the Crystal Re-
vices tion server Port is required if the SDK is

retrieving and interacting with
Crystal reports from the CMS.

ports 2011 Processing Server Request
Port.
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Associated Servers

All Information platform ser-
vices servers required by the
products accessing the web
services.

Server Port Requirements

CMS Name Server Port (6400 by de-
fault)

SAP Busi-
Web Ser-
pe?s IO:" vices For example, communication | €MS Request Port
Jrigt?orr\] ;';t_ provider W'tg I’;he Das_hbogrds Caé:he Request Port for each server that is
form ser- (‘dSWSbOb and Frocessing _erve_r;c Se- required. For example, the Dashboard
vices je.war) qust Ports is required if SAP | pegjgn Cache Server and Dashboard
BusinessObjects Dashboards | pegign Processing Server Request
is accessing Enterprise data | pots.
source connections through
the Web Services provider.
CMS Name Server Port (6400 by de-
CMS fault)
SAP Busi- SAP Busi- ) )
ness Ob- . Adaptive Processing Server [ CMS Request Port
jects Infor- nessOl:‘)Jects hosting the Multi Dimensional _ _
mation plat- An_a_ly5|s, Analysis Service Adaptive Processing Server Request
form ser- edition for Port
. OLAP Input FRS
vices Input FRS Request Port
Output FRS

Output FRS Request Port

6.14.2.2.2 Port Requirements for Third-Party Applications

This table lists third-party software used by SAP Business Objects products. It includes specific examples
from some software vendors, but different vendors will have different port requirements.

Third-party
application

CMS System

Database

jects component
that uses the third-

party product

Central Management
Server (CMS)

port

Third-party application
port requirement

Database server listen

The CMS is the only server
that communicates with the
CMS system database.
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Third-party

SAP Business Oh-
jects component
that uses the third-

party product

Third-party application
port requirement

Description

The CMS is the only server

CMS Auditing | Central Management | Database server listen : .
Database Server (CMS) ort that communicates with the
P CMS auditing database.
Connection Server
. Every Job Server . These servers retrieve informa-

Reporting . Database server listen . :

child process tion from the reporting
Database port

Every Processing
Server

database.

web application
server

All SAP Business Ob-
jects web services
and web applications
including Bl launch

HTTP port and HTTPS
port.

For example, on Tomcat
the default HTTP port is

The HTTPS port is only re-
quired if secure HTTP commu-
nication is used.

pad and CMC 8080 and the default
HTTPS port is 443.
FTP server Every Job Server FTP In (port 21) The Job Servers use the FTP
v FTP Out (port 22) ports to allow send to FTP.
The Job Servers use the
Email server Every Job Server SMTP (port 25) SMTP port to allow send to

email .

Unix servers to
which the Job
Servers can
send content

Every Job Server

rexec out (port 512)

(Unix only) rsh out (port
514)

(Unix only) The Job Servers
use these ports to allow send
to disk .
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SAP Business Ob-
Third-party  jects component  Third-party application . ption
application that uses the third- port requirement
party product
CMS Connection port for third- | User credentials are stored in
L _ | party authentication. the third-party authentication
gﬁﬁ:tphﬂfét;ﬁg Isnef(r)\;_ server. The CMS, Information
Authentication | — .0 e car For example, the connec- | platform services SDK, and
Server Vices SBK tion server for the Oracle | the thick clients listed here
LDAP server is defined by | need to communicate with the
every thick Client, for | the user in the file third-party authentication
example Live Office. | 'dap-ora. server when a user logs on.

6.15 Configuring Bl platform for firewalls

This section gives step-by-step instructions for configuring your Bl platform system to work in a firewalled
environment.

6.15.1 To configure the system for firewalls

1. Determine which Information platform services components must communicate across a firewall.

2. Configure the Request Port for each Information platform services server that must communicate
across a firewall.

3. Configure a port range for any Job Server children that must communicate across a firewall by
addingthe -requestJsChildPorts<lowestport><highestport>and -requestPort<port>
parameters to the server's command line.

4. Configure the firewall to allow communication to the Request Ports and job server port range on the
Information platform services servers that you configured in the previous step.

5. (Optional) Configure the hosts file on each machine that hosts a Information platform services server
that must communicate across a firewall.

Related Topics

« Communication between Information platform services components
» Configuring port numbers

* Command lines overview
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« Specifying the firewall rules
« Configure the hosts file for firewalls that use NAT

6.15.1.1 Specifying the firewall rules

You must configure the firewall to allow the necessary traffic between SAP BusinessObjects components.
Consult your firewall documentation for details of how to specify these rules.

Specify one inbound access rule for each communication path that crosses the firewall. You might not
need to specify an access rule for every SAP BusinessObjects server behind the firewall.

Use the port number you specify in the server Port text box. Remember that each server on a machine
must use a unique port number. Some Business Objects servers use more than one port.

Note:

If Information platform services is deployed across firewalls that use NAT, every server on all machines
needs a unique Request Port number. That is, no two servers in the entire deployment can share the
same Request Port.

Note:

You do not need to specify any outbound access rules. Information platform services servers do not
initiate communication to the web application server, or to any client applications. Information platform
services servers can initiate communication to other Information platform services servers in the same
cluster. Deployments with clustered servers in an outbound-firewalled environment are not supported.

Example:

This example shows the inbound access rules for a firewall between the web application server and
the Information platform services servers. In this case you would open two ports for the CMS, one
port for the Input File Repository Server (FRS), and one port for the Output FRS. The Request Port
numbers are the port numbers you specify in the Port text box in the CMC configuration page for a
server.

Source Computer Port Destination

Computer

web application

Any CMS 6400 Allow
server

web application
server

<Request Port

Any CMS number>

Allow
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Destination

Source Computer [ ———

web application Any Input FRS <Request Port Allow

server number>

web application Any Output FRS <Request Port Allow

server number>

Any Any CMS Any Reject
Other Information

Any Any platform services | Any Reject
servers

Related Topics
» Configure the hosts file for firewalls that use NAT

6.15.1.2 Configure the hosts file for firewalls that use NAT

This step is required only if the Information platform services servers must communicate across a
firewall on which Network Address Translation (NAT) is enabled. This step allows the client machines
to map a server's hostname to a routable IP address.

Note:

Information platform services can be deployed on machines that use Domain Name System (DNS). In
this case, the server machine host names can be mapped to externally routable IP address on the DNS
server, instead of in each machine's hosts file.

Understanding Network Address Translation

A firewall is deployed to protect an internal network from unauthorized access. Firewalls that use “NAT”
will map the IP addresses from the internal network to a different address that is used by the external
network. This “address translation” improves security by hiding the internal IP addresses from the
external network.

Information platform services components such as servers, thick clients, and the web application server
hosting the Information platform services SDK will use a service reference to contact a server. The
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service reference contains the hostname of the server's machine. This hostname must be routable from
the Information platform services component's machine. This means the host s file on the component's
machine must map the server machine's hostname to the server machine's external IP address. The
server machine's external IP address is routable from external side of the firewall, whereas the internal
IP address is not.

The procedure for configuring the hosts file is different for Windows and UNIX.

6.15.1.2.1 To configure the hosts file on Windows

1. Locate every machine that runs a Information platform services component that must communicate
across a firewall on which “Network Address Translation ” (“NAT”) is enabled.

2. On each machine located in the previous step, open the hosts file using a text editor like Notepad.
The hosts file is located at \WINNT\system32\drivers\etc\hosts.

3. Follow the instructions in the hosts file to add an entry for each machine behind the firewall that is
running a Information platform services server or servers. Map the server machine's hostname or
fully qualified domain name to its external IP address.

4. Save the hosts file.

6.15.1.2.2 To configure the hosts file on Unix

Note:
Your UNIX operating system must be configured to first consult the “hosts” file to resolve domain names
before consulting DNS. Consult your UNIX systems documentation for details.

1. Locate every machine that runs an Information platform services component that must communicate
across a firewall on which “Network Address Translation ” (“NAT”) is enabled.
2. Open the “hosts” file using an editor like vi. The hosts file is located in the following directory \etc

3. Follow the instructions in the hosts file to add an entry for each machine behind the firewall that is
running an Information platform services server or servers. Map the server machine's hostname or
fully qualified domain name to its external IP address.

4. Save the hosts file.

6.15.2 Debugging a firewalled deployment

If one or more of your Information platform services servers do not work when your firewall is enabled,
even though the expected ports have been opened on the firewall, you can use the event logs to
determine which of the servers is attempting to listen on which ports or IP Addresses. You can then
either open those ports on your firewall, or use the Central Management Console (CMC) to change the
port numbers or IP addresses that these servers attempt to listen on.

Whenever an Information platform services server starts, the server writes the following information to
the Event Log for each request port that it attempts to bind to.

+ "Server" - The name of the server and whether it successfully started.
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+ "Published Address(es)" - A list of IP Address and port combinations which are posted to the name
service that other servers will use to communicate with this server.

If the server successfully binds to a port, the log file also displays "Listening on port(s)", the IP Address
and port that the server is listening on. If the server is unsuccessful in binding to the port, the log file
displays "Failed to listed on port(s)", the IP Address and port that the server attempts to listen on and
fails.

When a Central Management Server starts, it also writes Published Address(es), Listening on port(s),
and Failed To Listen On information for the server's Name Service Port.

Note:

If the server is configured to use a port that is auto-assigned and to use a host name or IP Address that
is invalid, the event log indicates that the server failed to listen on the host name or IP Address and
port “0”. If a specified host name or IP Address is invalid, the server will fail before the host operating
system is able to assign a port.

Example:

The following example shows the an entry for a Central Management Server that is successfully
listening on two Request Ports and a Name Service Port.

Server mynode.cmsl successfully started.
Request Port :

Published Address(es): mymachine.corp.com:11032, mymachine.corp.com:8765

Listening on port(s): [2001:0db8:85a3:0000:0000:8a2e:0370:7334]:11032, 10.90.172.216:8765
Name Service Port :

Published Address (es): mymachine.corp.com: 6400

Listening on port(s): [2001:0db8:85a3:0000:0000:8a2e:0370:7334]:6400, 10.90.172.216:6400

6.15.2.1 To debug a firewalled deployment

1. Read the event log to determine if the server is successfully binding to the port that you have specified.

If the server was unable to successfully bind to a port, there is probably a port conflict between the
server and another process that is running on the same machine. The "Failed to List On" entry
indicates the port that the server is attempting to listen on. Run a utility such as netstat to determine
which process that has taken the port, and then configure either the other process or the server to
listen on another port.

2. If the server was able to successfully bind to a port, "Listening On" indicates which port the server
is listening on. If a server is listening on a port and is still not working properly, either ensure that
that port is open on the firewall or configure the server so that it listens on a port that is open.

Note:

If all of the Central Management Servers in your deployment are attempting to listen to ports or IP
Addresses that are not available, then the CMSs will not start and you will not be able to log on to the
CMC. If you want to change the port number or IP Address that the CMS attempts to listen, you must
use the Central Configuration Manager (CCM) to specify a valid port number or IP Address.
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Related Topics
» Configuring port numbers

6.16 Examples of typical firewall scenarios

This section provides examples of typical firewall deployment scenarios.

6.16.1 Example - Application tier deployed on a separate network

This example shows how to configure a firewall and Information platform services to work together in
a deployment where the firewall separates the web application server from other Information platform
services servers.

In this example, Information platform services components are deployed across these machines:

+ Machine boe 1 hosts the web application server and the Information platform services SDK.

+ Machine boe 2 hosts the Intelligence tier servers, including the Central Management Server, the
Input File Repository Server, the Output File Repository Server, and the Event server.
+ Machine boe 3 hosts the Processing tier servers, including the Adaptive Job Server, the Web

Intelligence Processing Server, the Report Application Server, the Crystal Reports Cache Server ,
and Crystal Reports Processing Server.

Figure 6-1: Application tier deployed on a separate network
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6.16.1.1 To configure an application tier deployed on a separate network

The following steps explain how to configure this example.
1. These communication requirements apply to this example:
»  The web application server that hosts the Information platform services SDK must be able to
communicate with the CMS on both of its ports.

+  The web application server that hosts the Information platform services SDK must be able to
communicate with every Information platform services server.

«  The browser must have access to the http or the https Request Port on the Web Application
Server.

2. The web application server must communicate with all Information platform services servers on
machine boe 2 and boe_3. Configure the port numbers for each server on these machines. Note
that you can use any free port between 1,025 and 65,535.

The port numbers chosen for this example are listed in the table:

Server Port Numbher

Central Management Server 6400
Central Management Server 6411
Input File Repository Server 6415
Output File Repository Server 6420
Event server 6425
Adaptive Job Server 6435
Crystal Reports Cache server 6440
Web Intelligence Processing Server 6460
Report Application Server 6465
Crystal Reports Processing Server 6470

3. Configure the firewalls Firewall 1 to allow communication to the fixed ports on the Information
platform services servers and the web application server that you configured in the previous step.

In this example we are opening the HTTP Port for the Tomcat Application server.
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Table 6-6: Configuration for Firewall_1

Destination Computer Port Action

Any boe_1 8080 Allow

Configuration for firewall_2

Port :::irnation Com-
boe_1 Any boe_2 6400 Allow
boe_1 Any boe_2 6411 Allow
boe_1 Any boe_2 6415 Allow
boe_1 Any boe_2 6420 Allow
boe_1 Any boe_2 6425 Allow
boe_1 Any boe_3 6435 Allow
boe_1 Any boe_3 6440 Allow
boe_1 Any boe_3 6460 Allow
boe_1 Any boe_3 6465 Allow
boe_1 Any boe_3 6470 Allow

4. This firewall is not NAT-enabled, and so we do not have to configure the hosts file.

Related Topics
» Configuring port numbers
» Understanding communication between Information platform services components

6.16.2 Example - Thick client and database tier separated from Information platform
services servers hy a firewall

This example shows how to configure a firewall and Information platform services to work together in
a deployment scenario where:

« One firewall separates a thick client from Information platform services servers.
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One firewall separates Information platform services servers from the database tier.

In this example, Information platform services components are deployed across these machines:

Machine boe 1 hosts the Publishing Wizard. Publishing Wizard is a Information platform services
thick client.

Machine boe 2 hosts the Intelligence tier servers, including the Central Management Server (CMS),
the Input File Repository Server, the Output File Repository Server, and the Event server.
Machine boe 3 hosts the Processing tier servers, including: Adaptive Job Server, Web Intelligence
Processing Server, Report Application Server, the Crystal Reports Processing Server, and Crystal
Reports Cache Server.

Machine Databases hosts the CMS system and auditing databases and the reporting database.
Note that you can deploy both databases on the same database server, or you can deploy each
database on its own database server. In this example, all the CMS databases and the reporting
database are deployed on the same database server. The database server listen port is 3306, which
is the default listen port for MySQL server.

Figure 6-2: Rich client and database tier deployed on separate networks
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6.16.2.1 To configure tiers separated from Information platform services servers
by a firewall

The following steps explain how to configure this example.

1.

Apply the following communication requirements to this example:

» The Publishing Wizard must be able to initiate communication with the CMS on both of its ports.

» The Publishing Wizard must be able to initiate communication with the Input File Repository
Server and the Output File Repository Server.

+  The Connection Server, every Job Server child process, and every Processing Server must have
access to the listen port on the reporting database server.

+ The CMS must have access to the database listen port on the CMS database server.
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2. Configure a specific port for the CMS, the Input FRS, and the Output FRS. Note that you can use
any free port between 1,025 and 65,535.

The port numbers chosen for this example are listed in the table:

Server Port Number

Central Management Server 6411
Input File Repository Server 6415
Output File Repository Server 6416

3. We do not need to configure a port range for the Job Server children because the firewall between
the job servers and the database servers will be configured to allow any port to initiate communication.

4. Configure Firewall 1 to allow communication to the fixed ports on the Information platform

services servers that you configured in the previous step. Note that port 6400 is the default port
number for the CMS Name Server Port and did not need to be explicitly configured in the previous

step.
Port Destination Computer Port Action
Any boe_2 6400 Allow
Any boe_2 6411 Allow
Any boe_2 6415 Allow
Any boe_2 6416 Allow

Configure Firewall 2 to allow communication to the database server listen port. The CMS (on
boe_2) must have access to the CMS system and auditing database and the Job Servers (on boe_3)
must have access to the system and auditing databases. Note that we did not have configure a port
range for job server child processes because their communication with the CMS did not cross a

firewall.
Source Computer Port e
puter
boe_2 Any Databases 3306 Allow
boe_3 Any Databases 3306 Allow

5. This firewall is not NAT-enabled, and so we do not have to configure the hosts file.

Related Topics
» Understanding communication between Information platform services components
« Configuring Bl platform for firewalls
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6.17 Firewall settings for integrated ERP environments

This section details specific considerations and port settings for Information platform services systems
that integrate with the following ERP environments.

- SAP
+ Oracle EBS
« Siebel

» JD Edwards
+  PeopleSoft

Information platform services components include browser clients, rich clients, servers, and the
Information platform services SDK hosted in the Web Application server. System components can be
installed on multiple machines. It is useful to understand the basics of communication between Information
platform services and the ERP components before configuring you system to work with firewalls

Port requirements for Information platform services servers
The following ports are required for their corresponding servers in Information platform services:

+ Central Management Server Name Server port

+ Central Management Server Request port

* Input FRS Request port

+  Output FRS Request port

+  Report Application Server Request port

+ Crystal Reports Cache Server Request port

+ Crystal Reports Page Server Request port

» Crystal Reports Processing Server Request Port

6.17.1 Specific firewall guidelines for SAP integration

Your Information platform services deployment must conform to the following communication rules:

+ The CMS must be able to initiate communication with SAP system on SAP System Gateway port.

+  The Adaptive Job Server and Crystal Reports Processing Server (along with Data Access
components) must be able to initiate communication with SAP system on the SAP System Gateway
port.
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+ The BW Publisher component must be able to initiate communication with the SAP system on the
SAP System Gateway port.

+ Information platform services components deployed on the SAP Enterprise Portal side (for example,
iViews and KMC) must be able to initiate communication with Information platform services web
applications on HTTP/HTTPS ports.

+  The web application server must be able to initiate communication on the SAP System Gateway
service.

» Crystal Reports must be able to initiate communication with the SAP host on the SAP System
Gateway port and SAP System Dispatcher port.

The port that the SAP Gateway service is listening on is the same as that specified in the installation.

Note:

If a component requires an SAP router to connect to an SAP system, you can configure the component
using the SAP router string. For example, when configuring an SAP entitiement system to import roles
and users, the SAP router string can be substituted for the application server’'s name. This insures that
the CMS will communicate with the SAP system through the SAP router.

6.17.1.1 Detailed port requirements

Port requirements for SAP

Information platform services uses the SAP Java Connector (SAP JCO) to communicate with SAP
NetWeaver (ABAP). You need to configure and ensure the availability of the following ports:

+  SAP Gateway service listening port (for example, 3300).
+  SAP Dispatcher service listening port (for example, 3200).

The following table summarizes the specific port configurations that you need.
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Source comput-
er Port Destination computer Port Action
SAP Any Information platform ser- |Web Service HTTP/HTTPS port | Allow
vices Web Application
Server
SAP Any CMS CMS Name Server port Allow
SAP Any CMS CMS Requested port Allow
Web Application [ Any SAP SAP System Gateway Service | Allow
Server port
Central Manage- | Any SAP SAP System Gateway Service | Allow
ment Server port
(CMS)
Crystal Reports | Any SAP SAP System Gateway Service | Allow

port and SAP System Dispatch-
er port

6.17.2 Firewall configuration for JD Edwards EnterpriseOne integration

Deployments of Information platform services that will communicate with JD Edwards software must
conform to these general communication rules:
+ Central Management Console Web Applications must be able to initiate communication with JD
Edwards EnterpriseOne through the JDENET port and a randomly selected port.
+ Crystal Reports with Data Connectivity client side component must be able to initiate communication
with JD Edwards EnterpriseOne through the JDNET port. For retrieving data, JD Edwards
EnterpriseOne side must be able to communicate with the driver through a random port that cannot

be controlled.

Central Management Server must be able to initiate communications with JD Edwards EnterpriseOne
through the JDENET port and a randomly selected port.
»  The JDENET port number can be found in the JD Edwards EnterpriseOne Application Server
configuration file (JDE . INT) under the JDENET section.

6.17.2.1 Port Requirements for Information platform services servers
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Application Server Port Requirements
Information Inf i lat
platform ser- | ,ormation pial- 1. nformation platform services Sign-on Server port
vices XI form services X

6.17.2.2 Port Requirements for JD Edwards EnterpriseOne

Port Requirement Description

Used for communication be-
JDENET port and a randomly tween Information platform ser-
selected port vices and JD Edwards Enter-

priseOne application server.

JD Edwards EnterpriseOne

6.17.2.3 Configuring Information platform services Web Application server to
communicate with JD Edwards

This section shows how to configure a firewall and Information platform services to work together in a
deployment scenario where the firewall separates the Web Application server from other Information
platform services servers.

For firewall configuration with Information platform services servers and clients, see the Information
platform services port requirements section of this guide . In addition to the standard firewall configuration,
communication with JD Edwards servers requires some extra ports to be opened.

Table 6-14: For JD Edwards EnterpriseOne Enterprise

Source Computer Destination Computer Port

CMS with Security Connectivi-

ty feature for JD Edwards En- | Any JD. Edwards Enter- Any Allow
. priseOne

terpriseOne

Information platform services JD Edwards Enter-

servers with Data Connectivity | Any fiseOne Any Allow

for JD Edwards EnterpriseOne P
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Source Computer Port Destination Computer Port Action

Crystal Reports with client side

Data Connectivity for JD Ed- | Any | oD Edwards Enter- | Allow
. priseOne

wards EnterpriseOne

Information platform services An JD Edwards Enter- An Allow

Web Application Server y priseOne y

6.17.3 Specific firewall guidelines for Oracle EBS

Your deployment of Information platform services must allow the following components to initiate
communication with the Oracle database listener port.

+ Information platform services web components

»  CMS (specifically the Oracle EBS security plugin)
+ Information platform services Xl backend servers (specifically the EBS Data Access component)

» Crystal Reports (specifically the EBS Data Access component)

Note:

The default value of the Oracle database listener port in all the above is 1521.

6.17.3.1 Detailed port requirements

In addition to the standard firewall configuration for Information platform services, some extra ports
need to be opened to work in an integrated Oracle EBS environment:

Source Computer Port Destination Computer Port Action
Web application server Any Oracle EBS :))c:?tde database Allow
CMS with security connectivity Oracle database

for Oracle EBS Any Oracle EBS port Allow
Information platform services Oracle database

servers with server-side data | Any Oracle EBS ort Allow
connectivity for Oracle EBS P
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Source Computer Port Destination Computer Port

Crystal Reports with client-side Oracle database
data connectivity for Oracle Any Oracle EBS Allow
EBS port

6.17.4 Firewall configuration for PeopleSoft Enterprise integration

Deployments of BusinessObjects Xl Integration for PeopleSoft must conform to the following general

communication rules:

+  The Central Management Server (CMS) with the Security Connectivity component must be able to
initiate communication with the PeopleSoft Query Access (QAS) web service.

« Information platform services servers with a Data Connectivity component must be able to initiate
communication with the PeopleSoft QAS web service.

« The Crystal Reports with Data Connectivity client components must be able to initiate communication
with the PeopleSoft QAS web service.

*  The Enterprise Management (EPM) Bridge must be able to communicate with the CMS and the
Input File Repository Server.

« the EPM Bridge must be able to communicate with the PeopleSoft database using an ODBC
connection.

The web service port number is the same as the port specified in PeopleSoft Enterprise Domain name.

6.17.4.1 Port Requirements for Information platform services XI servers

Application Server Port Requirements
Information _
latform ser- Information plat- . | |
y form services XI | * Information platform services Sign-on Server port
vices XI Enter- !
i Enterprise
prise

6.17.4.2 Port Requirements for PeopleSoft
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Port Requirement Description

This port is required when using
SOAP connection for PeopleSoft
Enterprise for People Tools 8.46
and newer solutions

PeopleSoft Enterprise: People

Tools 8.46 or newer Web Service HTTP/HTTPS port

6.17.4.3 Configuring BusinessOhjects Xl Integration for PeopleSoft for firewalls

This section shows how to configure a firewall and Information platform services with Information platform
services X| Enterprise to work together in a deployment scenario where the firewall separates the Web
Application server from other Information platform services servers.

For firewall configuration with Information platform services servers and clients, refer to the Information
platform services XI Administrator's Guide.

Besides the firewall configuration with Information platform services, Information platform services XI
Enterprise needs to do some extra configurations.

Table 6-18: For PeopleSoft Enterprise: PeopleTools 8.46 or newer

Source Computer Port Destination Computer Port Action
. . o PeopleSoft web

?“;I;m:z fSoerCFL)J;I(t)y Fe%rl)r:ctectlw- Any PeopleSoft service HTTP Allow

y P /HTTPS port

Information platform services PeopleSoft web

servers with Data Connectivity | Any PeopleSoft service HTTP Allow

for PeopleSoft HTTPS port

CrystalReports with client side PeopleSoft web

Data Connectivity for People- | Any PeopleSoft service HTTP Allow

Soft HTTPS port

EPM Bridge Any | CMS CMS Name Server | 51

Port
EPM Bridge Any | cMs ;’)\fts requested | 0w
EPM Bridge Any 'S”p“t File Repository || i FRS port | Allow
erver
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Source Computer Port Destination Computer Port

PeopleSoft

Database Port Allow

EPM Bridge Any PeopleSoft

6.17.5 Firewall configuration for Siebel integration

This section shows which ports are used for communication between Information platform services Xl
and Siebel eBusiness Application systems when they are separated by firewalls.

+  The Web Application must be able to initiate communication with the Information platform services
Sign-on Server for Siebel. For enterprise Sign-on Server for Siebel three ports are needed:
1. The Echo (TCP) port 7 for checking access to the Sign-on Server.
2. Information platform services Sign-on Server for Siebel port (by default, 8448) for CORBA IOR
listening port.
3. A random POA port for CORBA communication that cannot be controlled, so all ports need to
open.

The CMS must be able to initiate communication with Information platform services Sign-on Server
for Siebel. CORBA IOR listening port configured for each Sign-on Server (for example, 8448). You
will also need to open a random POA port number that will not be known until you have installed
Information platform services.

+ Information platform services Sign-on Server for Siebel must be able to initiate communication with
SCBroker (Siebel connection broker) port (for example, 2321).

+ Information platform services backend servers (Siebel Data Access component) must be able to
initiate communication with SCBroker (Siebel connection broker) port (for example, 2321).

+ Crystal Reports (Siebel Data Access component) must be able to initiate communication with
SCBroker (Siebel connection broker) port (for example, 2321).

Detailed description of ports

This section lists the ports that are used by Information platform services XI. If you deploy Information
platform services with firewalls, you can use this information to open the minimum number of ports in
those firewalls specific for BusinessObjects Xl Integration for Siebel.

Table 6-19: Port requirement for Information platform services X| servers

Application Server Port Requirements
SAP BusinessObjects | BusinessObjects XI | © Information platform services Sign-on Server
X| Enterprise Siebel integration port
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Table 6-20: Port requirement for Siebel

Port Require-
ment

Description

Siebel eBusiness Appli-

cation 2321 Default SCBroker (Siebel connection broker) port

Configuring SAP Information platform services Xl firewalls for integration with Siebel

This section shows how to configure a firewalls for Siebel and Information platform services Xl to work
together in a deployment scenario where the firewall separates the Web Application server from other
Information platform services Xl servers.

Source Computer Destination Computer
Web Aoplication Server An Information platform services Sign- An Allow

PP y on Server for Siebel y

Information platform services Sign-

CMS Any on Server for Siebel Any Allow
Information platform ser-
vices Sign-on Server for Any Siebel Sg)rtBroker Allow
Siebel P
Information platform ser-
vices servers with server- AN Siebel SCBroker Allow
side Data Connectivity for y port
Siebel
Crystal Reports with client-
side Data Connectivity for | Any Siebel Sg)rtBroker Allow
Siebel P

6.18 Information platform services and reverse proxy servers

Information platform services can be deployed in an environment with one or more reverse proxy
servers. A reverse proxy server is typically deployed in front of the web application servers in order to
hide them behind a single IP address. This configuration routes all Internet traffic that is addressed to
private web application servers through the reverse proxy server, hiding private IP addresses.

Because the reverse proxy server translates the public URLs to internal URLSs, it must be configured
with the URLs of the Information platform services web applications that are deployed on the internal
network.
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6.18.1 Supported reverse proxy servers

Information platform services supports the following reverse proxy servers:
+ IBM Tivoli Access Manager WebSEAL 6

+ Apache 2.2

*  Microsoft ISA 2006

6.18.2 Understanding how web applications are deployed

Information platform services web applications are deployed on a web application server. The applications
are deployed automatically during installation through the WDeploy tool. WDeploy can also be used to
manually deploy the applications after Information platform services is deployed. The web applications
are located in the following directory on a default Windows installation:

C:\Program Files (x86)\SAP BusinessObjects\Information platform services
___MINI-BOE-VERSION \warfiles\webapps

WDeploy is used to deploy two specific WAR files:

+ BOE: includes the Central Management Console (CMC), Bl launch pad, Open Document,
+ dswsbobje: contains the Web Service application

If the web application server is located behind a reverse proxy server, the reverse proxy server should
be configured with the correct context paths of the WAR files. To expose all of the Information platform
services functionality, configure a context path for every Information platform services WAR file that is
deployed.

6.19 Configuring reverse proxy servers for Information platform services weh
applications

The reverse proxy server must be configured to map incoming URL requests to the correct web
application in deployments where Information platform services web applications are deployed behind
a reverse proxy server.

This section contains specific configuration examples for some of the supported reverse proxy servers.
Refer to the vendor documentation for your reverse proxy server for more information.
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6.19.1 Detailed instructions for configuring reverse proxy servers

Configure the WAR files

Information platform services web applications are deployed as WAR files on a web application server.
Ensure you configure a directive on your reverse proxy server for the WAR file that is required for your
deployment. You can use the WDeploy to deploy either the BOE or dswsbobje WAR files. For more
information on WDeploy see the Information platform services Web Application Deployment Guide.

Specify BOE properties in the custom configuration directory

The BOE.war file includes global and application specific properties. If you need to modify any of the

of properties use the custom configuration directory. By default the directory is located at C: \Program
Files (x86)\SAP BusinessObjects\ Information platform services  MINI-BOE-

VERSION \warfiles\webapps\BOE\WEB-INF\config\custom.

Note:
Do not modify the properties in the config\default directory. If you make any changes, the changes
will overwrite files in the default directory. Ensure that users only use the config\custom directory.

Note:

On some web application servers, such as the Tomcat version bundled with Information platform
services, you can access the BOE . war file directly. In this scenario, you can set custom settings without
undeploying the WAR file. When you cannot access the BOE . war file, you must undeploy, customize,
and then redeploy the file.

Consistent use of the / (front slash)

Define context paths on the reverse proxy server exactly the same as paths to a browser URL. For
example, if the directive contains a / (front slash) at the end of the mirror path on the reverse proxy
server, type / at the end of the browser URL.

You must use a / (front slash) consistently in the source and destination URLs in the directive of the
reverse proxy server. That is, if you add a / (front slash) to the end of the source URL, you must also
add it to the end of the destination URL.

6.19.2 To configure the reverse proxy server

The steps below are required for Information platform services web applications to work behind a
supported reverse proxy server.

1. Ensure the reverse proxy server is set up correctly according to the vendor's instructions and the
deployment's network topology.

2. Determine which Information platform services WAR file is required.
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. Configure the reverse proxy server for each Information platform services WAR file. Note that the

rules are specified differently on each type of reverse proxy server.

. Perform any special configuration that is required. Some web applications require special configuration

when deployed on certain web application servers.

6.19.3 To configure Apache 2.2 reverse proxy server for Information platform

services

This section provides a workflow for configuring Information platform services and Apache 2.2 to work
together.

1.
2,

Ensure that Information platform services and Apache 2.2 are installed on separate computers.

Ensure that Apache 2.2 is installed and configured as a reverse proxy server as described in the
vendor documentation.

. Configure the ProxyPass for every WAR file that is deployed behind the reverse proxy server.
. Configure the ProxyPassReverseCookiePath for every web application that is deployed behind

the reverse proxy server.

6.19.4 To configure WehSEAL 6.0 reverse proxy server for Information platform

services

This section explains how to configure Information platform services and WebSEAL 6.0 to work together.

The recommended configuration method is to create a single standard junction that maps all of the
Information platform services web applications hosted on an internal web application server or web
server to a single mount point.

1.

Ensure that Information platform services and WebSEAL 6.0 are installed on separate machines.

It is possible but not recommended to deploy Information platform services and WebSEAL 6.0 on
the same machine. Refer to the WebSEAL 6.0 vendor documentation for instructions on configuring
this deployment scenario.

. Ensure that WebSEAL 6.0 is installed and configured as described in the vendor documentation.
. Launch the WebSEAL pdadmin command line utility. Log in to a secure domain such as sec_master

as a user with administration authorization.

. Enter the following command at the pdadmin sec_master prompt:

server task <instance name-webseald-host name>create -t
<type> -h <host_name> -p <port> <junction point>

Where:
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* <instance name-webseald-host name> specifies the full server name of the installed
WebSEAL instance. Use this full server name in the same format as displayed in the output of
the server 1list command.

*  <type> specifies the type of junction. Use tcp if the junction maps to an internal HTTP port.
Use ss1 if the junction maps to an internal HTTPS port.

* <host name> specifies the DNS host name or IP address of the internal server that will receive
the requests.

+  <port> specifies the TCP port of the internal server that will receive the requests.

* <junction point> specifies the directory in the WebSEAL protected object space where the
document space of the internal server is mounted.

Example:

server task default-webseald-webseal.rp.sap.com
create -t tcp -h 10.50.130.123 -p 8080/hr

6.19.5 To configure Microsoft ISA 2006 for Information platform services

This section explains how to configure Information platform services and ISA 2006 to work together.

The recommended configuration method is to create a single standard junction that maps all of the
Information platform services WAR files hosted on an internal web application server or web server to
a single mount point. Depending on your web application server, there are additional configuration
required on the application server for it to work with ISA 2006.

1. Ensure that Information platform services and ISA 2006 are installed on separate machines.

It is possible but not recommended to deploy Information platform services and ISA 2006 on the
same machine. Refer to the ISA 2006 documentation for instructions on configuring this deployment
scenario.
2. Ensure that ISA 2006 is installed and configured as described in the vendor documentation.
3. Launch the ISA Server Management utility.
4. Use the navigation panel to launch a new publishing rule
a. Goto
Arrays > MachineName > Firewall Policy > New > Web Site Publishing Rule

Remember:
Replace MachineName with the name of the machine on which ISA 2006 is installed.

Type a rule name in Web publishing rule name and click Next

Select Allow as the rule action and click Next.

Select Publish a single Web site or load balancer as the publishing type and click Next.
Select a connection type between the ISA Server and the published Web site and click Next.

®ao00o
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For example, select Use non-secured connections to connect the published Web server or
server farm.

Type the internal name of the Web site you are publishing (for example, the machine name
hosting Information platform services) in Internal site name and click Next.

Note:

If the machine hosting ISA 2006 cannot connect to the target server select Use a computer
name or IP address to connect to the published server and type the name or IP address in
the field provided.

In "Public Name Details" select the domain name (for example Any domain name) and specify
any internal publishing details (for example /*). Click Next.
You now need to create a new web listener to monitor for incoming Web requests.

Click New to launch the New Web Listener Definition Wizard.

Type a name in Web Listener name and click Next.
Select a connection type between the ISA Server and the published Web site and click Next.

For example, select Do not require SSL secured connections with clients.
In "Web Listener IP Addresses" section select the following and click Next.

Internal
External
Local Host
All Networks

ISA Server is now configured to publish only over HTTP.
Select an "Authentication Setting" option, click Next, and then click Finish.
The new listener is now configured for the web publishing rule.

Click Next in "User Sets", then click Finish.

Click Apply to save all the settings for the web publishing rule and update the ISA 2006 configuration.
You now have to update the properties of the web publishing rule to map paths for the web
applications.

In the navigation panel, right-click the Firewall Policy you configured and select Properties.
Select the "Paths" tab and click Add to map routes to SAP BusinessObjects web applications.
Under "Public Name" tab, select Request for the following websites and click Add.

In the "Public Name" dialog box, type your ISA 2006 server name and click OK.

Click Apply to save all the settings for the web publishing rule and update the ISA 2006 configuration.
Verify the connections by accessing the following URL:

http://<ISA Server host Name><web listener port number>/<External path of

the application>

For example: http://mylSAserver:80/Product/BOE/CMC

Note:
You may have to refresh the browser several times.
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You need to modify the HTTP policy for the rule have just configured to ensure that you will be able to
logon on to the CMC. Right-click the rule you created in the ISA Server Management utility and select
Configure HTTP. You must now deselect Verify Normalization in the "URL Protection" area.

To remotely access Information platform services you need to create an access rule.

6.20 Special configuration for Information platform services in reverse proxy
deployments

Some Information platform services products need additional configuration to function correctly in
reverse proxy deployments. This section explains how to perform the additional configuration.

6.20.1 Enabling reverse proxy for Information platform services Web Services

This section describes the required procedures to enable reverse proxies for Information platform
services Web Services.

6.20.1.1 Enabling reverse proxy for Web Services on weh application servers
other than Tomcat

The following procedure requires that Information platform services web applications are successfully
configured against your chosen web application server. Note that the wsresources are case-sensitive.
1. Stop the web application server.

2. Specify the external URL of the Web Services in the dsws.properties file.

This file is located in dswsbobje web application. For example, if your external is URL is
http://my reverse proxy server.domain.com/dswsbobje/,update the following properties
in the dsws.properties file:
° wsresourcel=ReportEngine|reportengine web service alonel|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/ReportEngine
° wsresource2=BICatalog|bicatalog web service alone|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/BICatatog
° wsresource3=Publish|publish web service alone|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/Publish
° wsresource4=QueryService|query web service alone|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/QueryService
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* wsresource5=BIPlatform|BIPlatform web service|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/BIPlatform

* wsresourceb6=LiveOffice|Live Office web servicel|http://my re
verse proxy server.domain.com/SAP/dswsbobje/services/LiveOffice

3. Save and close the dsws.properties file.
4. Restart the web application server.

5. Ensure the reverse proxy server maps its virtual path to the correct web application server connector
port. The following example shows a sample configuration for Apache HTTP Server 2.2 to reverse
proxy Information platform services Web Services deployed on the web application server of your
choice:

ProxyPass /SAP/dswsbobje http://internalServer:<listening port> /dswsbobje
ProxyPassReverseCookiePath /dswsbobje /SAP/dswsbobje

Where <1listening port> is the listening port of your web application server.

6.20.2 Enabling the root path for session cookies for ISA 2006

This section describes how to configure specific web application servers to enable the root path for
session cookies to work with ISA 2006 as the reverse proxy server.

6.20.2.1 To configure Sun Java 8.2

You need to modify the sun-web . xm1 for every Information platform services web application.
1. Go to <SUN_WEBAPP_ DOMAIN>\generated\xml\j2ee-modules\webapps\BOE\WEB-INF

2. Open sun-web.xml

3. After the <context-root> container add the following:

<session-config>
<cookie-properties>
<property name="cookiePath" wvalue="/" />
</cookie-properties>
</session-config>
<property name="reuseSessionID" value="true"/>

B

. Save and close sun-web.xml.

o

. Repeat steps1-4 for every web application.
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6.20.2.2 To configure Oracle Application Server 10gR3

You need to modify the global-web-application.xml Oor orion-web.xml for every Information
platform services web application's deployment directory.

1. Goto <ORACLE HOME>\j2ee\home\config\
2. Open global-web-application.xml Oor orion-web.xml.
3. Add the following line to the <orion-web-app> container:

<session-tracking cookie-path="/" />

4. Save and close the configuration file.
5. Logon to the Oracle Admin Console:

a. Goto OC4J:home > Administration > Server Properties .
b. Select Options under "Command Line Options".
c. Click Add another Row and type the following:

Doracle.useSessionIDFromCookie=true

6. Restart the Oracle server.

6.20.2.3 To configure WehSphere Community Edition 2.0

Open the WebSphere Community Edition 2.0 Admin Console.

In the left navigation panel, find "Server" and select Web Server.
Select the connectors and click Edit.

Select the emptySessionPath check box and click Save.

Type your ISA server name in ProxyName.

Type the ISA listener port number in ProxyPort.

Stop and then restart the connector.

Noakowobdb=

6.20.3 Enabling reverse proxy for SAP BusinessObjects Live Office

To enable SAP BusinessObjects Live Office’s View Object in Web Browser feature for reverse proxies,
adjust the default viewer URL. This can be done in the Central Management Console (CMC) or through
Live Office options.
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Note:
This section assumes reverse proxies for Information platform services Java Bl launch pad and
Information platform services Web Services have been successfully enabled.

6.20.3.1 To adjust the default viewer URL in the CMC

1. In the CMC, on the "Applications" page, click Central Management Console.
2. Click Actions > Processing Settings.
3. In the URL box, type the URL for the default viewer, and click Set URL.

For example, type http://ReverseProxyServer:ReverseProxyServerPort/BOE/Open
Document.jsp?sIDType=CUID&iDocID=%SI CUIDS%, where ReverseProxyServer and Re
verseProxyServerPort are the correct reverse proxy server name and its listen port.
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7.1 Authentication options in Information platform services

Authentication is the process of verifying the identity of a user who attempts to access the system, and
authorization is the process of verifying that the user has been granted sufficient rights to perform the
requested action upon the specified object.

Security plugins expand and customize the ways in which Information platform services authenticates
users. Security plugins facilitate account creation and management by allowing you to map user accounts
and groups from third-party systems into Information platform services. You can map third-party user
accounts or groups to existing Information platform services user accounts or groups, or you can create
new Enterprise user accounts or groups that correspond to each mapped entry in the external system.

The current release supports the following authentication methods:

+  Enterprise

- LDAP

* Windows AD
- SAP

+ Oracle EBS
+ Siebel

+ JD Edwards
* PeopleSoft

Because Information platform services is fully customizable, the authentication and processes may
vary from system to system.

Related Topics

 Configuring SAP authentication

 Enabling JD Edwards EnterpriseOne authentication
» Enabling Oracle EBS authentication

» Enabling PeopleSoft Enterprise authentication
 Enabling Siebel authentication

 Enterprise authentication overview

 Using LDAP authentication

* Using Windows AD authentication
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7.1.1 Primary authentication

Primary authentication occurs when a user first attempts to access the system. One of two things can
happen during primary authentication:

If single sign-on is not configured, the user provides their credentials, such as their user name,
password and authentication type.

These details are entered by the users on the logon screen.

If a method of single sign-on is configured, the credentials for the users are silently propagated.

These details are extracted using other methods such as Kerberos or SiteMinder.

The authentication type may be Enterprise, LDAP, Windows AD, SAP, Oracle EBS, Siebel, JD
Edwards EnterpriseOne, PeopleSoft Enterprise depending upon which type(s) you have enabled
and set up in the Authentication management area of the Central Management Console (CMC).
The user's web browser sends the information by HTTP to your web server, which routes the
information to the CMS or the appropriate Information platform services server.

The web application server passes the user's information through a server-side script. Internally, this
script communicates with the SDK and, ultimately, the appropriate security plug-in to authenticate the
user against the user database.

For instance, if the user is logging on to Bl launch pad and specifies Enterprise authentication, the SDK
ensures that the Information platform services security plug-in performs the authentication. The Central
Management Server (CMS) uses the security plug-in to verify the user name and password against the
system database. Alternatively, if the user specifies an authentication method, the SDK uses the
corresponding security plug-in to authenticate the user.

If the security plug-in reports a successful match of credentials, the CMS grants the user an active
system identity and the following actions are performed:

The CMS creates an enterprise session for the user. While the session is active, this session
consumes one user license on the system.

The CMS generates and encodes a logon token and sends it to the web application server.

The web application server stores the user's information in memory in a session variable. While
active, this session stores information that allows Information platform services to respond to the
user's requests.

Note:
The session variable does not contain the user's password.

The web application server keeps the logon token in a cookie on the client's browser. This is only
used for failover purposes, such as when you have a clustered CMS or when Bl launch pad is
clustered for session affinity.
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Note:
It is possible to disable the logon token, However, if you disable the logon token, you will disable
failover.

7.1.2 Security plug-ins

Security plug-ins expand and customize the ways in which Information platform services authenticates
users. Information platform services currently ships with the system default Information platform
services security plug-in together with the following plugins:

*  Enterprise

- LDAP

* Windows AD
- SAP

+ Oracle EBS

- Siebel

+ JD Edwards
*  PeopleSoft

Security plug-ins facilitate account creation and management by allowing you to map user accounts

and groups from third-party systems into Information platform services. You can map third-party user
accounts or groups to existing Information platform services user accounts or groups, or you can create
new Enterprise user accounts or groups that correspond to each mapped entry in the external system.

The security plug-ins dynamically maintain third-party user and group listings. Once you map an extermal
group into Information platform services, all users who belong to that group can successfully log on to
Information platform services. When you make subsequent changes to the third-party group membership,
you do not need to update or refresh the listing in Information platform services. For instance, if you
map an LDAP group to Information platform services , and then you add a new user to the group, the
security plug-in dynamically creates an alias for that new user when he or she first logs on to Information
platform services with valid LDAP credentials.

Moreover, security plug-ins enable you to assign rights to users and groups in a consistent manner,
because the mapped users and groups are treated as if they were Enterprise accounts. For example,
you might map some user accounts or groups from Windows AD, and some from an LDAP directory
server. Then, when you need to assign rights or create new, custom groups within Information platform
services, you make all of your settings in the CMC.

Each security plug-in acts as an authentication provider that verifies user credentials against the
appropriate user database. When users log on to Information platform services, they choose from the
available authentication types that you have enabled and set up in the Authorization management area
of the CMC.

Note:
The Windows AD security plugin cannot authenticate users if the Information platform services server
components are running on UNIX.
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7.1.3 Single sign-on to Information platform services

Single sign-on to Information platform services means that once users have logged on to the operating
system, they can access Information platform services applications that support SSO without having
to provide their credentials again. When a user logs on, a security context for that user is created. This
context can be propagated tolnformation platform services in order to perform SSO - resulting in the
user being logged on as an Information platform services user that corresponds to the user.

The term “anonymous single sign-on” also refers to single sign-on to Information platform services ,
but it specifically refers to the single sign-on functionality for the Guest user account. When the Guest
user account is enabled, which it is by default, anyone can log on to Information platform services as
Guest and will have access to Information platform services.

7.1.3.1 Single sign-on support

The term single sign-on is used to describe different scenarios. At its most basic level, it refers to a
situation where a user can access two or more applications or systems while providing their log-on
credentials only once, thus making it easier for users to interact with the system.

Single sign-on to Bl launch pad can be provided by Information platform services or by different
authentication tools, depending on your application server type and operating system.

These methods of single sign-on are available if you are using a Java application server on Windows:
* Windows AD with Kerberos
* Windows AD with SiteMinder

These methods of single sign-on are available if you are using IS on Windows:
*  Windows AD with Kerberos

*  Windows AD with NTLM
*  Windows AD with SiteMinder

These methods of single sign-on support are available on Windows or Unix, with any supported web
application server for the platform.

+ LDAP with SiteMinder

»  Trusted Authentication

* Windows AD with Kerberos
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Windows AD with Kerberos is supported if the Java application is on Unix. However, Information platform
services must run on a Windows server.

The following table describes the methods of single sign-on support for Bl launch pad.

Authenti-
cation CMS Serv-
Mode er Options
leljndows \é\glr;dows Windows AD with Kerberos |[Windows AD authentication to Bl launch pad
only. and the CMC is available out of the box.
LDAP Q(r)]r):esdugl-a i Supported LDAP directory LDAP authentication to Bl launch pad and the
form servers, with SiteMinder only. | CMC is available out of the box. SSO to Bl
launch pad and the CMC requires SiteMinder.
Enterprise An:: sdupl- t Trusted Authentication Enterprise authentication to Bl launch pad and
AP the CMC is available out of the box. SSO with
enterprise authentication to Bl launch pad and
the CMC requires Trusted Authentication.

Related Topics
« Single sign-on to Information platform services

= Single sign-on to database

» End-to-end single sign-on

7.1.3.2 Single sign-on to database

Once users are logged on to Information platform services, single sign-on to the database enables
them to perform actions that require database access, in particular, viewing and refreshing reports,
without having to provide their logon credentials again. Single sign-on to the database can be combined
with single sign-on to Information platform services, to provide users with even easier access to the
resources they need.

7.1.3.3 End-to-end single sign-on
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End-to-end single sign-on refers to a configuration where users have both single sign-on access to
Information platform services at the front-end, and single sign-on access to the databases at the
back-end. Thus, users need to provide their logon credentials only once, when they log on to the
operating system, to have access to Information platform services and to be able to perform actions
that require database access, such as viewing reports.

In Information platform services end-to-end single sign-on is supported through Windows AD and
Kerberos.

7.2 Enterprise authentication

7.2.1 Enterprise authentication overview

Enterprise authentication is the default authentication method for Information platform services; it is
automatically enabled when you first install the system - it cannot be disabled. When you add and
manage users and groups, Information platform services maintains the user and group information
within its database.

Tip:

Use the system default Enterprise Authentication if you prefer to create distinct accounts and groups
for use with Information platform services, or if you have not already set up a hierarchy of users and
groups in a third-party directory server.

You do not have to configure or enable Enterprise authentication. You can however modify Enterprise
authentication settings to meet your organization's particular security requirements. You can only modify
Enterprise setting through the Central Management Console (CMC).

7.2.2 Enterprise authentication settings

Settings ‘ Options Description
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Settings

Password Restrictions

‘ Options

Enforce mixed-case pass-
word

Description

This option ensures that passwords contain
at least two of the following character classes:
upper case letters, lower case letters, num-
bers, or punctuation.

Must contain at least N
characters

By enforcing a minimum complexity for
passwords, you decrease a malicious user's
chances of simply guessing a valid user's
password.

User Restrictions

Must change password ev-
ery N day(s)

This option ensures that the passwords do
not become a liability and are regularly re-
freshed.

Cannot reuse the N most
recent passwords(s)

This option ensures that passwords will not
routinely be repeated.

Must wait N minute(s) to
change password

This option ensures that new passwords
cannot be immediately changed once entered
into the system.

Logon Restrictions

Disable account after N
failed attempts to log on

This security option specifies how many at-
tempts a user is allowed to log on to the sys-
tem before their account is disabled.

Reset failed logon count
after N minute(s)

This option specifies a time interval for reset-
ting the logon attempt counter.

Re-enable account after N
minute(s)

This option specifies for how long an account
is suspended after N failed logon attempts.

Synchronize Data
Source Credentials with
Log On

Enable and update user's
data source credentials at
logon time

This option enables data source credentials
after the user has logged on.

Trusted Authentication

Trusted Authentication is
enabled

This option turns on Trusted Authentication.

Related Topics

* Enabling Trusted Authentication

7.2.3 To change Enterprise settings

1. Go to the "Authentication" management area of the CMC.
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2. Double-click Enterprise.
The "Enterprise" dialog box appears.
3. Change the settings.
Tip:
To revert all the settings to the default value click Reset.

4. Click Update to save your modifications.

7.2.3.1 To change general password settings

Note:
Accounts not used for an extended period of time are not automatically de-activated.

1. Go to the "Authentication" management area of the CMC.
2. Double-click Enterprise.
The "Enterprise" dialog box appears.

3. Click the check box for each password option that you want to use, and enter a value if necessary.

Recommended Maximum

Minimum Value Value
Enforce mixed-case pass- N/A N/A
words
Must contain at least N 0 characters 64 characters
Characters
Must change password every
N day(s) 1 day 100 days
Cannot reuse the N most re- 1 password 100 passwords
cent password(s)
Must wait N minute(s) to 0 minutes 100 minutes
change password
Dl_sable account after N 1 failed 100 failed
failed attempts to log on
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Minimum Value Recommended Maximum

Value

Reset failed logon count af-

ter N minute(s) 1 minute 100 minutes

Re-enable account after N

. 0 minutes 100 minutes
minute(s)

4. Click Update.

7.2.4 Enabling Trusted Authentication

Note:
Accounts that are not used for a period of time are not automatically de-activated.

Enterprise Trusted Authentication is used to perform single sign-on by relying on the web application
server to verify the identity of a user. This method of authentication involves establishing trust between
the Central Management Server (CMS) and the web application server hosting the Information platform
services web application. When the trust is established, the system defers the verification of the identity
of a user to the web application server. Trusted Authentication can be used to support authentication
methods such as SAML, x.509 and other methods which do not have dedicated authentication plugins.

Users prefer to log on to the system once, without needing to provide passwords several times during
a session. Trusted Authentication provides a Java single sign-on solution for integrating your Information
platform services authentication solution with third-party authentication solutions. Applications that have
established trust with the Central Management Server (CMC) can use Trusted Authentication to allow
users to log on without providing their passwords.

To enable Trusted Authentication you must configure a shared secret on the server through the Enterprise
authentication settings, while the client is configured through the properties specified for the BOE.war
file.

Note:

« Before you are able to use Trusted Authentication, you must have either created Enterprise users,
or mapped the third-party users that will need to sign on to Information platform services.

« The single sign-on URL for Bl launch pad is http://server:port/BOE/BI.

Related Topics
 To configure the server to use Trusted Authentication
* To configure Trusted Authentication for the web application
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7.2.4.1 To configure the server to use Trusted Authentication

Before you can perform this task, the Enterprise users or mapped third-party users who need to sign
on to Information platform services must be created.

You must configure the server and then the client computer for Trusted Authentication.

Caution:
Information platform services does not audit modifications to Trusted Authentication parameters. You
should manually back up all Trusted Authentication information.

1. On the CMC, go to the Authentication management area.
2. Click the Enterprise option.
The "Enterprise" dialog-box appears.

3. Scroll down until you see “Trusted Authentication”.

a.
b.

Click Trusted Authentication is enabled.
Click New Shared Secret.

The shared secret is used by the client computer and the CMS to establish trust.

The shared secret key is generated and ready for download message appears.
Click Download Shared Secret.

The "File Download" dialog box appears.

. Click Save and then save the TrustedPrincipal.conf file in one of the following directories:

* <INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win32 x86\
° <INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win64 x64\

To specify the number of days that your shared secret will be valid, enter a value in the Shared
Secret Validity Period box.

Specify the maximum amount of time, in milliseconds, that the clock on the client computer and
the clock on the CMS can differ for trusted authentication requests.

Caution:
To avoid increasing your vulnerability to replay attacks, do not set this value to 0.

4. Click Update to commit the shared secret.

After configuring the server for Trusted Authentication, you must configure the client computer where
your app server is located.

7.2.5 Configuring Trusted Authentication for the web application
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To configure Trusted Authentication for the client, you must modify global properties for the BOE . war
file and specific properties for Bl launch pad and OpenDocument applications.

Use one of the following methods to pass the shared secret to the client:

* WEB_SESSION option
* TrustedPrincipal.conf file

Use one of the following methods to pass the user name to the client:
* REMOTE USER

° HTTP HEADER

* COOKIE

° QUERY STRING

* WEB_SESSION

* USER PRINCIPAL

Regardless of how you pass the shared secret, the method you use must be customized in the
Trusted.auth.user.retrieval global properties for the BOE . war file.

7.2.5.1 Using Trusted Authentication for SANL single sign-on

Security Assertion Markup Language (SAML) is an XML-based standard for communicating identity
information. SAML provides a secure connection where identity and trust is communicated thereby
enabling a single sign-on mechanism that eliminates additional logins for trusted users seeking to
access Information platform services.

Enabling SANL authentication

If your application server can work as a SAML service provider, you can use Trusted Authentication to
provide SAML SSO to the system.

To do this, you must first configure the application server for SAML authentication. Please refer to your
application server documentation for further instructions on how to accomplish this, as they will vary by
application server.

Using Trusted Authentication

Once your web application server is configured to work as a SAML service provider, you can use Trusted
Authentication to provide SAML SSO.

Note:
Users must either be imported into Information platform services or have Enterprise accounts.

Dynamic aliasing is used to enable the SSO. When a user first accesses the logon page through SAML,
they will be asked to manually log in using their existing Information platform services account credentials.
Once the user's credentials are verified, the system will alias the user's SAML identity to their Information
platform services account. Subsequent logon attempts for the user will be performed using SSO, as
the system will have the user's identity alias dynamically matched to an existing account.
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Note:

A specific property for the BOE.war - trusted.auth.user.namespace.enabled - must be enabled
for this mechanism to work.

7.2.5.2 Trusted Authentication properties for web applications

The following table lists the Trusted Authentication settings included in the default global .properties
file for BOE.war. To overwrite any settings, create a new file in C: \Program Files
BusinessObjects\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom.

(x86) \SAP
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sso.en
abled=true

sso.en
abled=false

Enables and disables single sign-on (SSO) to Information plat-
form services. To enable Trusted authentication, this property
must be set to true.

er.namespace.en
abled

trust None Session variable name used to retrieve the secret for Trusted
ed.auth.shared.se Authentication. Only applies if using the web session to pass
cret the shared secret.
trusted.auth.us |None Specifies the variable used to retrieve the user name for Trusted
er.param Authentication.
trusted.auth.us |None Specifies the method used to retrieve the user name for Trusted
er.retrieval Authentication. Can be set to one of the following:

* "REMOTE USER"

* "HTTP HEADER"

* "COOKIE"

* "QUERY STRING"

* "WEB SESSION"

* "USER PRINCIPAL"

If the property is blank, Trusted Authentication is disabled.
trusted.auth.us |None Enables and disables dynamic binding of aliases to existing

user accounts. If the property is set to t rue, Trusted Authenti-
cation uses alias binding to authenticate users to Information
platform services. With alias binding, your application server
can work as a SAML service provider, enabling Trusted Authen-
tication to provide SAML single sign-on to the system. If the
property is blank, Trusted Authentication will use name matching
when authenticating users.

7.2.5.3 To configure Trusted Authentication for the weh application

If you plan to store the shared secretin the TrustedPrincipal . conf file, make sure the file is located
in the appropriate platform directory:
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Platform Location of TrustedPrincipal.conf

° <INSTALLDIR>\SAP BusinessObjects
Enterprise XI 4.0\win32 x86\

° <INSTALLDIR>\SAP BusinessObjects
Enterprise XI 4.0\win64 x64\

Windows, default installation

<IN
AlX STALLDIR>/sap_bobj/enterprise xi40/
aix rs6000/

<IN
Solaris STALLDIR>/sap_bobj/enterprise xi40/
solaris_sparc/

<IN
HP_UX STALLDIR>/sap bobj/enterprise xi40/
hpux pa-risc/

<INSTALLDIR>/sap bobj/enter

Linux prise xi40/linux x86

Various mechanisms populate the user name variable that is used to configure Trusted Authentication
for the client hosting web applications. Configure or set up your web application server so that your
user names are exposed before you use the user retrieval name methods. See http://ja
va.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServietRequest.html for further information.

To configure Trusted Authentication for the client, you must access and modify properties for the
BOE . war file, which includes general and specific properties for Bl launch pad and OpenDocument
web applications.

Note:
Additional steps may be required, depending on how you plan to retrieve the user name or shared
secret.

1. Access the custom folder for the BOE . war file on the machine hosting the web applications.

If you are using the Tomcat web application server provided with the Information platform services
installation, you can access the following folder:

C:\Program Files (x86)\SAP BusinessObjects\Tomcat6\webapps\BOE\WEB-
INF\config\custom\

Tip:

If you are using a web application server that does not enable direct access to the deployed web
applications, use the following folder in your product installation to modify the BOE . war file:

<INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\

Later, you must redeploy the modified BOE . war file.
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2. Create a new file, using Notepad or another text editing utility.
3. Enter the following trusted authentication properties:

sso.enabled=true

trusted.auth.user.retrieval=Method for user ID retrieval
trusted.auth.user.param=Variable
trusted.auth.shared.secret=WEB SESSION

Forthe trusted.auth.shared. secret property, select one of the following options for user
name retrieval:

How the user name will bhe retrieved

The user name is retrieved from the contents
of an HTTP header. You specify which HTTP
header to use in the trusted.auth.us

er .param property.

HTTP_ HEADER

The user name is retrieved from a parameter of
the request URL. You specify which query string
touse inthe trusted.auth.user.param
property.

QUERY_ STRING

The user name is retrieved from a specified
COOKIE cookie. You specify which cookie to use in the
trusted.auth.user.param property.

The user name is retrieved from the contents
of a specified session variable. You specify the
WEB SESSION web session variable to use in the trust
ed.auth.user.param property in glob
al.properties.

The user name is retrieved from a call to ge
tUserPrincipal () .getName () on the
HttpServletRequest object for the current
request in a servlet or JSP.

USER_ PRINCIPAL

The user name is retrieved from a call to

REMOTE USER
- HttpServletRequest.getRemoteUser ().
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Note:

< Some web application servers require the environment variable REMOTE USER set to true on
the server. To find out whether this is required, see your web application server documentation.
If it is required, confirm that the environment variable is set to true.

+ If you are using USER_PRINCIPAL or REMOTE USER to pass the user name, leave the trust
ed.auth.user.param blank.

4. Save the file with the name global .properties.

5. Restart your web application server.

The new properties take effect only after the modified BOE web application is redeployed on the machine
running the web application server. Use WDeploy to redeploy the WAR file on the web application

server. For more information on using WDeploy, see the Information platform services Web Application
Deployment Guide.

7.2.5.3.1 Sample configurations

To pass the shared secret through the TrustedPrincipal.conf file

The following sample configuration assumes that a user JohnDoe has been created in Information
platform services.

The user information will be stored and passed through the web session, while the shared secret will
be passed via the TrustedPrincipal.conf file. This file is assumed to be in the following directory:
C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise
XI 4.0\win32_x86 . The bundled version of Tomcat 6 is the web application server.

1. Inthe <INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\ directory, use Notepad or another
text editing utility to create a new file.

2. In the new file, enter the following Trusted Authentication properties:

sso.enabled=truetrue
trusted.auth.user.retrieval=WEB_SESSION
trusted.auth.user.param=MyUser
trusted.auth.shared.secret=

3. Save the file with the name global.properties.

4. LocatetheC:\Program Files (x86)\SAP BusinessObjects\Tomcat6\webapps\BOE\WEB-
INF\eclipse\plugins\webpath.InfoView\web\custom. jsp file.

5. Inthe custom. jsp file, enter the following properties:

<\ !DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
"http://www.w3.0rg/TR/html4/loose.dtd">

<%Q@ page language="java" contentType="text/html;charset=utf-8" %>

<%

//custom Java code

request.getSession () .setAttribute ("MyUser", "JohnDoe") ;

%>

<html>

<head>

<title>Custom Entry Point</title>

</head>

<body>

<script type="text/javascript" src="noCacheCustomResources/myScript.js"></script>
<a href="javascript:goToLogonPage () ">Click this to go to the logon page of BI launch pad</a>
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</body>
</html>

6. Create amyScript.jsfileinthe C:\Program Files (x86)\SAP BusinessObjects\Tom
cato6\webapps\BOE\WEB-INF\eclipse\plugins\webpath.InfoView\web\noCacheCus
tomResources directory.

7. Inthe myScript. s file, enter the following properties:

function goToLogonPage () {
window.location = "logon.jsp";

}

8. Stop the Tomcat server.

9. Delete the work folderinthe C:\Program Files (x86)\ SAP BusinessObjects\Tomcat6
directory.

10. Restart Tomcat.

To verify that you have properly configured Trusted Authentication, goto http:// [cm

sname] :8080/BOE/BI/custom. jsp to access Bl launch pad, where [cmsname] is the name of
the computer hosting the CMS. The following link should appear: Click this to go to the logon page
of Bl launch pad

To pass the shared secret through the web session variable

The following sample configuration assumes that a user JohnDoe has been created in Information
platform services.

User information is stored and passed via the web session, and the shared secret is passed via the
web session variable, which is located by default in the C:\Program Files (x86)\SAP
BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\win32 x86 directory. You
need to open and note the content of the file. In this sample configuration, the shared secret is:

9ecb0778edcff048edael0fcddela5db8211293486774al27ec949clbdb98dae8e0eal388979%edc65773
841c8ae5d1£f675a6bf5d7¢c66038b6a3£f1345285b55a0a7

The bundled version of Tomcat 6 is the web application server.

1. Inthe <INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\ directory, use Notepad or another
text editing utility to create a new file.

2. In the new file, enter the following Trusted Authentication properties:

sso.enabled=truetrue
trusted.auth.user.retrieval=WEB_SESSION
trusted.auth.user.param=MyUser
trusted.auth.shared.secret=MySecret

3. Save the file with the name global.properties.
4. LocatetheC:\Program Files (x86)\SAP BusinessObjects\Tomcat6\webapps\BOE\WEB-
INF\eclipse\plugins\webpath.InfoView\web\custom. jsp file.

5. Inthe custom. jsp file, enter the following properties:

<\!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
"http://www.w3.0org/TR/html4/loose.dtd">

<%@ page language="java" contentType="text/html;charset=utf-8" %>
<%
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//custom Java code

request.getSession () .setAttribute ("MySecret", "9ecb0778edcff048edae0fcddela5db82112934
86774a127ec949clbdb98dae8e0ea388979edc65773841c8ae5d1£675a6bf5d7¢c66038b6a3£1345
285b55a0a7"

request.getSession () .setAttribute ("MyUser", "JohnDoe");

%>

<html>

<head>

<title>Custom Entry Point</title>

</head>

<body>

<script type="text/javascript" src="noCacheCustomResources/myScript.js"></script>

<a href="javascript:goToLogonPage () ">Click this to go to the logon page of BI launch pad</a>
</body>

</html>

6. Create amyScript.jsfileinthe C:\Program Files (x86)\SAP BusinessObjects\Tom

cato6\webapps\BOE\WEB-INF\eclipse\plugins\webpath.InfoView\web\noCacheCus
tomResources directory.

7. Inthe myScript. s file, enter the following properties:

function goToLogonPage () {

—n

window.location = "logon.jsp";

}

8. Stop the Tomcat server.

9. Deletetheworkfolderinthe C:\Program Files (x86)\ SAP BusinessObjects\Tomcat6
directory.

10. Restart Tomcat.

To verify that you have properly configured Trusted authentication, use the following URL to access
the Bl launch pad application:http:// [cmsname] : 8080/BOE/BI/custom. jsp, Wwhere [cmsname]
is the name of the computer hosting the CMS. The following link should appear: Click this to go to
the logon page of Bl launch pad

To pass the user name through user principal

The following sample configuration assumes that a user called JohnDoe has been created in Information
platform services.

User information is stored and passed through the User Principal option, and the shared secret is
passedviathe TrustedPrincipal. conf file, which is located by defaultinthe C: \Program Files
(x86) \SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\win32 x86
directory. The bundled version of Tomcat 6 is the web application server.

Note:
The web application server configuration is the same for the USER_PRINCIPAL method and the RE
MOTE_ USER method.

1. Stop the Tomcat server.

2. Open the server.xml file for Tomcat in the default C: \Program Files (x86)\SAP
BusinessObjects\Tomcat6\conf\ directory.

3. Locatethe <Realm className="org.apache.catalina.realm.UserDatabaseRealm".../>
tag, and change it to the following value:

<Realm className="org.apache.catalina.realm.MemoryRealm".../>
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10.

. Open the tomcat-users.xml file in the default C: \Program Files (x86)\SAP

BusinessObjects\Tomcat6\conf\ directory.

. Locate the <tomcat-users> tag, and enter the following values:

<user name="“JohnDoe” password=“password”
roles=“onjavauser”/>

. Open the web.xml file in the C:\Program Files (x86)\SAP

BusinessObjects\Tomcat6\webapps\BOE\WEB-INF\ directory.

. Before the </web-app> tag, insert the following tags:

<security-constraint>
<web-resource-collection>
<web-resource-name>OnJavaApplication</web-resource-name>
<url-pattern>/*</url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>onjavauser</role-name>
</auth-constraint>
</security-constraint>

<login-config>
<auth-method>BASIC</auth-method>
<realm-name>OnJava Application</realm-name>
</login-config>

Note:

You must add a page for the <url-pattern></url-pattern> tag. Typically this page is not the
default URL for Bl launch pad or any other web application.

. Open the custom global.properties file, and enter the following values:

° trusted.auth.user.retrieval=USER PRINCIPAL

+ (Optional) trusted.auth.user.namespace.enabled=true to map an external user name
to a different BOE user name

. Delete the work folder inthe C:\Program Files (x86)\SAP BusinessObjects\Tomcaté6

directory.
Restart Tomcat.

To verify that you have properly configured Trusted authentication, go to http:// [cm
sname] :8080/BOE/BI to access Bl launch pad, where [cmsname] is the name of the computer
hosting the CMS. After a few moments a logon dialog box appears.

7.3 LDAP authentication

7.3.1 Using LDAP authentication
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This section provides a general description of how LDAP authentication works with Information platform
services. It then introduces the administration tools that allow you to manage and configure LDAP
accounts to Information platform services.

When you install Information platform services, the LDAP authentication plug-in is installed automatically,
but not enabled by default. To use LDAP authentication, you need to first ensure that you have your
respective LDAP directory set up. For more information about LDAP, refer to your LDAP documentation.

Lightweight Directory Access Protocol (LDAP), a common, application-independent directory, enables
users to share information among various applications. Based on an open standard, LDAP provides a
means for accessing and updating information in a directory.

LDAP is based on the X.500 standard, which uses a directory access protocol (DAP) to communicate
between a directory client and a directory server. LDAP is an alternative to DAP because it uses fewer
resources and simplifies and omits some X.500 operations and features.

The directory structure within LDAP has entries arranged in a specific schema. Each entry is identified
by its corresponding distinguished name (DN) or common name (CN). Other common attributes include
the organizational unit name (OU), and the organization name (O). For example, a member group may
be located in a directory tree as follows: cn=Information platform services Users, ou=Enterprise Users
A, o=Research. Refer to your LDAP documentation for more information.

Because LDAP is application-independent, any client with the proper authorization can access its
directories. LDAP offers you the ability to set up users to log on to Information platform services through
LDAP authentication. It also enables users to be authorized when attempting to access objects in
Information platform services. As long as you have an LDAP server (or servers) running, and use LDAP
in your existing networked computer systems, you can use LDAP authentication (along with Enterprise,
and Windows AD authentication).

If desired, the LDAP security plug-in provided with Information platform services can communicate with
your LDAP server using an SSL connection established using either server authentication or mutual
authentication. With server authentication, the LDAP server has a security certificate which Information
platform services uses to verify that it trusts the server, while the LDAP server allows connections from
anonymous clients. With mutual authentication, both the LDAP server and Information platform services
have security certificates, and the LDAP server must also verify the client certificate before a connection
can be established.

The LDAP security plug-in provided with Information platform services can be configured to communicate
with your LDAP server via SSL, but always performs basic authentication when verifying users'
credentials. Before deploying LDAP authentication in conjunction with Information platform services,
ensure that you are familiar with the differences between these LDAP types. For details, see RFC2251,
which is currently available at http://www.fags.org/rfcs/rfc2251.html.

Related Topics

» Configuring LDAP authentication
* Mapping LDAP groups
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7.3.1.1 LDAP security plugin

The LDAP security plug-in allows you to map user accounts and groups from your LDAP directory
server to Information platform services; it also enables the system to verify all logon requests that specify
LDAP authentication. Users are authenticated against the LDAP directory server, and have their
membership in a mapped LDAP group verified before the CMS grants them an active Information
platform services session. User lists and group memberships are dynamically maintained by Information
platform services. You can specify that Information platform services use a Secure Sockets Layer (SSL)
connection to communicate to the LDAP directory server for additional security.

LDAP authentication for Information platform services is similar Windows AD authentication in that you
can map groups and set up authentication, authorization, and alias creation. Also as with NT or AD
authentication, you can create new Enterprise accounts for existing LDAP users, and can assign LDAP
aliases to existing users if the user names match the Enterprise user names. In addition, you can do
the following:

*  Map users and groups from the LDAP directory service.

» Map LDAP against AD. There are a number of restrictions if you configure LDAP against AD.

»  Specify multiple host names and their ports.

» Configure LDAP with SiteMinder.

Once you have mapped your LDAP users and groups, all of the Information platform services client

tools support LDAP authentication. You can also create your own applications that support LDAP
authentication.

Related Topics

» Configuring SSL settings for LDAP Server or Mutual Authentication
» Configuring the LDAP plug-in for SiteMinder

7.3.2 Configuring LDAP authentication

To simplify administration, Information platform services supports LDAP authentication for user and
group accounts. Before users can use their LDAP user name and password to log on to Information
platform services, you need to map their LDAP account to Information platform services. When you
map an LDAP account, you can choose to create a new account or link to an existing Information
platform services account.

Before setting up and enabling LDAP authentication, ensure that you have your LDAP directory set up.
For more information, refer to your LDAP documentation.
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Configuring LDAP authentication includes the following tasks:

» Configuring the LDAP host

*  Preparing the LDAP server for SSL (if required)

+ Configuring the LDAP plug-in for SiteMinder (if required)

Note:

If you configure LDAP against AD, you will be able to map your users but you will not be able to configure

AD single sign-on or single sign-on to the database. However, LDAP single sign-on methods like
SiteMinder and trusted authentication will still be available.

7.3.2.1 To configure the LDAP host

Before configuring the LDAP host, your LDAP server must be installed and running.
1. In the "Authentication" management area of the CMC, double-click LDAP.

Tip:
To go to the "Authentication" management area, click Authentication in the navigation list.

2. Type the name and port number of your LDAP hosts in the Add LDAP host (hosthame:port) box
(for example, myserver:123), click Add, and click OK.

Tip:
Repeat this step to add more than one LDAP host of the same server type if you want to add hosts
that can act as failover servers. To remove a host, select the host name and click Delete.

3. In the LDAP Server Type list, select your server type.

Note:
If you are mapping LDAP to AD, select Microsoft Active Directory Application Server for your
server type.

4. To view or change LDAP Server Attribute Mappings or LDAP Default Search Attributes, click
Show Attribute Mappings.

By default, each supported server type's server attribute mappings and search attributes are already
set.

5. Click Next.

6. Inthe Base LDAP Distinguished Name box, type a distinguished name (for example, 0=SomeBase)
for your LDAP server, and click Next.

7. Inthe "LDAP Server Credentials" area, type a distinguished name and password for a user account
that has read access to the directory.

Note:
Administrator credentials are not required.
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Note:
If your LDAP server allows anonymous binding, leave this area blank. Information platform services
servers and client computers will bind to the primary host via anonymous logon.

If you configured referrals on your LDAP host, enter authentication information under "LDAP Referral
Credentials", and type the number of referral hops in the Maximum Referral Hops box.

Note:
You must configure the "LDAP Referral Credentials" area if all of the following conditions apply:

The primary host is configured to refer to another directory server that handles queries for entries
under a specified base.

The host being referred to us configured to not allow anonymous binding.

A group from the host being referred to will be mapped to Information platform services.

Note:

Although groups can be mapped from multiple hosts, only one set of referral credentials can be
set. Therefore, if you have multiple referral hosts, you must create a user account on each host
that uses the same distinguished name and password.

If Maximum Referral Hops is set to 0 (zero), no referrals will be followed.

Click Next, and choose the type of Secure Sockets Layer (SSL) authentication used:

Basic (no SSL)
Server Authentication
Mutual Authentication
Click Next, and choose Basic (No SSO) or SiteMinder as the method of LDAP single sign-on
authentication.
Click Next, and select how aliases and users are mapped to Information platform services accounts:
In the New Alias Options list, select an option for mapping new aliases to Enterprise accounts:
Assign each added LDAP alias to an account with the same name
Use this option when you know users have an existing Enterprise account with the same
name; that is, LDAP aliases will be assigned to existing users (auto alias creation is turned

on). Users who do not have an existing Enterprise account or who do not have the same
name in their Enterprise and LDAP account are added as new users.

Create a new account for every added LDAP alias

Use this option when you want to create a new account for each user.

In the Alias Update Options list, select an option for managing alias updates for Enterprise
accounts:

Create new aliases when the Alias Update occurs

Use this option to automatically create a new alias for every LDAP user mapped to Information
platform services. New LDAP accounts are added for users without Information platform
services accounts or for all users if you selected Create a new account for every added
LDAP alias.



Create new aliases only when the user logs on

Use this option when the LDAP directory you are mapping contains many users, but only a
few of them will use Information platform services. The system does not automatically create
aliases and Enterprise accounts for all users. Instead, it creates aliases (and accounts, if
required) only for users who log on to Information platform services.

If your Information platform services license is based on users roles, in the New User Options
list, select an option to specify how new users are created:

Bl Viewer

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license
agreement. Users are restricted to access application workflows that are defined for the Bl
Viewer role. Access rights are generally limited to viewing business intelligence documents.
This role is typically suitable for users who consume content through Information platform
services applications.

Bl Analyst

New user accounts are configured under the Bl Analyst role. Access to Information platform
services applications for all accounts under the Bl Analyst role is defined in the license
agreement. Users can access all application workflows that are defined for the Bl Analyst
role. Access rights include viewing and modifying Business Intelligence documents. This role
is typically suitable for users who create and modify content for Information platform services
applications.

If your Information platform services license is not based on users roles, in the New User Options
list, select an option to specify how new users are created:

New users are created as named users

New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user
name and password. This provides named users with access to the system regardless of how
many other people are connected. You must have a named user license available for each
user account created using this option.

New users are created as concurrent users

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time.
This type of licensing is very flexible because a small concurrent license can support a large
user base. For example, depending on how often and how long users access Information
platform services, a 100-user concurrent license could support 250, 500, or 700 users.

Under "Attribute Binding Options", specify the attribute binding priority for the LDAP plugin:
Click the Import Full Name, Email Address and other attributes box.

The full names and descriptions used in the LDAP accounts are imported and stored with the
user objects in Information platform services.

Specify an option for Set priority of LDAP attribute binding relative to other attributes binding.
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Note:

If option is set to 1, LDAP attributes take priority in scenarios where LDAP and other plugins
(Windows AD and SAP) are enabled. If it is set to 3, attributes from other enabled plugins take
priority.

13. Click Finish.

Related Topics

» Configuring SSL settings for LDAP Server or Mutual Authentication
» Configuring the LDAP plug-in for SiteMinder

* Role-based licensing

7.3.2.2 Managing multiple LDAP hosts

Using LDAP and Information platform services, you can add fault tolerance to your system by adding
multiple LDAP hosts. Information platform services uses the first host that you add as the primary LDAP
host. Subsequent hosts are treated as failover hosts.

The primary LDAP host and all failover hosts must be configured in exactly the same way, and each
LDAP host must refer to all additional hosts from which you want to map groups. For more information
about LDAP hosts and referrals, see your LDAP documentation.

To add multiple LDAP Hosts, enter all hosts when you configure LDAP using the LDAP configuration
wizard (see for details.) Or if you have already configured LDAP, go to the Authentication management
area of the Central Management Console and click the LDAP tab. In the LDAP Server Configuration
Summary area, click the name of the LDAP host to open the page that enables you to add or delete
hosts.

Note:

» Make sure that you add the primary host first, followed by the remaining failover hosts.

+ If you use failover LDAP hosts, you cannot use the highest level of SSL security (that is, you cannot
select "Accept server certificate if it comes from a trusted Certificate Authority and the CN attribute
of the certificate matches the DNS hostname of the server.")

Related Topics
» Configuring LDAP authentication

7.3.2.3 Configuring SSL settings for LDAP Server or Mutual Authentication
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This section describes the CMC related information for configuring SSL with LDAP Server and Mutual
Authentication. It assumes that you have configured the LDAP host and that you selected either of
these for your SSL authentication choice:

« Server Authentication

*  Mutual Authentication

For additional information or for information on configuring the LDAP host server, refer to your LDAP
vendor documentation.

Related Topics
* To configure the LDAP host
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7.3.2.3.1 To configure the LDAP Server or Mutual Authentication

Resource ‘ Take this action hefore starting this task

CA certificate This action is required for both server and Mutual Authentication with SSL.

1. Obtain a Certificate Authority (CA) to generate a CA certificate.
2. Add the certificate to your LDAP Server.

For information, see your LDAP vendor documentation.

Server certificate This action is required for both server and Mutual Authentication with SSL.

1. Request and then generate a server certificate.
2. Authorize the certificate and then add it to the LDAP Server.

cert7.db, cert8.db, These files are required for both server and Mutual Authentication with SSL.

key3.db 1. Download the certutil application that generates either a cert7.db or
cert8.db file (depending on your requirements) from ftp://ftp.mozil
la.org/pub/mozilla.org/security/nss/releases/NSS_3_6_RTM/.

2. Copy the CA certificate to the same directory as the certutil application.

3. Use the following command to generate the cert7.db or cert8.db,
key3.db, and secmod. db files:

certutil -N -d .

4. Use the following command to add the CA certificate to the cert7.db
or cert8.db file:

certutil -A -n <CA alias_name> -t CT -d . -I cacert.cer

5. Store the three files in a directory on the computer that hosts Information
platform services.

cacerts This file is required for server or Mutual Authentication with SSL for Java
applications, like Bl launch pad.

1. Locate the keytool file in your Java bin directory.
2. Use the following command to create the cacerts file:

keytool -import -v -alias <CA_alias_name> -file <CA certificate_name> -
trustcacerts -keystore

3. Store the cacerts file in the same directory as the cert7.db or
cert8.db and key3.db files.

Client certificate
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Resource ‘ Take this action hefore starting this task

1. Create separate client requests for the cert7.db or cert8.db and
.keystore files:

»  To configure the LDAP plugin, use the certutil application to generate
a client certificate request.

+ Use the following command to generate the client certificate request:
certutil -R -s "<client dn>" -a -o <certificate request name> -d .

<client dn> includes information such as "CN=<client name>,
OU=org unit, O=Companyname, L=city, ST=province, and
C=country.

2. Use the CA to authenticate the certificate request. Use the following
command to retrieve the certificate and insert it in the cert7.db or
cert8.db file:

certutil -A -n <client name> -t Pu -d . -I <client certificate name>

3. To facilitate Java authentication with SSL:

+ Use the keytool utility in the Java bin directory to generate a client
certificate request.
+ Use the following command to generate a key pair:

keytool -genkey -keystore .keystore

4. After specifying information about your client, use the following command
to generate a client certificate request:

keytool -certreq -file <certificate_ request_ name> -keystore .keystore

5. After the client certificate request is authenticated by the CA, use the
following command to add the CA certificate to the . keystore file:
keytool -import -v -alias <CA alias name> -file <ca certificate name> -
trustcacerts -keystore .keystare - - -

6. Retrieve the client certificate request from the CA, and use the following
command to add it to the . keystore file:
keytool -import -v -file <client certificate name> -trustcacerts -keystore
.keystore

7. Store the . keystore file in the same directory as the cert7.db or
cert8.db and cacerts files on the computer that hosts Information
platform services.

1. Choose the level of SSL security to use:
- Always accept server certificate

This is the lowest security option. Before Information platform services can establish an SSL
connection with the LDAP host (to authenticate LDAP users and groups), it must receive a security
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certificate from the LDAP host. Information platform services does not verify the certificate it
receives.

Accept server certificate if it comes from a trusted Certificate Authority

This is a medium security option. Before Information platform services can establish an SSL
connection with the LDAP host (to authenticate LDAP users and groups), it must receive and
verify a security certificate sent to it by the LDAP host. To verify the certificate, Information platform
services must find the CA that issued the certificate in its certificate database.

Accept server certificate if it comes from a trusted Certificate Authority and the CN attribute
of the certificate matches the DNS hostname of the server

This is the highest security option. Before Information platform services can establish an SSL
connection with the LDAP host (to authenticate LDAP users and groups), it must receive and
verify a security certificate sent to it by the LDAP host. To verify the certificate, Information platform
services must find the CA that issued the certificate in its certificate database. It must also be
able to confirm that the CN attribute on the server certificate exactly matches the LDAP host
name you entered in the Add LDAP host box in the first step of the wizard—if you entered the
LDAP host name as ABALONE.rd.crystald.net:389. (Using CN =ABALONE:389 in the certificate
doesn't work.)

The host name on the server security certificate is the name of the primary LDAP host. Therefore
if you select this option you cannot use a failover LDAP host.

Note:
Java applications ignore the first and last setting and accept the server certificate only if it comes
from a trusted CA.

In the SSL host box, type the host name of each computer, and click Add.

Next, you must add the host name of each computer in your Information platform services system
that uses the Information platform services SDK. (This includes the computer running your Central
Management Server and the computer running your web application server.)

Specify the SSL settings for each SSL host you added to the list:
Select default in the SSL list.
Clear the Use default value check boxes.

Type a value in the Path to the certificate and key database files box and the Password for
the key database box.

If specifying settings for mutual authentication, type a value in the Nickname for the client
certificate in the cert7.db box or the Nickname for the client certificate in the cert8.db box.

Note:
The default settings will be used (for any setting) for any host with the Use default value check box
selected or for any computer name you do not add to the list of SSL hosts.

Specify the default settings for each host that isn't in the list, and click Next.

To specify settings for another host, select the host name in the list on the left, and type values in
the boxes on the right.
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Note:
The default settings will be used for any setting (for any host) with the Use default value check box
selected or for any computer name you do not add to the list of SSL hosts.

5. Select Basic (No SSO) or SiteMinder as the method of LDAP single sign-on authentication.
6. Choose how new LDAP users and aliases are created.
7. Click Finish.

Related Topics
» Configuring the LDAP plug-in for SiteMinder

7.3.2.4 To modify your LDAP configuration settings

After you have configured LDAP authentication using the LDAP configuration wizard, you can change
LDAP connection parameters and member groups using the LDAP Server Configuration Summary
Page.
1. Go to the Authentication management area of the CMC.
2. Double-click LDAP.

If LDAP authorization is configured, the "LDAP Server Configuration Summary" page appears. On

this page you can change any of the connection parameter areas or fields. You can also modify the
"Mapped LDAP Member Groups" area.

3. Delete currently mapped groups that are no longer accessible under the new connection settings,
and click Update.

4. Change your connection settings, then click Update.

5. Change your "Alias and New User" options, and click Update.

6. Map your new LDAP member groups, and click Update.

7.3.2.5 Configuring the LDAP plug-in for SiteMinder

This section explains how to configure the CMC to use LDAP with SiteMinder. SiteMinder is a third-party
user access and authentication tool that you can use with the LDAP security plug-in to create single
sign-on to Information platform services.

To use SiteMinder and LDAP with Information platform services, you must make configuration changes
in the following two places:

*  LDAP plugin through the CMC
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- BOE.war file properties

Note:

Ensure that the SiteMinder Administrator has enabled support for 4.x Agents. This must be done
regardless of what supported version of SiteMinder you are using. For more information about SiteMinder
and how to install it, see the SiteMinder documentation.

Related Topics
* To configure the LDAP host

7.3.2.5.1 To configure LDAP for single sign-on with SiteMinder
1. Open the Please configure your SiteMinder settings screen using one of the following methods:

+ Select SiteMinder on the "Please choose a method of LDAP single sign-on authentication" screen
in the LDAP configuration wizard.

- Select the "Single Sign On Type" link on the LDAP authentication screen which is available if
you have already configured LDAP and are now adding SSO.
2. In the Policy Server Host box, type the name of each policy server, and then click Add.

3. For each Policy Server Host, specify the Accounting, Authentication and Authorization port
numbers.

4. Enter the name of the Agent Name and the Shared Secret. Enter the shared secret again.
5. Click Next.
6. Proceed with configuring the LDAP options.

7.3.2.5.2 To enable LDAP and SiteMinder in the BOE.war file

In addition to specifying SiteMinder settings for the LDAP security plugin, SiteMinder settings must be

specified for the BOE.war properties.

1. Go to the following directory in your Information platform services installation:
<INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\

2. Create a new file using Notepad or another text editing utility.

3. Enter the following statement:

siteminder.authentication=secLDAP
siteminder.enabled=true

4. Close the file and save it under the following name:
global.properties

Note:
Make sure the file name is not saved under any extensions such as . txt.

5. Create another file in the same directory.
6. Enter the following statement:

authentication.default=LDAP
cms.default=[enter your cms name]: [Enter the CMS port number]
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For example:

authentication.default=LDAP
cms.default=mycms: 6400

7. Close the file and save it under the following name:

bilaunchpad.properties

The new properties take effect only after the modified BOE web application is redeployed on the machine
running the web application server. Use WDeploy to redeploy the WAR file on the web application
server. For more information on using WDeploy, see the Information platform services Web Application
Deployment Guide.

7.3.3 Mapping LDAP groups

Once you have configured the LDAP host using the LDAP configuration wizard, you can map LDAP
groups to Enterprise groups.

Once you have mapped LDAP groups, you can view the groups by clicking the LDAP option in the
Authentication management area. If LDAP authorization is configured, the Mapped LDAP Member
Groups area displays the LDAP groups that have been mapped to Information platform services.

You can also map Windows AD groups to authenticate in Information platform services via the LDAP
security plugin.

Note:
If you have configured LDAP against AD, this procedure will map your AD groups.

Related Topics
* Mapping LDAP against Windows AD

7.3.3.1 To map LDAP groups using Information platform services

1. In the "Authentication" management area of the CMC, double-click LDAP.
If LDAP authorization is configured, the LDAP summary page appears.

2. Under "Mapped LDAP Member Groups", enter your LDAP group (by common name or distinguished
name) in the Add LDAP group (by cn or dn) box, and click Add.

To add more than one LDAP group, repeat this step. To remove a group, select the LDAP group,
and click Delete.
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Under "New Alias Options", select an option to specify how LDAP aliases are mapped to Enterprise
accounts:

Assign each added LDAP alias to an account with the same name

Use this option when you know users have an existing Enterprise account with the same name;
that is, LDAP aliases will be assigned to existing users (auto alias creation is turned on). Users
who do not have an existing Enterprise account, or who do not have the same name in their
Enterprise and LDAP account, are added as new LDAP users.

Create a new account for every added LDAP alias

Use this option when you want to create a new account for each user.

Under "Alias Update Options", select one of the following options to specify whether LDAP aliases
are automatically created for all new users:

Create new aliases when the Alias Update occurs

Use this option to automatically create a new alias for every LDAP user mapped to Information
platform services. New LDAP accounts are added for users without Information platform services
accounts or for all users, if you selected the Create a new account for every added LDAP alias
option and clicked Update.

Create new aliases only when the user logs on

Use this option when the LDAP directory you are mapping contains many users, but only a few
of them will use Information platform services. Information platform services does not automatically
create aliases and Enterprise accounts for all users. Instead, it creates aliases (and accounts, if
required) only for users who log on to Information platform services.

Under "New User Options", specify properties for the new Enterprise accounts created to map to
LDAP accounts.

If your Information platform services license is based on users roles, select one of the following
options:

Bl Viewer User

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license agreement.
Users are restricted to access application workflows that are defined for the Bl Viewer role.
Access rights are generally limited to viewing business intelligence documents. This role is
typically suitable for users who consume content through Information platform services
applications.

Bl Analyst User

New user accounts are configured under the Bl Analyst role. Access to Information platform
services applications for all accounts under the Bl Analyst role is defined in the license agreement.
Users can access all application workflows that are defined for the Bl Analyst role. Access rights
include viewing and modifying business intelligence documents. This role is typically suitable for
users who create and modify content for Information platform services applications.

If your Information platform services license is not based on users roles, select one of the following
options:
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New users are created as named users

New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user name
and password. This provides named users with access to the system regardless of how many
other people are connected. You must have a named user license available for each user account
created using this option.

New users are created as concurrent users

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time. This
type of licensing is very flexible because a small concurrent license can support a large user
base. For example, depending on how often and how long users access Information platform
services, a 100-user concurrent license could support 250, 500, or 700 users.

6. Click Update.

Related Topics
* Role-based licensing

7.3.3.2 To unmap LDAP groups using Information platform services

. Go to the Authentication management area of the CMC.
. Double-click LDAP.

If LDAP authorization is configured, the LDAP summary page will appear.

In the "Mapped LDAP Member Groups" area, select the LDAP group you would like to remove.

. Click Delete, and then click Update.

The users in this group will not be able to access Information platform services.

Note:
The only exceptions to this occur when a user has an alias to an Enterprise account. To restrict
access, disable or delete the user's Enterprise account.

To deny LDAP Authentication for all groups, clear the "LDAP Authentication is enabled" check box and
click Update.

7.3.3.3 Mapping LDAP against Windows AD

If you configure LDAP against Windows ADauthen, note the following restrictions:
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If you configure LDAP against AD, you will be able to map your users but you will not be able to
configure AD single sign-on or single sign-on to the database. However, LDAP single sign-on methods
like SiteMinder and trusted authentication will still be available.

Users who are only members of default groups from AD will not be able to log in successfully. Users
must also be a member of another explicitly created group in AD and, in addition, this group must
be mapped. An example of such a group is the "domain users" group.

If a mapped domain local group contains a user from a different domain in the forest, the user from
a different domain in the forest will not be able to log in successfully.

Users from a universal group from a domain different than the DC specified as the LDAP host will
not be able to log in successfully.

You cannot use the LDAP plug-in to map users and groups from AD forests outside the forest where
Information platform services is installed.

You cannot map in the Domain Users group in AD.

You cannot map a machine local group.

If you are using the Global Catalog Domain Controller, there are additional considerations when
mapping LDAP against AD:

You can map in:
* universal groups on a child domain,

» groups on the same domain that contains universal
groups from a child domain, and

* universal groups on a cross domain.

You cannot map in:

Multiple domains when pointing to the | ©  global groups on a child domain,

Global Catalog Domain Controller * local groups on a child domain,

+ groups on the same domain that contain a global group
from the child domain, and

+ cross-domain global groups.

Generally, if the group is a universal group, it will support
users from cross or child domains. Other groups will not
be mapped if they contain users from cross or child do-
mains. Within the domain you are pointing to, you can
map domain local, global, and universal groups.

To map in universal groups, you must point to the Global
Mapping in universal groups Catalog Domain Controller. You should also use port
number 3268 instead of the default 389.
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+ If you are using multiple domains but not pointing to the Global Catalog Domain Controller, then you
cannot map in any type of groups from cross or child domains. You can map in all types of groups
only from the specific domain you are pointing to.

7.3.3.4 Troubleshooting LDAP accounts

+ If you create a new LDAP user account—and the account does not belong to a group account that
is mapped to Information platform services—map the group to Information platform services or add
the new LDAP user account to a group that is already mapped to Information platform services.

» Ifyou create a new LDAP user account—and the account belongs to a group account that is mapped
to Information platform services—refresh the user list.

Related Topics
* Configuring LDAP authentication
* Mapping LDAP groups

7.4 Windows AD authentication

7.4.1 Overview

7.4.1.1 Using Windows AD authentication

This section provides a general description of how Windows Active Directory (AD) authentication works
with Information platform services. It then introduces the administration workflows required to enable
and manage AD accounts in Information platform services. At the end of the section, there are some
basic troubleshooting tips.

196 2012-08-15



Authentication

Support requirements

To facilitate AD authentication on Information platform services, you should remember the following
support requirements.

+  The CMS must always be installed on a supported Windows platform.

+ Although Windows 2003 and 2008 are supported platforms for both Kerberos and NTLM
authentication, certain Information platform services applications may only use particular authentication
methods. For example, applications such as Information platform services Bl launch pad and
Information platform services Central Management Console only support Kerberos.

Basic AD authentication workflow
To use AD authentication with Information platform services you must follow the following basic workflow:

Configure the required domain controller resources.

Prepare the Information platform services host for Windows AD authentication.

Enable the AD security plug-in and map in AD groups.

Choose an authentication method:

* Windows AD with Kerberos

* Windows AD with NTLM

5. Set up single sign-on to Information platform services applications. This optional step can be facilitated
via the following methods:

* Windows AD with Vintela (Kerberos)

* Windows AD with SiteMinder (Kerberos)

e

7.4.1.1.1 Windows AD security plug-in

The Windows AD security plug-in enables you to map user accounts and groups from your Microsoft
Active Directory (AD) 2003, and 2008 user database to Information platform services. It also enables
Information platform services to verify all logon requests that specify AD Authentication. Users are
authenticated against the AD user database, and have their membership in a mapped AD group verified
before the Central Management Server (CMS) grants them an active Information platform services
session.

The Windows AD security plug-in enables you to configure the following:
+ Windows AD authentication with NTLM
* Windows AD authentication with Kerberos

* Windows AD authentication with SiteMinder for single sign-on

The Windows AD security plug-in is compatible with both Microsoft Active Directory 2003, and 2008
domains running in either native mode or mixed mode.

Once you have mapped your AD users and groups, all of the Information platform services client tools
support AD authentication.
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» Windows AD authentication only works if the CMS is run on Windows. For single sign-on to database
to work, the reporting servers must also run on Windows. Otherwise all other servers and services
can run on all supported platforms.

+ The Windows AD plug-in for Information platform services supports domains within multiple forests.

7.4.1.1.2 Using Windows AD users and groups

Information platform services supports Active Directory (AD) authentication with the Windows security
plug-in, which is included by default when the product is installed on a Windows platform. Support for
Windows AD authentication means that users and groups accounts in Microsoft Active Directory (2003
and 2008) can be used to authenticate with Information platform services. System administrator can
therefore map existing AD accounts, instead of setting up each user and group within Information
platform services.

Scheduling updates for Windows AD groups

Information platform services enables administrators to schedule updates for Windows AD groups and
user aliases. This feature is available for AD authentication with either Kerberos or NTLM. The CMC
also enables you to view the time and date when the last update was performed.

Note:
For AD authentication to work on Information platform services, you must configure how updates are
scheduled for your AD groups and aliases.

When scheduling an update, you can choose from the recurrence patterns summarized in the following
table:

The update will run every hour. You specify at what time it will

Hourly start, as well as a start and end date.

The update will run every day or run every number of specified
Daily days. You can specify at what time it will run, as well as a start
and end date.

The update will run every week. It can be run once a week or
Weekly several times a week. You can specify on which days and at what
time it will run, as well as a start and end date.

The update will run every month or every several months. You

Monthly can specify what time it will run, as well as a start and end date.

The update will run on a specific day in the month. You can
Nth Day of Month specify on which day of the month, what time it will run, as well
as a start and end date.

The update will run on the first Monday of each month. You can

1st Monday of Month specify what time it will run, as well as a start and end date.
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Last Dav of Month The update will run on the last day of each month. You can
y specify what time it will run, as well as a start and end date.

The update will run on a specified day of a specified week of the
X Day of Nth Week of the Month | month. You can specify what time it will run, as well as a start
and end date.

The update will be run on the dates specified in a calendar that

Calendar has previously been created.

Scheduling AD group updates

Information platform services relies on Active Directory (AD) for user and group information. To minimize
the volume of queries sent to AD, the AD plugin caches information about groups and how they relate
to each other and their user membership. The update does not run when no specific schedule is defined.

You must use the CMC to configure the recurrence of the group update refresh. This should be scheduled
to reflect how frequently your will group membership information is modified.

Scheduling AD user alias updates

User objects can be aliased to a Windows Active Directory (AD) account, allowing users to use their
AD credentials to log on to Information platform services. Updates to AD accounts are propagated to
Information platform services by the AD plug-in. Accounts created, deleted, or disabled in AD will be
correspondingly created, deleted, or disabled in Information platform services.

If you do not schedule AD alias updates, updates will only occur when:

* Avuserlogs on. The AD alias will be updated.

+ An administrator selects the Update AD Groups and Aliases now option from the "On-Demand
AD Update" area of the CMC.

Note:
No AD passwords are stored in the user alias.

7.4.1.1.3 Single sign-on with Windows AD

The Windows AD security plug-in supports single sign-on, thereby allowing authenticated AD users to
log on to Information platform services without explicitly entering their credentials. The single sign-on
requirements depend upon the way in which users access Information platform services: either via a
thick client, or over the Web. In both scenarios, the security plug-in obtains the security context for the
user from the authentication provider, and grants the user an active Information platform services
session if the user is a member of a mapped AD group.

The most common usage scenario involves single sign-on to the Bl launch pad web application.
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Single sign-on to database

The Windows AD plug-in supports single sign-on to database. If set properly authenticated AD users
do not have to provide their account credentials when accessing reports from the Bl launch pad
application.

7.4.2 Preparing for AD authentication (Kerberos)

7.4.2.1 Using Kerheros authentication for Windows AD

This section describes the prerequisite tasks required for setting up the Kerberos authentication for
Information platform services. Once all the prerequisite tasks have been implemented, you can proceed
to configure Windows AD authentication options for Kerberos in the Windows AD security plug-in.

Recommended workflow
To properly set up Windows AD authentication the following prerequisite tasks need to be implemented:
+ Setting up a service account for running Information platform services

* Preparing the Information platform services servers for Windows AD authentication with Kerberos
» Configuring your web application server for Windows AD authentication with Kerberos.

7.4.2.1.1 Setting up a service account for AD authentication with Kerberos

To configure Information platform services for Kerberos and Windows AD authentication, you require
a service account. You can either create a new domain account or use an existing domain account.
The service account will be used to run the Information platform services servers.

Note:
After you set up the service account, you will need to grant the account appropriate rights.

If you are using a Windows 2003 or 2008 Domain, you also have the option of setting up constrained
delegation.

To set up the service account on a Windows 2003 or 2008 domain

You need to set up a new service account on the domain controller to successfully enable Windows
AD authentication with Kerberos. This task is performed on the AD domain controller machine.

1. Create a new account with a password on the domain controller or use an existing account.

For detailed instructions, refer to "http://msdn.microsoft.com/ "
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2. Run the keytab ktpass command to create and place a Kerberos keytab file.

You will need to specify the ktpass parameters listed in the following table:

Parame o
ter Description
-out Specifies the name of the Kerberos keytab file to generate.
-mapus Specifies the name of the user account to which the SPN mapped. This is account
er under which the server intelligence agent runs.
-pass Specifies the password used by the service account.
Specifies the principal type. Should be specified as:
-ptype
-ptype KRB5 NT PRINCIPAL
Specifies which encryption type to use with the service account. Use the following:
-crypto
—-crypto RC4-HMAC-NT
For example,

ktpass -out -mapuser sbo.serviceDOMAIN.COM -pass password
-kvno 255 -ptype KRB5 NT PRINCIPAL -crypto RC4-HMAC-NT

The output from the ktpass command should confirm the target domain controller, and that a
Kerberos keytab file containing the shared secret has been created. The command also maps the
principal name to the (local) service account.

3. Run the setspn -1 command to verify that the ktpass command was successfully executed.
The display output lists all the service principal names registered to the local service account.

4. Right-click the service account you created in Step 1, select Properties > Delegation.
5. Click Trust this user for delegation to any service (Kerberos only).
6. Click OK to save your settings.

Once created, the service account needs to be granted rights and added to the servers's Local
Administrators group.

Granting the service account rights

To support Windows AD and Kerberos, you must grant the service account the right to act as part of
the operating system. This must be done on each machine running a Server Intelligence Agent (SIA)
with the Central Management Server (CMS).

If you require single sign-on to the database, the SIA must include the following servers:

» Crystal Reports Processing Server

*  Report Application Server

*  Web Intelligence Processing Server
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Note:
For single sign-on to the database to work, the service account must be trusted for delegation.

To grant the service account rights
1. Click Start > Control Panel > Administrative Tools > Local Security Policy.
Expand Local Policies, then click User Rights Assignment.
Double-click Act as part of the operating system.
Click Add.
Enter the name of the service account you created, then click OK.
Ensure that the Local Policy Setting check box is selected, and click OK.
Repeat the above steps on each machine running a Information platform services server.
Note:
It is important that the Effective Right ends up being checked after Act as part of the operating
system is selected. Typically, you will need to restart the server for this to occur. If, after restarting

the server, this option is still not on, your Local Policy settings are being overridden by your Domain
Policy settings.

No kRN

Adding the Service Account to the servers’ Local Administrators group
In order to support Kerberos, the service account must be part of the local Administrators group for
each server that has a SIA with one of the following services deployed:

- CMS

» Crystal Reports Processing Server (required only for SSO2DB)
* Report Application Server (required only for SSO2DB)

* Web Intelligence Processing Server (required only for SSO2DB)

Note:
If you're using SSO2DB, you require a service account that has been trusted for delegation. You must
also have administrative rights on the server.

To add an account to the Administrator's group
1. On the desired machine, right-click My Computer and click Manage.
Go to System Tools > Local Users and Groups > Groups.
Right-click Administrators, then click Add to Group.
Click Add and type the logon name of the service account.
Click Check Names to ensure that the account resolves.
Click OK, then click OK again.
Repeat these steps for each Information platform services server that has to be configured.

No ok~
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7.4.2.1.2 Preparing the servers for Windows AD authentication with Kerberos

After the service account has been created and configured for Windows AD authentication with Kerberos,
you can run each SIA in your Information platform services deployment under the account.

To configure the SIA under the service account

Perform the following steps for any Server Intelligence Agent (SIA) that is running services used by the
service account created for Windows AD authentication with Kerberos.

1. To start the CCM, choose Programs > SAP BusinessObjects Bl platform 4 > SAP
BusinessObjects Bl platform > Central Configuration Manager.

The CCM home page opens.
2. Right-click the Server Intelligence Agent (SIA) and select Stop.
Note:
When you stop the SIA, all services managed by the SIA are stopped.
Right-click the SIA and select Properties.
Clear the System Account check box.
Enter the service account credentials (DOMAINNAME\service name) and click OK.
Restart the SIA.
If necessary, repeat steps 1 to 5 for each SIA running a service that must be configured.

No e

7.4.2.1.3 Preparing the application server for Windows AD authentication (Kerberos)

This section contains the tasks related to configuring Kerberos for use with these the following application

servers:

+ Tomcat

+ WebSphere
* WebLogic

» Oracle Application Server
+  SAP NetWeaver 7.10

This section contains this information:

- The workflow specific to a particular web application server. This workflow is necessary because
the implementation of Java Authentication and Authorization Service (JAAS) varies between different
application servers .

» The procedural details for each step in the workflow.
- Sample Krb5.ini file for Java application servers.

Overview

The specific process of configuring Kerberos for a web application server varies slightly depending the
specific application server. However, the general process of configuring Kerberos involves these steps:

» Creating the Kerberos configuration file.
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» Creating the JAAS login configuration file.

Note:
This step is not required for the SAP NetWeaver 7.10 Java application server. However you will
need to add LoginModule to your SAP NetWeaver server.

*  Modifying the Java Options.
+ Restarting your Java application server.

To create a Kerberos configuration file for SAP NetWeaver, Tomcat, WebLogic, SAP NetWeaver
or Oracle

Follow these steps to create the Kerberos configuration file if you’re using SAP Netweaver 7.10, Tomcat
6, Oracle Application Server or WebLogic.

1. Create the file krb5. ini, if it does not exist, and store it under C:\WINNT for Windows.
Note:
- If the application server is installed on UNIX, you should use the following directories:

Solaris: /etc/krb5/krb5.conf

Linux: /etc/krb5.conf

* You can store this file in a different location, however if you do, you will need to specify its location
in your java options. For more information on krb5.ini go to
http://docs.sun.com/app/docs/doc/816-0219/6m6njgb94?a=view.

2. Add the following required information in the Kerberos configuration file:

[libdefaults]

default_realm = DOMAIN.COM
dns lookup kdc = true
dns_lookup realm = true
default tkt enctypes = rc4-hmac
default tgs_enctypes rc4-hmac
[domain realm]

.domain.com = DOMAIN.COM
domain.com = DOMAIN.COM
.domain2.com = DOMAIN2.COM
domain2.com = DOMAINZ2.COM
[realms]

DOMAIN.COM = {

default domain = DOMAIN.COM
kdc = HOSTNAME.DOMAIN.COM

}

DOMAIN2.COM = ({

default domain = DOMAIN2.COM
kdc = HOSTNAME.DOMAIN2.COM

}

[capaths]

DOMAIN2.COM = ({

DOMAIN.COM =

}

Note:

DOMAIN.COM is the DNS name of your domain which must be entered in uppercase in FQDN format.
kdc is the Host name of the Domain Controller. You can add multiple domain entries to the [realms]
section if your users log in from multiple domains. [capath] defines the trust between domains
that are in another AD forest. In the example above DOMAIN2 . COM is a domain in an external forest
and has direct two way transitive trust to DOMAIN.COM. In a multiple domain configuration, under
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[libdefaults] thedefault realmvalue may be any of the source domains. The best practice
is to use the domain with the greatest number of users that will be authenticating with their AD
accounts. If no UPN suffix is supplied at log on, it defaults to the value of default realm. This
value should be consistent with the default domain setting in the CMC.

Related Topics
» To modify the Java options for Kerberos on Tomcat

To create a Kerberos configuration file for WebSphere
1. Create the file krb5.ini, if it does not exist, and store it under C:\WINNT for Windows.

Note:
You can store this file in a different location, however if you do, you will need to specify its location
in your java options.

2. Add the following required information in the Kerberos configuration file:

[libdefaults]

default realm = DOMAIN.COM
dns_lookup kdc = true
dns_lookup realm = true
default tkt enctypes = rcd-hmac
default_tgs_enctypes = rc4-hmac
[domain_realm]

.domain.com = DOMAIN.COM
domain.com = DOMAIN.COM
.domain2.com = DOMAIN2.COM
domain2.com = DOMAIN2.COM
[realms]

DOMAIN.COM = {

default domain = DOMAIN.COM
kdc = HOSTNAME.DOMAIN.COM

}

DOMAIN2.COM = ({
default_domain = DOMAIN2.COM
kdc = HOSTNAME.DOMAIN2.COM

}

[capaths]

DOMAIN2.COM = ({

DOMAIN.COM =

}

Note:

+ If you are using DES encryption, change rc4-hmac to des-cbc-crec.

* DOMAIN.COM is the DNS name of your domain which must be entered in uppercase in FQDN
format.

* hostname is the Host name of the Domain Controller.

3. Save and close the file.

Related Topics
» To modify the Java options for Kerberos on WebSphere
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Sample multiple domain Krb5.ini file

The following is a sample file with multiple domains:

[domain_ realm]
; trust relationship: childtest4<->sboptest3<->sboptest<->sboptest2
[libdefaults]
default_realm = SBOPTEST.COM
[realms]
SBOPTEST.COM = ({
kdc = VANPGVMBOBJO1.sboptest.com

}
SBOPTEST2.COM = {
kdc = VANPGVMBOBJOS5.sboptest2.com

}
SBOPTEST3.COM = {
kdc = VANPGVMBOBJO7.sboptest3.com

}
CHILDTEST4.SBOPTEST3.COM = {
kdc = vanpgvmbobj08.childtest4.sboptest3.com
}
[capaths]
; for clients in sboptest3 to login sboptest2
SBOPTEST3.COM = {
SBOPTEST2.COM = SBOPTEST.COM

}
; for clients in childtest4 to login sboptest2
CHILDTEST4.SBOPTEST3.COM = {
SBOPTEST2.COM = SBOPTEST.COM
SBOPTEST2.COM = SBOPTEST3.COM
}

To create a Tomcat or WebLogic JAAS login configuration file
1. Create afile called bsclLogin. conf if it does not exist, and store it in the default location: C:\WINNT.
Note:

You can store this file in a different location. However, if you do, you will need to specify its location
in your java options.

2. Add the following code to your JAAS bscLogin.conf configuration file:

com.businessobjects.security.jgss.initiate {
com.sun.security.auth.module.Krb5LoginModule required;

bi

3. Save and close the file.

To create a Oracle JAAS login configuration file
1. Locate the jazn-data.xml file.

Note:
This default location for this file is C: \OraHome 1\j2ee\home\config. If you installed Oracle
Application Server in a different location, find the file specific to your installation.

2. Add the following content to the file between the <jazn-loginconfig> tags:

<application>
<name>com.businessobjects.security.jgss.initiate</name>
<login-modules>

<login-module>
<class>com.sun.security.auth.module.Krb5LoginModule</class>
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<control-flag>required</control-flag>
</login-module>

</login-modules>

</application>

3. Save and close the file.

To create a WebSphere JAAS login configuration file
1. Create afile called bscLogin. conf if it does not exist, and store it in the default location: C:\WINNT
2. Add the following code to your JAAS bscLogin. conf configuration file:

com.businessobjects.security.jgss.initiate ({
com.ibm.security.auth.module.Krb5LoginModule required;

}i

3. Save and close the file.

To add a LoginModule to SAP NetWeaver

To use Kerberos and SAP NetWeaver 7.10, configure the system as if you were using the Tomcat web
application server. You will not need to create a bscLogin.conf file.

Once this has been done, you need to add a LoginModule and update some Java settings on SAP
NetWeaver 7.10.

To map the com.sun.security.auth.module.Krb5LoginModule to the
com.businessobjects.security.jgss.initiate, you need to manually add a LoginModule to NetWeaver.

1. Open the NetWeaver Administrator by typing the following address into a web browser:
http://<machine name>:<port>/nwa.

2. Click Configuration Management > Security > Authentication > Login Modules > Edit.
3. Add a new login module with the following information:

Display Name Krb5LoginModule
Class Name com.sun.security.auth.module.Krb5LoginModule
4. Click Save.

NetWeaver creates the new module.

Click Components > Edit.
Add a new Policy called com.businessobjects.security.jgss.initiate.
In the Authentication Stack, add the login module we created in Step 3, and set it to Required.

Confirm that there are no other entries in the "Options for Selected Login Module". If there are,
remove them.

9. Click Save.
10. Log out of the NetWeaver Administrator.

O N o

To modify the Java options for Kerberos on Tomcat
1. From the Start menu, select Programs >Tomcat > Tomcat Configuration.
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Click the Java tab.
Add the following options:

-Djava.security.auth.login.config=C:\XXXX\bscLogin.conf
-Djava.security.krb5.conf=C:\XXXX\krb5.ini

Replace XXXX with the location where you stored the file.

Close the Tomcat configuration file.
Restart Tomcat.

To configure Java options for NetWeaver

1.

Ll

© No o

12.
13.
14.
15.

16.

Browse to the Java configuration tool (located at C: \usr\sap\<NetWeaver ID>\<in
stance>\j2ee\configtool\ by default) and double-click configtool .bat.

The configuration tool opens.

Click View > Expert Mode.
Expand Cluster-Data > Template.

Select the Instance that corresponds to your NetWeaver server (for example Instance - <system
ID><machine name>).

Click VM Parameters.

Select SAP from the Vendor list, and GLOBAL from the Platform list.
Click System.

Add the following custom parameter information:

java.security.kbr5.conf <path to the krb5.ini file including the
file name>

javax.security.auth.useSubjectCredsOn- | False
ly

. Click Save.
10.
1.

Click Configuration Editor.

Click Configurations > Security > Configurations > com.businessobjects.security.jgss.initiate
> Security > Authentication.

Click Edit Mode.

Right-click the Authentication node and select Create sub-node.
Select Value-Entry from the top list.

Enter the following:

Name Create_security_session
Value False
Click Create.
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17. Close the window.
18. Click Config Tool.
19. Click Save.

Once you have updated your configuration, you need to restart your NetWeaver server.

To modify the Java options for Kerberos on WebLogic

If you are using Kerberos with WebLogic, your Java options need to be modified to specify the location
of the Kerberos configuration file and the Kerberos login module.
1. Stop the domain of WebLogic that runs your Information platform services applications.

2. Open the script that starts the domain of WebLogic that runs your Information platform services
applications (startWeblogic.cmd for Windows, startWebLogic. sh for UNIX).

3. Add the following information to the Java_Options section of the file:

set JAVA OPTIONS=-Djava.security.auth.login.config=C:/XXXX/bscLogin.conf -Djava.securi
ty.krb5.conf=C:/XXX/krb5.ini

Replace XXXX with the location you stored the file.

4. Restart the domain of WebLogic that runs your Information platform services applications.

To modify the Java options for Kerberos on Oracle Application Server

If you are using Kerberos with Oracle Application Server, the Java options need to be modified to specify
the location of the Kerberos configuration file.

1. Log on to the administration console of your Oracle Application Server.

Click the name of the OC4J instance that runs your Information platform services applications.
Select Server Properties.

Scroll down to the Multiple VM Configuration section.

In the Command Line Options section, append the following at the end of the Java Options text field:
-Djava.security.krb5.conf=C:/XXXX/krb5.ini replacing XXXX with the location where
you stored the file.

6. Restart your OC4J instance.

A o

To modify the Java options for Kerberos on WebSphere
1. Log into the administrative console for WebSphere.
For IBM WebSphere 5.1, type http://servername: 9090/admin. For IBM WebSphere 6.0, type
http://servername:9060/ibm/console
2. Expand Server, click Application Servers, and then click the name of the application server you
created to use with Information platform services.
3. Go to the JVM page.

If you are using WebSphere 5.1, follow these steps to get to the JVM page.
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a. On the server page, scroll down until you see Process Definition in the Additional Properties
column.

b. Click Process Definition.
c. Scroll down and click Java Virtual Machine.

If you are using WebSphere 6.0, follow these steps to get to the JVM page.

a. On the server page, select Java and Process Management.
b. Select Process Definition.
c. Select Java Virtual Machine.

4. Click Generic JVM arguments then type the location of your Krb5.ini and the location of your
bsclLogin.conf file.

-Djava.security.auth.login.config=C:\XXXX\bscLogin.conf
-Djava.security.krb5.conf=C:\XXXX\krb5.ini
Replace XXXX with the location you stored the file.

5. Click Apply, and then click Save.
6. Stop and restart the server.

7.4.3 AD authentication single sign-on

7.4.3.1 Options for Windows AD authentication single sign-on

There are two supported methods for setting up single sign-on for Windows AD authentication with
SAP BusinessObjects Enterprise:

+ Vintela single sign on - this option can only be used with Kerberos.
+ Single sign on with SiteMinder - this option can only be used with Kerberos.

7.4.3.2 Configuring Windows AD authentication (Kerberos) with Vintela single

The following section details the reqiured tasks for setting up Information platform services to work with
Windows AD authentication and Vintela single sign-on.
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Note:

The prerequisite setup tasks for Windows AD authentication, together with the specific Vintela single
sign-on task should be completed before configuring the Windows AD authentication options in the
CMC.

7.4.3.3 Workflow for configuring Kerheros and single sign-on for Java Bl launch
pad

To set up Information platform services to work with Windows AD authentication and Vintela single
sign-on you need to complete the following tasks:

Create and configure a service account to be used for Vintela single sign-on.

Setup your Information platform services deployment to run under the service account.
Configure the BOE general and Bl launch pad-specific properties for Vintela single sign on.
Increase the header size limit of the Java application server.

Configure the Internet Browsers for Vintela single sign-on.

Configure constrained delegation for Vintela single sign-on (optional).

oakraubh-=

Once all these tasks have been completed you can configure the Windows AD authentication options
in the CMC.

7.4.3.4 To set up the service account for Vintela single sign-on

You need to set up a new service account on the domain controller to successfully enable Vintela single
sign-on for Windows AD authentication. This service account will be used specifically for allow users
in a given Windows AD group to sign-on to Bl launch pad. This task is performed on the AD domain
controller machine. Steps 1-5 below are required for using Windows AD with Kerberos, while steps 6-7
are specific for setting up Vintela single sign-on.

1. Create a new service account with a password on the primary domain controller.
2. Run the kerberos keytab setup command ktpass to create and place a keytab file.
You will need to specify the ktpass parameters listed in the following table:

Description

-out Specifies the name of the Kerberos keytab file to generate.

2012-08-15



Authentication

ter Description

Specifies principal name used for the service account. This parameter should be
specified in SPN format.

Note:
_ The name of your service account is case-sensitive. An SPN always includes the
-princ name of the host computer on which the service instance is running.

Tip:
The SPN must be unique in the forest in which it is registered. One way to check is
to use Windows support tool L.dp . exe to search for the SPN.

-mapus Specifies the name of the user account to which the -princ (above) is mapped. This

er is account under which the server intelligence agent runs.
-pass Specifies the password used by the service account.
Specifies the principal type. Should be specified as:
-ptype
-ptype KRB5_NT_ PRINCIPAL
Specifies which encryption type to use with the service account. Use the following:
-crypto
—-crypto RC4-HMAC-NT
For example:

ktpass -out keytab filename.keytab -princ

MYSIAMYSERVER/sbo.service.DOMAIN.COM

-mapuser sbo.serviceDOMAIN.COM -pass password

-kvno 255 -ptype KRB5 NT PRINCIPAL -crypto RC4-HMAC-NT

The output from the ktpass command should confirm the target domain controller, and that a
Kerberos keytab file containing the shared secret has been created. The command also maps the

principal name to the (local) service account.

. Runthe setspn -1 command to verify that the ktpass command was successfully executed.

The display output lists all the service principal names registered to the local service account.

Right-click the service account you created in Step 1, selectProperties > Delegation.
Click Trust this user for delegation to any service (Kerberos only).

. Use the setspn -a command to add the HTTP service principal names to the service account you

created in Step 1. Specify service principal names for the server, fully qualified domain server and
IP address for the machine on which Bl launch pad is deployed.

For example:

setspn -a HTTP/servername servicename
setspn -a HTTP/servernamedomain servicename
setspn -a HTTP/<ip address of server> servicename

Where servername is the name of the server on which Bl launch pad is deployed andservername
domain is the fully qualified domain name of the latter.

2012-08-15



Authentication

7.

Run setspn -1 servicename to verify that the HTTP service principal names were added to the
service account.

The output for the command should include all the registered service principal names as shown in
the example below:

Registered ServicePrincipalNames for
CN=bo.service, OU=boe, OU=BIP, OU=PG, DC=DOMAIN, DC=com:
HTTP/<ip address of server>
HTTP/servername.DOMAIN.com

HTTP/servername

servername/servicenameDOMAIN. com

The service account has had all the required service principal names added, and the required keytab
file has been created.

For Vintela single sign-on to work, you need to setup the Information platform services servers, edit Bl
launch pad properties, and to copy the keytab file to the appropriate directory.

7.4.3.5 Preparing servers for Vintela single sign-on

Before you perform this task:

You must ensure that the computer on which the Information platform services servers are deployed
has been added to the primary domain and that all the required DNS suffixes have been appended.

You need the keytab file you created for Windows AD authentication with Kerberos.

. Copy the Kerberos keytab file to a location on the computer hosting the Information platform services

Servers.

. Add the Kerberos service account to the Administrator group on the host computer.

Format the account name as DOMAIN NAME\service name.

. Add the Kerberos service account to the following system rights in the Local Security Policy MMC:

Allows a process to impersonate any user with-

Act as part of the Operating system out the need to authenticate

Enables a user to be logged on through a batch-

Log on as a Batch job queue facility

Allows a service account to register a process

Log on as a service )
as a service

Allows an account to call the CreateProcessAs-

Replace a Process Level Token User() API, enabling one service to start another

You must run the Information platform services servers under the service account.

2012-08-15



Authentication

4. Go to Programs > SAP BusinessObjects Bl platform 4 > SAP BusinessObjects Bl platform >
Central Configuration Manager.

In the Central Configuration Manager, right-click the Server Intelligence Agent (SIA) and select Stop.
Right-click the SIA and select Properties.

Clear the System Account check box.

Enter the Kerberos account credentials (DOMATIN NAME\service name)from step 2, and click OK.
Restart the SIA.

© N O

To complete setup of Vintela single sign-on:

* Prepare the web application server and Bl launch pad properties for Vintela single sign-on.

+ Configure the Window AD security plugin to enable Windows AD authentication and Vintela single
sign-on.

7.4.3.6 To enable Vintela single sign-on for Bl launch pad and OpenDocument

This procedure can be used for both the Bl launch pad and OpenDocument web applications. In addition
to specifying Vintela single sign-on settings for the Windows AD security plugin, Vintela settings must
be specified for the BOE.war properties.

1. Access the custom folder for the BOE web application on the machine hosting the web application
server.
If you are using the Tomcat web application server provided with the Information platform services
installation, you can directly access the following folder:

C:\Program Files (x86)\SAP BusinessObjects\Tomcat6\webapps\BOE\WEB-
INF\config\custom\

Tip:

If you are using a web application server that does not enable direct access to the deployed web
applications, you can use the following folder in your product installation to modify the BOE web
application.

<INSTALLDIR>\Information platform services XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\.

You will have to later redeploy the modified BOE web application.

2. Create a new file.

Note:
Use Notepad or any other text-editing utility.

3. Enter the following:

sso.enabled=true
siteminder.enabled=false
vintela.enabled=true
idm.realm=[YOUR_REALM]
idm.princ=[YOUR_PRINCIPAL]
idm.allowUnsecured=true
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9.
10.

idm.allowNTLM=false
idm.logger.name=simple
idm.logger.props=error-log.properties

Note:

The idm.realm and idm.princ parameters require valid values. The idm.realm should be the same

value you set when you configured the default_realm in your krb5. ini file. The value must be in
upper case. The idm.princ parameter is the SPN used to for the service account created for Vintela
single sign-on.

If you have chosen to use a keytab file, add the key pad parameter and specify the path to the file
as shown in the example below:
idm.keytab=C:/WIN/filename.keytab

Skip the following step if you do not want to use constrained delegation for Windows AD authentication
and Vintela single sign-on.

. To use contrained delegation add:

idm.allowS4U=true

. Close the file and save it with a global .properties name:

Note:
Make sure the file name is not saved under any extensions such as . txt.

. Create another file in the same directory. Save the file as OpenDocument .properties or BI

launchpad.properties depending on your requirements.

. Enter the following statement:

authentication.default=secWinAD
cms.default=[enter your cms name]: [Enter the CMS port number]

For example:

authentication.default=secWinAD
cms.default=mycms:6400

Save and close the file.
Restart your web application server.

The new properties will take effect only after the BOE web application is redeployed on the machine
running the web application server. Use WDeploy to redeploy BOE on the web application server. For
more information on using WDeploy to undeploy web applications, see the Information Platform Services
Web Application Deployment Guide.

Note:
If your deployment is using a firewall, remember to open all the required ports otherwise the web
applications will not be able to connect to the Information platform services servers.

Related Topics

* Preparing the application server for Windows AD authentication (Kerberos)

« Sample multiple domain Krb5.ini file
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7.4.3.7 To increase the header size limit of your Java application server

Active Directory creates a Kerberos token which is used in the authentication process. This token is
stored in the HTTP header. Your Java application server will have a default HTTP header size. To avoid
failures, ensure that it has a minimum default size of 16384 bytes. (Some deployments may require a
larger size. For more information, see Microsoft's sizing guidelines on their support site
(http://support.microsoft.com/kb/327825).)

1. On the server with Tomcat installed, open the server.xml file.
On Windows, this file is located at <Tomcat INSTALLDIR>/conf
+ If you are using the version of Tomcat installed with Information platform services on Windows,
and you did not modify the default
installation location, replace <TomcatINSTALLDIR> with C:\Program Files (x86) \SAP
BusinessObjects\Tomcat6\
+ If you are using any other supported web application server, consult the documentation for your
web application server to determine the appropriate path.
2. Find the corresponding <Connector ..> tag for the port number you have configured.
If you are using the default port of 8080, find the <Connector ..>tag with port=8080” in it.
For example:
<Connector URIEncoding="UTF-8" acceptCount="100"
connectionTimeout="20000" debug="0"
disableUploadTimeout="true" enableLookups="false"
maxSpareThreads="75" maxThreads="150"
minSpareThreads="25" port="8080" redirectPort="8443"
/>
3. Add the following value within the <Connector ..>tag:
maxHttpHeaderSize="16384"
For example:
<Connector URIEncoding="UTF-8" acceptCount="100"
connectionTimeout="20000" debug="0"
disableUploadTimeout="true" enableLookups="false"
maxSpareThreads="75" maxThreads="150"
maxHttpHeaderSize="16384" minSpareThreads="25" port="8080" redirectPort="8443" />
4. Save and close the server.xml file.
5. Restart Tomcat.
Note:

For other Java application servers, consult your Java application server’'s documentation.
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7.4.3.8 Configuring Internet hrowsers

To support Kerberos single sign-on, you must configure Information platform services clients. This
involves configuring the Internet Explorer (IE) browser on the client machines.

7.4.3.8.1 To configure Internet Explorer on the client machines

You need to configure the Internet Explorer browser on a Information platform services client machine
to support end-to-end single sign-on. This implementation includes the following tasks:

Configuring client machines for integrated Windows authentication
Adding the URL for Bl launch pad to the list of local intranet sites

Tip:
You can automate the following steps through a registry key. For more details, refer to your Windows
documentation.

1.
2.

On the client machine, open an Internet Explorer browser.
Enable integrated windows authentication.

a.
b.
C.
d.

Go to Tools > Internet Options.

Select the "Advanced" tab.

Navigate to the "Security" settings.

Select Enable integrated windows authentication and click Apply.

. Add the URL for Bl launch pad to the list of local intranet sites.
a.
b.
C.
d.

Go to Tools > Internet Options.

Go to Security > Local intranet > Sites > Advanced.
Type in the URL for Bl launch pad, and click Add.
Click OK twice to close the Internet Options dialog box.

Close the Internet Explorer browser, and then open it again for the changes to take effect.

. Repeat steps 1-4 for every client machine.

7.4.3.8.2 To configure Firefox on the client machines

1.

Modify network.negotiate-auth.delegation-uris

a.

On the client machine open a Firefox browser window.

b. Type about:config in the URL address field. A list of configurable properties appears.
C.
d. Enter the URL that you will use to access Bl launch pad. For example if your Bl launch pad URL

Double-click network.negotiate-auth.delegation-uris to edit the property.

is http://machine.domain.com:8080/BOE/BI, then you will need to enter http://machine. do
main.com.
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Note:
To add more than one URL, separate them with a comma. For example: http://machine. do
main.commachine2.domain.com.

e. Click OK.

2. Modify network.negotiate-auth.trusted-uris

a. On the client machine open a Firefox browser window.

b. Type about:config in the URL address field. A list of configurable properties appears.

c. Double-click network.negotiate-auth.trusted-uris to edit the property.

d. Enter the URL that you will use to access Bl launch pad. For example if your Bl launch pad URL
is http://machine.domain.com:8080/BOE/BI, then you will need to enter http://machine. do
main.com.

Note:
To add more than one URL, separate them with a comma. For example: http://machine. do
main.commachine?.domain.com.

e. Click OK.

3. Close and reopen the Firefox browser window for these changes to take effect.
4. Repeat all of these steps on each Information platform services client machine.

7.4.3.9 To configure constrained delegation for Vintela single sign-on

Constrained delegation is optional for AD authentication and Vintela single sign-on. It is required for
deployment scenarios that involve single sign-on to the system database.
1. On the AD domain controller machine, open the Active Directory "Users and Computers" snap-in.

2. Right-click the service account you created for Vintela single sign-on, and click Properties >
Delegation.

Select Trust this user for delegation to the specified services only.

Select Use Kerberos only.

Click Add > Users or Computers.

Type the service account name (used for Vintela single sign-on) and click OK.
A list of services is displayed.

oo~

7. Select the following services and then click OK.
* The HTTP service

»  The service used to run the Service Intelligence Agent (SIA) on the machine hosting SAP
BusinessObjects Enterprise.

The services are added to the list of services that can be delegated for the (Vintela single sign-on)
account.
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You need to modify the web application properties to account for this modification. Open the BOE
global.properties file on your web application server. Add the following and then restart the web
application server.

idm.allowS4U=true

7.4.3.10 Using Windows AD with SiteMinder

This section explains how to use AD and SiteMinder. SiteMinder is a third-party user access and
authentication tool that you can use with the AD security plug-in to create single sign-on to Information
platform services. You can use SiteMinder with Kerberos.

Ensure your SiteMinder identity management resources are installed and configured before configuring
Windows AD authentication to work with SiteMinder. For more information about SiteMinder and how
to install it, refer to your SiteMinder documentation.

There are two tasks you must complete to enable AD single sign-on with SiteMinder:

» Configure the AD plug-in for single sign-on with SiteMinder
» Configure SiteMinder properties for the BOE web application

Note:

Ensure that the SiteMinder Administrator has enabled support for 4.x Agents. This must be done
regardless of which supported version of SiteMinder you are using. For more information about SiteMinder
configuration, refer to your SiteMinder documentation.

7.4.3.10.1 To modify the BOE properties file for Windows AD authentication with SiteMinder

In addition to specifying SiteMinder settings for the Windows AD security plugin, SiteMinder settings
must be specified for the BOE.war properties.

1. Go to the following directory in your Information platform services installation:

<INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\

2. Create a new file.

Note:

Use Notepad or another text-editing utility.
3. Enter the following statement:

sso.enabled=true
siteminder.authentication=secWinAD
siteminder.enabled=true

4. Save the file with the name global.properties, and close the file.
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7.

Note:
Make sure the file name is not saved with an extension, such as . txt.

Create another file in the same directory.

. Enter the following statement:

authentication.default=secWinAD
cms.default=[CMS name]:[CMS port number]

For example:

authentication.default=LDAP
cms.default=mycms: 6400

Save the file with the name BIlaunchpad.properties, and close the file.

The new properties will take effect only after BOE.war is redeployed on the computer running the web
application server. Use WDeploy to redeploy the WAR file on the web application server. For more
information on using WDeploy to undeploy web applications, see the Information Platform Services
Web Application Deployment Guide.

7.4.3.10.2 To disable SiteMinder

If you want to prevent SiteMinder from being configured, or to disable it after it has been configured in
the CMC, modify the web configuration file for Bl launch pad.

To disable SiteMinder for Java clients

In addition to disabling SiteMinder settings for the Windows AD security plugin, SiteMinder settings
must be disabled for the BOE.war file on your web application server.

1.

4,

Go to the following directory in your Information platform services installation:

<INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps\BOE\WEB-INF\config\custom\

. Open the global.properties file.
. Change siteminder.enabled to false

siteminder.enabled=false

Save your changes and close the file.

The change takes effect only after BOE . war is redeployed on the machine running the web application
server. Use WDeploy to redeploy the WAR file on the web application server. For more information on
using WDeploy to undeploy web applications, see the Information platform services Web Application
Deployment Guide.

7.4.4 Mapping AD groups and configuring AD authentication
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7.4.4.1 To map AD users and groups and configure the Windows AD security
plugin

To configure Windows AD authentication to work with a specific authentication type, first complete all
required preparatory tasks. For information, see “Related Topics” below.

Regardless of which protocol is used, you must complete the following steps to allow AD users to
authenticate. Follow steps 1 to 8 below to import AD groups to Information platform services.

1.
2.
3.

In the "Authentication" management area of the CMC, double-click Windows AD.
Click the Enable Windows Active Directory (AD) check box.

Under "AD Configuration Summary", click the link beside AD Administration Name.
Note:

Before the Windows AD plugin is configured, this link will appear as two double quotes. After the
configuration has been saved, the link with be populated with the AD Administration names.

Enter the name and password of an enabled domain user account, using one of the following formats:
*  NT name: DomainName\UserName

¢ UPN: user@DNS domain name

Information platform services uses this account to query information from AD. It does not modify,
add, or delete content from AD; it only reads information.

Note:
AD authentication will not continue if the AD account used to read the AD directory becomes
invalid—for example, if the account's password is changed or expires or the account is disabled.

Enter information in the Default AD Domain box.

You can map groups from the default domain, without specifying the domain name prefix.

If you enter the Default AD Domain name, users from the default domain do not have to specify

the AD domain name when logging on to Information platform services via AD authentication.

Under "Mapped AD Member Groups", enter the AD domain\group in the Add AD Group

(Domain\Group) box, using one of the following formats:

+  Security Account Manager account name (SAM), also referred to as “NT name” (Domain
Name\GroupName)

* DN (cn=GroupName, ...... , dc=DomainName, dc=com)

Note:

To map a local group, use only the NT name format (\\ ServerName\ GroupName). AD does not
support local users; local users who belong to a mapped local group are not mapped to Information
platform services. Therefore, they are not able to access the system.

. Click Add.
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The group is added to the list.

Note:
To import AD group accounts without configuring AD authentication options or AD group updates,
skip steps 8 to 18.

If you selected Use Kerberos authentication:

To configure single sign-on to a database, select Cache security context.
In the Service principal name box, enter the SPN mapped to the service account.

Note:

To configure Information platform services for Kerberos and AD authentication using Kerberos, you
must have a service account. You can either create a domain account or use an existing domain
account. The service account will be used to run the Information platform services servers. To enable
AD authentication with Vintela single sign-on, you must provide an SPN that is configured for this
purpose.

Tip:
When manually logging on to Bl launch pad, users from other domains must append the domain
name (in uppercase letters) after the user name—for example, user@CHILD.PARENTDOMAIN.COM.

To configure single sign-on, select Enable Single Sign On for selected authentication mode.

To enable single sign-on, you must also configure the BOE web application general properties and
Bl launch pad properties.

Under "Synchronization of Credentials", select an option and update the AD user's data source
credentials at logon time.

This synchronizes the data source with the user's current logon credentials

To configure SiteMinder as the single sign-on option for AD authentication using Kerberos, under
"SiteMinder Options":

Note:
You can configure either Vintela or SiteMinder as the single sign-on option. Clear all entries in the
Service principal name box (step 9b) if you want to configure SiteMinder options.

Click Disabled.

The "Windows AD SiteMinder configuration" page appears. If you have not configured the Windows
AD plug-in, when asked if you want to continue, click OK.

Click Use SiteMinder Single Sign On.

In the Policy Server Host box, type the name of each policy server, and click Add.

For each Policy Server Host, specify the Accounting, Authentication, and Authorization port
numbers.

Enter the name of the Agent Name and the Shared Secret, and enter the Shared Secret again.

Note:

Ensure that the SiteMinder Administrator has enabled support for 4.x Agents. This must be done,
regardless of which supported version of SiteMinder you are using. For information about
SiteMinder and how to install it, see the SiteMinder documentation.

Click Update to save your information and return to the main AD authentication page.



Under "AD Alias Options", specify how to add new aliases to and update aliases in Information
platform services:

Under "New Alias Options", specify how to map new aliases to Enterprise accounts:
Assign each new AD alias to an existing User Account with the same name

Use this option when you know users have an existing Enterprise account with the same
name; that is, AD aliases will be assigned to existing users (auto alias creation is turned on).
Users who do not have an existing Enterprise account or who do not have the same name in
their Enterprise and AD account are added as new users.

Create a new user account for each new AD alias

Use this option to create a new account for each user.

Under "Alias Update Options", specify how to manage alias updates for Enterprise accounts:
Create new aliases when the Alias Update occurs

Use this option to automatically create a new alias for every AD user mapped to Information
platform services. New AD accounts are added for users without Information platform services
accounts—or for all users, if you selected the Create a new account for each new AD alias
option and clicked Update.

Create new aliases only when the user logs on

Use this option when the AD directory you are mapping contains many users, but only a few
of them will use Information platform services. Information platform services does not
automatically create aliases and Enterprise accounts for all users. Instead, it creates aliases
(and accounts, if required) only for users who log on to Information platform services.

If your Information platform services license is based on users roles, under "New User Options",
specify how new users are created:

Bl Viewer User

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license
agreement. Users are restricted to access application workflows that are defined for the BI
Viewer role. Access rights are generally limited to viewing business intelligence documents.
This role is typically suitable for users who consume content through Information platform
services applications.

Bl Analyst User

New user accounts are configured under the Bl Analyst role. Access to Information platform
services applications for all accounts under the Bl Analyst role is defined in the license
agreement. Users can access all applications workflows that are defined for the Bl Analyst
role. Access rights include viewing and modifying business intelligence documents. This role
is typically suitable for users who create and modify content for Information platform services
applications.

If your Information platform services license is not based on users roles, under "New User
Options", specify how new users are created:

New users are created as named users



New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user
name and password. This provides named users with access to the system regardless of how
many other people are connected. You must have a named user license available for each
user account created using this option.

New users are created as concurrent users

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time.
This type of licensing is very flexible because a small concurrent license can support a large
user base. For example, depending on how often and how long users access Information
platform services, a 100-user concurrent license could support 250, 500, or 700 users.

To configure how to schedule AD alias updates:
Click Schedule.
In the "Schedule" dialog box, select a recurrence in the Run object list.
Set schedule options and parameters as needed.
Click Schedule.

When the alias update occurs, the group information is also updated.

Under "Attribute Binding Options", specify the attribute binding priority for the AD plugin:
Click the Import Full Name, Email Address and other attributes box.

The full names and descriptions used in the AD accounts are imported and stored with the user
objects in Information platform services.

Specify an option for Set priority of AD attribute binding relative to other attributes binding.
When this option is set to 1, AD attributes take priority in scenarios where AD and other plugins
(LDAP and SAP) are enabled. When it is set to 3, attributes from other enabled plugins take
priority.

Under "AD Group Options", configure AD group updates:
Click Schedule.
The "Schedule" dialog box appears.
Select a recurrence in the Run object list.

Set the remaining schedule options and parameters as needed.
Click Schedule.

The system schedules and runs the update according to the schedule information you specified.
You can view the next scheduled update for AD group accounts under "AD Group Options".

Under "On-Demand AD Update", select one of the following options:
Update AD Group now
Select this option if you want to update the AD groups. The updates start after you click Update.

Note:
This option affects any scheduled AD group updates. The next scheduled AD group update is
listed under "AD Group Options".
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+  Update AD Groups and Aliases now

Select this option if you want to update the AD group and user aliases. The updates start after
you click Update.

Note:
This option affects any scheduled AD group updates. The next scheduled updates are listed
under "AD Group Options" and "AD Alias Options".

+ Do not update AD Groups and Aliases now

Select this option if you do not want to update AD groups and user aliases. If you click Update,
neither the group nor the user aliases will be updated.

Note:
This option affects any scheduled group or alias updates. The next scheduled updates are listed
under "AD Group Options" and "AD Alias Options".

17. Click Update, and click OK.

Related Topics

» Single sign-on with Windows AD

+ Using Windows AD with SiteMinder

* Using Kerberos authentication for Windows AD

7.4.5 Troubleshooting Windows AD authentication

7.4.5.1 Troubleshooting your Kerberos configuration

These steps may help you if you encounter problems when configuring Kerberos:

* Enabling logging
» Testing your Java SDK Kerberos configuration

7.4.5.1.1 To enable logging
1. From the Start menu, select Programs >Tomcat > Tomcat Configuration
2. Click the Java tab.
3. Add the following options:

-Dcrystal.enterprise.trace.configuration=verbose
—-sun.security.krb5.debug=true
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This will create a log file in the following location:

C:\Documents and Settings\<user name>\.businessobjects\jce verbose.log

7.4.5.1.2 To test your Java Kerberos configuration

* Run the following command to test your Kerberos configuration, where servact is the service
account and domain under which the CMS is running, and password is the password associated
with the service account.

<Install Directory>\SAP BusinessObjects Enterprise XI 4.0\win64 64\jdk\bin\servact@TESTMO03.COM Password

For example:

C:\Program Files\SAP BusinessObjects\SAP Business Objects Enterprise XI 4.0\win64 64\jdk\bin\
servact@TESTM03.COM Password
The domain and service principal name are case-sensitive. If the problem persists, confirm that the
domain and service principal name exactly match the domain and service principal name the Active
Directory.

7.4.5.1.3 Logon failure due to different AD UPN and SAM names

A user's Active Directory ID has successfully been mapped to Information platform services. Despite
this fact, they are unable to successfully log onto the CMC or Bl launch pad with Windows AD
authentication and Kerberos in the following format: DOMATIN\ABC123

This problem can happen when the user is set up in Active Directory with a UPN and SAM name that
are not exactly the same. The following examples may cause a problem:

+  The UPN is abc123@company.com but the SAM name is DOMAIN\ABC123.

*  The UPN is jsmith@company but the SAM name is DOMAIN\johnsmith.

There are two ways to address this problem:

» Have users log in using the UPN name rather than the SAM name.
*  Ensure the SAM account name and the UPN name are the same.

7.4.5.1.4 Pre-authentication error

A user who has previously been able to log on, can no longer log on successfully. The user will receive
this error: Account Information Not Recognized. The Tomcat error logs reveal the following error: "Pre-
authentication information was invalid (24)"

This can occur because the Kerberos user database didn't get a change made to UPN in AD. This may
mean that the Kerberos user database and the AD information are out of sync.

To resolve this problem, reset the user's password in AD. This will ensure the changes are propagated
correctly.

Note:
This problem is not an issue with J2SE 5.0.
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7.5 SAP authentication

7.5.1 Configuring SAP authentication

This section explains how to configure Information platform services authentication for your SAP
environment.

SAP authentication enables SAP users to log on to Information platform services using their SAP user
names and passwords, without storing these passwords in Information platform services. SAP
authentication also allows you to preserve information about user roles in SAP, and to use this role
information within Information platform services to assign rights to perform administrative tasks, or
access content.

Accessing the SAP authentication application

You must provide Information platform services with information about your SAP system. Information
platform services installs a web application to assist you. This web application is accessible through
the main Information platform services administration tool, the Central Management Console (CMC).
To access it from the home page of the CMC, click Authentication.

Authenticating SAP users

Security plug-ins expand and customize the ways in which Information platform services authenticates
users. The SAP Authentication feature includes an SAP security plug-in (secSAPR3.d11) for the Central
Management Server (CMS) component of Information platform services. This SAP security plug-in
offers several key benefits:

+ Itacts as an authentication provider that verifies user credentials against your SAP system on behalf
of the CMS. When users log on to Information platform services directly, they can choose SAP
Authentication and provide their usual SAP user name and password. Information platform services
can also validate Enterprise Portal logon tickets against SAP systems.

-+ ltfacilitates account creation by allowing you to map roles from SAP to Information platform services
user groups, and it facilitates account management by allowing you to assign rights to users and
groups in a consistent manner within Information platform services.

+ It dynamically maintains SAP role listings. So, once you map an SAP role to Information platform
services, all users who belong to that role can log on to Information platform services. When you
make subsequent changes to the SAP role membership, you need not update or refresh the listing
in Information platform services.

»  The SAP Authentication component includes a web application for configuring the plug-in. You can
access this application in the "Authentication" area of the Central Management Console (CMC).
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1.5.2 Creating a user account for Information platform services

The Information platform services system requires an SAP user account that is authorized to access
SAP role membership lists and authenticate SAP. You will need the account credentials to connect
Information platform services to your SAP system. For general instruction on creating SAP user accounts
and assigning authorizations through roles, see your SAP BW documentation.

Use transaction su01 to create a new SAP user account named CRYSTAL. Use transaction PFCG to
create a new role named CRYSTAL ENTITLEMENT. (These names are recommended but not required.)
Change the new role's authorization data by setting these values for the following authorization objects:

Authorization ohject Field Value
Activity (ACTVT) Read, Write (33, 34)
Authorization for file access Physical file name (FILENAME) | * (denotes All)

(S_DATASET)

ABAP program name (PRO- .
GRAM)

Activity (ACTVT) 16

BDCH, STPA, SUSO, BDLS5,
SUUS, SU_USER, SYST, SUNI,

Name of RFC to be protected RFC1, SDIFRUNTIME,

Authorization Check for RFC

Access (S_RFC) (RFC_NAME) PRGN_J2EE, /CRYSTAL/SECU-
RITY
Type of RFC object to be protect- Function group (FUGR)

ed (RFC_TYPE)
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Authorization object Field Value
Activity (ACTVT) Create or Generate, and Display
(03)
User Master Maintenance: User
Groups (S_USER_GRP) Note: _
User group in user master For greater security, you may
maintenance (CLASS) prefer to explicitly list the user
groups whose members require
access to Information platform
services.

Finally, add the CRYSTAL user to the CRYSTAL ENTITLEMENT role.

Tip:
If your system policies require users to change their passwords when they first log on to the system,
log on now with the CRYSTAL user account and reset its password.

7.5.3 Connecting to SAP entitlement systems

Before you can import roles or publish BW content to Information platform services, you must provide
information about the SAP entitlement systems to which you want to integrate. Information platform
services uses this information to connect to the target SAP system when it determines role memberships
and authenticates SAP users.

7.5.3.1 To add an SAP entitlement system

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link.

The entitlement systems settings appear.

Tip:
If an entitlement system is already displayed in the Logical system name list, click New.

3. In the System field, type the three-character System ID (SID) of your SAP system.
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9.

In the Client field, type the client number that Information platform services must use when it logs
on to your SAP system.

Information platform services combines your System and Client information, and adds an entry to
the Logical system name list.

Ensure the Disabled check box is clear.

Note:
Use the Disabled check box to indicate to Information platform services that a particular SAP system
is temporarily unavailable.

Complete the Message Server and Logon Group fields as appropriate, if you have set up load
balancing such that Information platform services must log on through a message server .

Note:

You must make the appropriate entries in the Services file on your Information platform services
machine to enable load balancing - especially if your deployment not on a single machine. Specifically
you should account for the machines hosting the CMS, the Web application server, as well as all
machines managing your authentication accounts and settings.

If you have not set up load balancing (or if you prefer to have Information platform services log on
directly to the SAP system), complete the Application Server and System Number fields as
appropriate.

In the User name, Password, and Language fields, type the user name, password, and language
code for the SAP account that you want Information platform services to use when it logs on to SAP.

Note:
These credentials must correspond to the user account that you created for Information platform
services.

Click Update.

If you add multiple entitlement systems, click the Options tab to specify the system that Information
platform services uses as the default (that is, the system that is contacted to authenticate users who
attempt to log on with SAP credentials but without specifying a particular SAP system).

Related Topics

* To create a user account

7.5.3.2 To verify if your entitiement system was added correctly

1.
2,

Click the Role Import tab.
Select the name of the entitlement system from the Logical system name list.

If the entitlement system was added correctly, the Available roles list will contain a list of roles that
you can choose to import.
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Tip:
If no roles are visible in the Logical system name list, look for error messages on the page. These
may give you the information you need to correct the problem.

7.5.3.3 To temporarily disable a connection to an SAP entitlement system

In the CMC, you can temporarily disable a connection between Information platform services and an
SAP entitlement system. This may be useful to maintain the responsiveness of Information platform
services in cases such as the scheduled down time of an SAP entitlement system.

1. In the CMC, go to the Authorization management area.

Double-click the SAP link.

In the Logical system name list, select the system you want to disable.
Select the Disabled check box.

Click Update.

A ol

1.5.4 Setting SAP Authentication options

SAP Authentication includes a number of options that you can specify when integrating Information
platform services with your SAP system. The options include:

+ Enabling or disabling SAP authentication

+ Specifying connection settings

+ Linking imported users to Information platform services license models.
+ Configuring single sign-on to the SAP system

7.5.4.1 To set SAP Authentication options

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link, and click the Options tab.
3. Review and modify settings as required.
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Setting
Enable SAP Authentication

Description

Clear this check box if you want to disable SAP
Authentication. To disable SAP Authentication for
a specific SAP system, select the system's Disabled
check box on the Entitlement Systems tab.)

Content folder root

Specify where you want Information platform ser-
vices to begin replicating the BW folder structure in
the CMC and Bl launch pad. The default is
/SAP/2 .0 but you can change it to a different
folder. To change this value, you must change it in
the CMC and in Content Administration Workbench.

Default system

Select the SAP entitlement system that Information
platform services uses as the default (that is, the
system that is contacted to authenticate users who
attempt to log on with SAP credentials but without
specifying a particular SAP system).

Note:

If you designate a default system, users from that
system do not have to enter their System ID and
client when they connect from client tools like Live
Office or Universe Designer using SAP authentica-
tion. For example, if SYS~100 is set as the default
system, SYS~100/user1 would be able to log on as
user1 when SAP authentication is chosen.

Max. number of failed attempts to access
entitlement system

Type the number of times that Information platform
services should re-attempt contacting an SAP sys-
tem to fulfill authentication requests. Setting the
value to —1 allows Information platform services to
attempt to contact the entitlement system an unlim-
ited number of times. Setting the value to 0 limits
Information platform services to making one attempt
to contact the entitlement system.

Note:

Use this setting together with Keep entitlement
system disabled [seconds] to configure how Infor-
mation platform services handles SAP entitlement
systems that are temporarily unavailable. Informa-
tion platform services uses these settings to deter-
mine when to stop communicating with an SAP
system that is unavailable, and when it should re-
sume communication with that system.
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Setting
Keep entitlement system disabled [sec-
onds]

Description

Type the number of seconds that Information plat-
form services should wait before resuming attempts
to authenticate users against the SAP system. For
example, if you type 3 for Max failed entitlement
system accesses, Information platform services

allows a maximum of 3 failed attempts to authenti-
cate users against any particular SAP system; the
fourth failed attempt results in Information platform
services ceasing its attempts to authenticate users
against that system for the amount of time specified.

Max. concurrent connections per system

Specify how many connections you want to keep
open to your SAP system at the same time. For
example, if you type 2 in this field, Information plat-
form services keeps two separate connections open
to SAP.

Number of uses per connection

Specify how many operations you want to allow to
the SAP system per connection. For example, if you
specified 2 for Max concurrent connections per
system and 3 for Number of uses per connection,
once there have been three logons on one connec-
tion, Information platform services closes that con-
nection and restart it.

Bl Viewer and Bl Analyst

Specify whether new user accounts are configured
under either the Bl Viewer or Bl Analyst user roles.
The Bl Viewer role is typically assigned to users
who are content consumers. This role has restricted
access to application workflows as stipulated in the
Information platform services license agreement.
The BI Analyst role is for users who create and
modify content for Information platform services
applications. This role does not have restricted ac-
cess to application workflows.

Note:

The option you select here does not change the
number or type of user licenses that you have in-
stalled in Information platform services. You must
have the appropriate licenses available on your
system.
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Concurrent users and Named Users . )
Specify whether new user accounts are configured

to use concurrent user licenses or named user li-
censes. Concurrent licenses specify the number of
people who can connect to Information platform
services at the same time. This type of licensing is
very flexible because a small number of concurrent
licenses can support a large user base. For exam-
ple, depending on how often and how long users
access Information platform services, a 100 user
concurrent license could support 250, 500, or 700
users. Named user licenses are associated with
specific users and allow people to access the sys-
tem based on their user name and password. This
provides named users with access to the system
regardless of how many other people are connect-
ed.

Note:

The option you select here does not change the
number or type of user licenses that you have in-
stalled in Information platform services. You must
have the appropriate licenses available on your
system.

Import Full Name, Email Address and other

attributes Select this option if you want to specify a priority

level for the SAP authentication plugin. The full
names and descriptions used in the SAP accounts
are imported and stored with the user objects in In-
formation platform services.

Set priority of SAP attribute binding relative

to other attributes binding Specifies a priority for binding SAP user attributes

(full name and email address). If the option is set
to 1, SAP attributes take priority in scenarios where
SAP and other plugins (Windows AD and LDAP)
are enabled. If the option is set to 3, attributes from
other enabled plugins take priority.

Use the following options to configure the SAP single sign-on service:
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4,

System ID The system identifier provided by Information platform services to the SAP

system when performing the SAP single sign-on service.

Browse Use this button to upload the key store file generated to enable the SAP

single sign-on. You can also manually enter the full path to the file in the field
provided.

Key Store Pass-

word Provide the password required to access the key store file.

Private Key Pass-

word Provide the password required to access the certificate corresponding to the

key store file. The certificate is stored on the SAP system.

Private Key Alias Provide the alias required to access the key store file.

Click Update.

Related Topics
* Role-based licensing

 Configuring SAP authentication

7.5.4.2 To change the Content folder root

. Go to the "Authentication” management area of the CMC.
. Double-click the SAP link.
. Click Options and type the name of the folder in Content folder root field.

The folder name that you type here is the folder that you want Information platform services to begin
replicating the BW folder structure from.

Click Update.
In the BW Content Administration Workbench, expand Enterprise system.

. Expand Available systems and double-click the system that your Information platform services is

connecting to.

. Click the Layout tab and in the Content base folder, type the folder that you want to use as the

root SAP folder in Information platform services (for example, /SAP/2.0/).
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7.5.5 Importing SAP roles

By importing SAP roles into Information platform services, you allow role members to log on to Information
platform services with their usual SAP credentials. In addition, single sign-on is enabled so that SAP
users are logged on to Information platform services automatically when they access reports from within
the SAP GUI or an SAP Enterprise Portal.

Note:
There are often many requirements for enabling SSO. Some of these might include using a driver and
application that are SSO-capable, and ensuring your server and web server are in the same domain.

For each role that you import, Information platform services generates a group. Each group is named
with the following convention: SystemID~C1ientNumber@NameOfRole . You can view the new
groups in the "Users and Groups" management area of the CMC. You can also use these groups to
define object security within Information platform services.

Consider three main categories of users when configuring Information platform services for publishing,
and when importing roles to Information platform services:

+ Information platform services administrators

Enterprise administrators configure the Information platform services system for publishing content
from SAP. They import the appropriate roles, create necessary folders, and assign rights to those
roles and folders in Information platform services.

»  Content publishers

Content publishers are those users who have rights to publish content into roles. The purpose of
this category of user is to separate regular role members from those users with rights to publish
reports.

*  Role members

Role members are users who belong to “content bearing” roles. That is, these users belong to roles
to which reports are published. They have View, View on Demand, and Schedule rights for any
reports published to the roles they are members of. However, regular role members cannot publish
new content, nor can they publish updated versions of content.

You must import all content publishing and all content bearing roles to Information platform services
prior to publishing for the first time.

Note:

It is strongly recommended that you keep the activities of roles distinct. For example, while it is possible
to publish from an administrator role, it is better practice to publish only from content publisher roles.
Additionally, the function of content publishing roles is only to define which users can publish content.
Thus, content publishing roles should not contain any content; content publishers should publish to
content bearing roles that are accessible to regular role members.
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Related Topics
* How rights work in Information platform services
* Managing security settings for objects in the CMC

7.5.5.1 To import SAP roles

. Go to the "Authentication” management area of the CMC.
. Double-click the SAP link.
. On the Options tab, select Bl Viewer, Bl Analyst, Concurrent users, or Named users depending

on your license agreement.

Note that the option you select here does not change the number or type of user licenses that you
have installed in Information platform services. You must have the appropriate licenses available
on your system.

Click Update.

. On the Role Import tab, select the appropriate entitlement system in the Logical system name

list.
In the "Available roles" area, select the role(s) that you want to import and click Add.

. Click Update.

7.5.5.2 To verify that roles and users were imported correctly

Before starting this task, you must know the user name and password of an SAP user who belongs to
a role you mapped to Information platform services.

1.

For Java Bl launch pad, go to http://webServer: PortNumber/BOE/BI.

Replace webserver with the name of the web server and portnumber with the port number that
is set up for Information platform services. You may need to ask your administrator for the name of
the web server, the port number, or the URL to enter.

In the Authentication Type list, select SAP.

By default, the Authentication Type list is hidden in Bl launch pad. The administrator must enable
it in the BIlaunchpad.properties file and then restart the app server.

. Enter the SAP system and the system client that you want to log on to.

Enter the user name and the password of a mapped user.

. Click Log On.

You are logged on to Bl launch pad as the selected user.
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7.5.5.3 Updating SAP roles and users

After enabling SAP authentication, it is necessary to schedule and run regular updates on mapped roles
that have been imported into Information platform services. This will ensure that your SAP role information
is accurately reflected in Information platform services.

There are two options for running and scheduling updates for SAP roles:

Update roles only: using this option will only update the links between the currently mapped roles
that have been imported in Information platform services. It is recommended that you use this option
if you expect to run frequent updates, and you have concerns over system resource usage. No new
user accounts will be created if you only update SAP roles.

Update roles and aliases: this option not only updates links between roles but will also create new
user accounts in Information platform services for user aliases added to roles in the SAP system.

Note:
If you have not specified to automatically create user aliases for updates when you enabled SAP
authentication, no accounts will be created for new aliases.

7.5.5.3.1 To schedule updates for SAP roles

After you map roles in Information platform services, you must specify how the system updates the
roles.

1.
2,

Click the User Update tab.
Click Schedule under either "Update Roles Only" or "Update Roles and Aliases".

Tip:

To immediately run an update, click Update Now.

Tip:

Select Update Roles Only if you want frequent updates or have concerns about system resources.
It takes the system longer to update both roles and aliases.

The "Recurrence" dialog box appears.

. Select an option in the Run Object list, and enter scheduling information.

You can choose the following recurrence patterns:

The update will be run every hour. You specify at what time it

Hourly will start, as well as a start and end date.

The update will be run every day or run every number of spec-
Daily ified days. You can specify at what time it will run, as well as a
start and end date.
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The update will be run every week. It can be run once a week

Weekly or several times a week. You can specify on which days and
at what time it will run, as well as and a start and end date.
Monthly The update will be run every month or every several months.

You can what time it will run, as well as a start and end date.

Nth Day of Month

The update will run on a specific day in the month. You can
specify on which day of the month, what time it will run, as well
as a start and end date.

1st Monday of Month

The update will run on the first Monday of each month. You
can specify what time it will run, as well as and a start and end
date.

Last Day of Month

The update will run on the last day of each month. You can
specify what time it will run, as well as and a start and end date.

The update will run on a specified day of a specified week of

X Day of Nth Week of the the month. You can specify what time it will run, as well as and
Month

a start and end date.

The update will be run on the dates specified in a calendar that
Calendar

has previously been created.

4. Click Schedule.

The date of the next scheduled role update appears on the User Update tab.

Note:

To cancel the next scheduled update, click Cancel Scheduled Updates in the "Update Roles Only"
area or the "Update Roles and Aliases" area.

1.5.6 Setting up single sign-on to the SAP system

To enable single sign-on to the SAP system, you need to create a keystore file and a corresponding
certificate. Use the keytool command line program to generate the file and the certificate. By default
the keytool program is installed in the sdk/bin directory for each platform.

The certificate needs to be added to your SAP ABAP BW system, and Information platform services

using the CMC.
Note:

The SAP authentication plugin must configured before you can set up single sign-on to the SAP database.
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7.5.6.1 To generate the keystore file

The PKCS12Tool program is used to generate keystore files and certificates that are required for setting
up single sign-on to the SAP database. The following table lists the default locations for the
PKCS12Tool.jar for each supported platform:

Platform Default location

Windows <INSTALLDIR>\SAP BusinessObjects Enterprise XI
4.0\java\lib

Unix sap_bobj/enterprise xid40/java/lib

1. Launch a command prompt and navigate to the directory where the PKCS12Tool program is located

2,

To generate the keystore file with default settings run the following command:
java -jar PKCS12Tool.jar

The files cert.der and keystore.pl2 are generated in the same directory. The files contain the
following default values:

Parameter Default

-keystore keystore.p12
-alias myalias
-storepass 123456
-dname CN=CA
-validity 365
-cert cert.der

Tip:

To override the default values, run the tool together with the -2 parameter. The following message
is displayed:

Usage: PKCS12Tool <options>
-keystore <filename (keystore.pl2)>
-alias <key entry alias(myalias)>
-storepass <keystore password(123456)>
—-dname <certificate subject DN (CN=CA) >
-validity <number of days(365)>
-cert <filename (cert.der)>
(No certificate is generated when importing a keystore)
-disablefips
-importkeystore <filename>

You can use the parameters to override the default values.
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7.5.6.2 To export the public key certificate

You need to create and export a certificate for the keystore file.

1. Launch a command prompt and navigate to the directory where the keytool program is located
2. To export a key certificate for the keystore file use the following command:

keytool -exportcert -keystore <keystore> -storetype pkcsl2 -file <filename>
-alias <alias>

Replace <keystore> with the name of the keystore file.

Replace <filename> with the name of the certificate.

Replace <alias> with the alias used to create the keystore file.

3. When prompted, enter the password you provided for the keystore file.

You now have a keystore file and a certificate in the directory where the keytool program is located.

7.5.6.3 Importing the certificate file into the target ABAP SAP system

You need a key store file and an associated certificate for your Information platform services deployment
to perform the following task.

Note:
This action can only be performed on an ABAP SAP system.

1. Connect to your SAP ABAP BW system using the SAP GUI.
Note:
You should connect as a user with administrative privileges.

2. Execute STRUSTSSO?2 in the SAP GUI.
The system is prepared for importing the certificate file.
Go to the Certificate tab.
Ensure the Use Binary option box is selected.
Click the file path button to point to the location where the certificate file is located.
Click the green check mark.
The certificate file is uploaded.
7. Click Add to Certificate List.
The certificate is displayed in the Certificate List.

o gk w
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8. Click Add to ACL and the specify a SystemID and Client.

The system ID must be the same used to identify the Information platform services system to SAP
BW.

The certificate is added to the Access Control List (ACL). The client should be specified as “000”.

9. Save your setting and exit.
The changes are saved in the SAP system.

7.5.6.4 To set up single sign-on to the SAP database in the CNIC

To perform the following procedure you need to access the SAP security plugin using an administrator
account.

1. Go to the "Authentication" management area of the CMC.

2. Double-click the SAP link and then click the Options tab.
If no certificate has been imported the following message should be displayed in the "SAP SSO
Service" section:
No key store file has been uploaded

3. Specify System ID for your Information platform services system in the field provided.
This should be identical to the value used when importing the certificate in the target SAP ABAP
system.

4. Click the Browse button to point to the key store file.

5. Provide the following required details:

Field ‘ Required information

"Key Store Pass- |Provide the password required to access the key store file. This password was
word" specified when creating the key store file.

"Private Key Pass- | Provide the password required to access the certificate corresponding to the
word" key store file. This password was specified when creating the certificate for
the key store file.

"Private Key Alias" | Provide the alias required to access the key store file. This alias was specified
when creating the key store file.

6. Click Update to submit your settings.

Once the settings are submitted successfully, the following message is displayed under the SystemID
field:
Key store file have been uploaded
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7.5.6.5 To add Security Token Service to the Adaptive Processing Server

In a clustered environment, the Security Token Services added separately to each Adaptive Processing
Server.

1. In the "Servers" management area of the CMC, double-click Core Services.
A list of servers appears under "Core Services".

2. Right-click the Adaptive Processing Server and click Stop Server.
Do not proceed until the server state is marked as "Stopped".

3. Right-click the Adaptive Processing Server and click Select Services.
The "Select Services" dialog box appears.

4. Using the add button, move Security Token Service from the Available services list on the left
to the Services list on the right.

5. Click OK.
6. Restart the Adaptive Processing Server.

7.6 PeopleSoft authentication

7.6.1 Overview

To use your PeopleSoft Enterprise data with Information platform services , you must provide the
program with information about your deployment. This information allows Information platform services
to authenticate users so that they can use their PeopleSoft credentials to log on to the program.

7.6.2 Enahling PeopleSoft Enterprise authentication

To allow PeopleSoft Enterprise information to be used by Information platform services, Information
platform services needs information on how to authenticate into your PeopleSoft Enterprise system.
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7.6.2.1 To enahle PeopleSoft Enterprise authentication in Information platform
services

1. Log on as an administrator to the Central Management Console.

2. From the Manage area, click Authentication.

3. Double-click PeopleSoft Enterprise.
The "PeopleSoft Enterprise" page appears. It has four tabs: Options, Domains, Roles, and User
Update.

4. On the Options tab, select the Enable PeopleSoft Enterprise Authentication check box.

5. Make appropriate changes under New Alias, Update Options, and New User Options according
to your Information platform services deployment. Click Update to save your changes before
proceeding to the Systems tab.

6. Click the Servers tab.

7. In the "PeopleSoft Enterprise System User" area, type a database User name and Password for
Information platform services to use to log on to your PeopleSoft Enterprise database.

8. In the "PeopleSoft Enterprise Domain" area, enter the Domain name and QAS address used to
connect to your PeopleSoft Enterprise environment, and click Add.

Note:
If you have multiple PeopleSoft domains, repeat this step for any additional domains you want to
have access to. The first domain you enter will become the default domain.

9. Click Update to save your changes.

7.6.3 Mapping PeopleSoft roles to Information platform services

Information platform services automatically creates a group for each PeopleSoft role that you map. As
well, the program creates aliases to represent the members of the mapped PeopleSoft roles.

You can create a user account for each alias that is created.

However, if you run multiple systems, and your users have accounts in more than one of the systems,
then you can assign each user to an alias with the same name before you create the accounts in
Information platform services.

Doing so reduces the number of accounts that are created for the same user in Information platform
services.

For example, if you run PeopleSoft HR 8.3 and PeopleSoft Financials 8.4, and 30 of your users have
access to both systems, then only 30 accounts are created for those users. If you choose not to assign
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each user to an alias with the same name, then 60 accounts are created for the 30 users in Information
platform services.

However, if you run multiple systems, and user names overlap, then you must create a new member
account for each alias that is created.

For example, if you run PeopleSoft HR 8.3 with a user account for Russell Aquino (user name "raquino”),
and you run PeopleSoft Financials 8.4 with a user account for Raoul Aquino (user name "raquino"),
then you need to create a separate account for each user's alias. Otherwise, the two users are added
to the same Information platform services account; they will be able to log in to Information platform
services with their own PeopleSoft credentials and have access to data from both PeopleSoft systems.

7.6.3.1 To map a PeopleSoft role to Information platform services

Log on as an administrator to the Central Management Console.
Click Authentication.
Double-click PeopleSoft Enterprise for PeopleTools.

From the Roles tab, in the PeopleSoft Enterprise Domains area, select the domain associated with
the role you want to map to Information platform services.

5. Use one of the following options to select the roles you want to map:

+ In the PeopleSoft Enterprise Roles area, in the Search roles text box, enter the role you want to
locate and map to Information platform services, and then click >.

» From the "Available Roles" list box, select the role you want to map to Information platform
services and click >

Note:

PoObd-=

» When searching for a particular user or role, you can use the wild card %. For example, to search
for all roles beginning with "A," type A%. Search is also case sensitive.

+ If you want to map a role from another domain, you must select the new domain from the list of
available domains to match a role from a different domain.

6. To enforce group and user synchronization between Information platform services and PeopleSoft,
check the Force user synchronization check box. To remove already imported PeopleSoft groups
from Information platform services , leave the Force user synchronization check box unchecked.

7. In the "New Alias Options" area, select one of the following options:
- Assign each added alias to an account with the same name

Select this option if you run multiple PeopleSoft Enterprise systems with users who have accounts
on more than one system (and no two users have the same user name for different systems).

+ Create a new account for every added alias

Select this option if you run only one PeopleSoft Enterprise , if the majority of your users have
accounts on only one of your systems, or if the user names overlap for different users on two or
more of your systems.
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In the Update Options area, select one of the following options:
New aliases will be added and new users will be created

Select this option to create a new alias for every user that is mapped to Information platform
services. New accounts are added for users without Information platform services accounts or
for all users if you selected the Create a new account for every added alias option.

No new aliases will be added and new users will not be created

Select this option if the role that you want to map contains many users, but only a few of them
will use Information platform services. Enterprise does not automatically create aliases and
accounts for the users. Instead, it creates aliases (and accounts, if required) only for users when
they log on to Information platform services for the first time. This is the default option.

In the New User Options area specify how new users are created.
If your Information platform services license is based on users roles, select one of the following
options:

New users are created as Bl Viewer

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license agreement.
Users are restricted to access application workflows that are defined for the Bl Viewer role.
Access rights are generally limited to viewing business intelligence documents. This role is
typically suitable for users who consume content through Information platform services
applications.

New users are created as Bl Analyst New user accounts are configured under the Bl Analyst
role. Access to Information platform services applications for all accounts under the Bl Analyst
role is defined in the license agreement. Users can access all applications workflows that are
defined for the Bl Analyst role. Access rights include viewing and modifying business intelligence
documents. This role is typically suitable for users who create and modify content for Information
platform services applications.

If your Information platform services license is not based on users roles, select one of the following
options:

New users are created as named users.

New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user name
and password. This provides named users with access to the system regardless of how many
other people are connected. You must have a named user license available for each user account
created using this option.

New users are created as concurrent users.

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time. This
type of licensing is very flexible because a small concurrent license can support a large user
base. For example, depending on how often and how long users access Information platform
services, a 100 user concurrent license could support 250, 500, or 700 users.

The roles that you selected now appear as groups in Information platform services.
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7.6.3.2 Remapping consideration

If you add users to a role that has already been mapped to Information platform services, you need to
remap the role to add the users to Information platform services. When you remap the role, the option
to map users as either named users or concurrent users affects only the new users that you added to
the role.

For example, you first map a role to Information platform services with the "New users are created as
named users" option selected. Later, you add users to the same role and remap the role with the "New
users are created as concurrent users" option selected.

In this situation, only the new users in the role are mapped to Information platform services as concurrent
users; the users that were already mapped remain named users. The same condition applies if you
first map users as concurrent users, and then you change the settings to remap new users as named
users.

7.6.3.3 To unmap a role

Log on as an administrator to the Central Management Console.
Click Authentication.

Click PeopleSoft Enterprise.

Click Roles.

Select the role that you want to remove, and click <.

Click Update.

Members of the role will no longer be able to access Information platform services, unless they have
other accounts or aliases.

o gk wbd-=

Note:
You can also delete individual accounts or remove users from roles before you map them to
Information platform services to prevent specific users from logging on.

7.6.4 Scheduling user updates

To ensure changes to your user data for your ERP system are reflected in your Information platform
services user data, you can schedule regular user updates. These updates will automatically synchronize
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your ERP and Information platform services users according to the mapping settings you have configured
in the Central Management Console (CMC).

There are two options for running and scheduling updates for imported roles:

Update roles only: using this option will update only the links between the currently mapped roles
that have been imported in Information platform services. Use this option if you expect to run frequent
updates, and you are concerned about system resource usage. No new user accounts will be created
if you only update roles.

Update roles and aliases: this option not only updates links between roles but will also create new
user accounts in Information platform services for new user aliases added to the ERP system.

Note:
If you have not specified to automatically create user aliases for updates when you enabled
authentication, no accounts will be created for new aliases.

7.6.4.1 To schedule user updates

After you map roles into Information platform services, you need to specify how the system updates
these roles.

1.
2,

Click the User Update tab.
Click Schedule in either the "Update Roles Only" or "Update Roles and Aliases" sections.

Tip:

If you want to run an update immediately click Update Now.

Tip:

Use the "Update Roles Only" option if you would like frequent updates and are concerned about
system resources. It takes the system longer to update both roles and aliases.

The "Recurrence" dialog box is displayed.

. Select an option from the "Run Object" list and provide all the requested scheduling information.

When scheduling an update, you can choose from the recurrence patterns summarized in the
following table:

The update will run every hour. You specify at what time it will

Hourly start, as well as a start and end date.

The update will run every day or run every number of specified
Daily days. You can specify at what time it will run, as well as a start
and end date.
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The update will run every week. It can be run once a week or
Weekly several times a week. You can specify on which days and at
what time it will run, as well as a start and end date.

The update will run every month or every several months. You

Monthly can what time it will run, as well as a start and end date.

The update will run on a specific day in the month. You can
Nth Day of Month specify on which day of the month, what time it will run, as well
as a start and end date.

The update will run on the first Monday of each month. You

1st Monday of Month can specify what time it will run, as well as a start and end date.

The update will run on the last day of each month. You can

Last Day of Month specify what time it will run, as well as a start and end date.

The update will run on a specified day of a specified week of
X Day of Nth Week of the Month | the month. You can specify what time it will run, as well as a
start and end date.

The update will run on the dates specified in a calendar that

Calendar has previously been created.

4. Click Schedule after you have finished providing the scheduling information.
The date of the next scheduled role update is displayed in the User Update tab.

Note:
You can always cancel the next scheduled update by clicking Cancel Scheduled Updates in either
the "Update Roles Only" or "Update Roles and Aliases" sections.

7.6.5 Using the PeopleSoft Security Bridge

The Security Bridge feature of Information platform services allows you to import PeopleSoft EPM
security settings to Information platform services.

The Security Bridge operates in two modes:

» Configuration mode

In configuration mode, the Security Bridge provides an interface that enables you to create a response
file. This response file is what governs the behavior of the Security Bridge during execution mode.

+ Execution mode
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Based on the parameters that you define in the response file, the Security Bridge imports the security
settings of dimension tables in PeopleSoft EPM to universes in Information platform services.

7.6.5.1 Importing security settings

To import the security settings, you must do the following tasks in order:

- Define the objects that the Security Bridge will manage.
+ Create a response file.

*  Run the Security Bridge application.

For information about managing security after you import the settings, see the Managing security settings
section.

7.6.5.1.1 Defining managed objects

Before you run the Security Bridge, it is important to determine the objects that are managed by the
application. The Security Bridge manages one or more PeopleSoft roles, an Information platform services
group, and one or more universes.

+  Managed PeopleSoft roles

These are roles in your PeopleSoft system. Members of these roles work with PeopleSoft data
through PeopleSoft EPM. You must choose the roles that include the members for whom you want
to provide/update access privileges to the managed universes in Information platform services.

The access rights that are defined for the members of these roles are based on their rights in
PeopleSoft EPM; the Security Bridge imports these security settings to Information platform services.

+ Managed Information platform services group

When you run the Security Bridge, the program creates a user in Information platform services for
each member of a managed PeopleSoft role.

The group in which the users are created is the managed Information platform services group.
Members of this group are the users whose access rights to the managed universes are maintained
by the Security Bridge. Because the users are created in one group, you can configure the Security
Bridge not to update the security settings for certain users simply by removing users from the
managed Information platform services group.

Before you run the Security Bridge, you must choose a group in Information platform services to be
the location where the users are created. If you specify a group that does not exist, the Security
Bridge will create the group in Information platform services.

* Managed universes

Managed universes are the universes to which the Security Bridge imports security settings from
PeopleSoft EPM. From the universes that are stored in your Information platform services system,
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you must choose which ones are to be managed by the Security Bridge. Members of managed
PeopleSoft roles who are also members of the managed Information platform services group cannot
access any data through these universes that they cannot access from PeopleSoft EPM.

7.6.5.1.2 To create a response file

1. Go to the folder that you specified during the installation of the Security Bridge, and run the
crpsepmsecuritybridge.bat (in Windows) and crpsepmsecuritybridge.sh (in Unix)

file.
Note:

In Windows, by default, this location is C:\Program Files\Business Objects\BusinessObjects 12.0

Integration Kit for PeopleSoft\epm

The Security Bridge for PeopleSoft EPM dialog box appears.

2. Select New to create a response file, or select Open and click Browse to specify a response file
that you want to modify. Select the language you want for the file.

3. Click Next >>.

4. Provide the locations of the PeopleSoft EPM SDK and the Information platform services SDK.

*  The PeopleSoft EPM SDK is typically located on the PeopleSoft server at

<PS_HOME>/class/com.peoplesoft.epm.pf.jar.

The SAP BusinessObjects Enterprise SDK is typically located at <INSTALLDIR>\SAP
BusinsessObjects Enterprise XI 4.0\javallib.

5. Click Next >>.

The dialog box prompts you for connection and driver information for the PeopleSoft database.

6. From the Database list, select the appropriate database type, and provide the information for the

following fields:

Database The name of the PeopleSoft database.
Host The name of the server that hosts the database.
Port number The port number for accessing the server.

Class location

The location of the class files for the database
driver.

User name

Your user name.
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Password Your password.

7. Click Next >>.

The dialog box displays a list of all the classes that the Security Bridge will use to run. If necessary,
you can add to or remove classes from the list.

8. Click Next >>.

The dialog box prompts you for connection information for Information platform services.

9. Provide the appropriate information for the following fields:

Server The name of the server when:e the Central
Management Server (CMS) is located.

User name Your user name.

Password Your password.

Authentication Your authentication type.

10. Click Next >>.
11. Choose an Information platform services group, and click Next >>.

Note:

« The group that you specify in this field is where the Security Bridge creates users for the members
of the managed PeopleSoft roles.

= If you specify a group that does not already exist, it will be created by the Security Bridge.

The dialog box displays a list of roles from your PeopleSoft system.

12. Select the Imported option for the roles that you want the Security Bridge to manage, and click Next
>>,

Note:
The Security Bridge creates a user in the managed Information platform services group (which you
specified in the previous step) for each member of the role(s) that you select.

The dialog box displays a list of universes in Information platform services .
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13. Select the universe(s) to which you want the Security Bridge to import security settings, and click
Next >>.

14. Specify a filename for the Security Bridge log file and a location where the log file will be saved. You
can use the log file to determine whether or not the Security Bridge is successful in importing the
security settings from PeopleSoft EPM.

15. Click Next >>.

The dialog box displays a preview of the response file that the Security Bridge will use during
execution mode.

16. Click Save, and choose a location where you want to save the response file.
17. Click Next >>.

You have successfully created the response file for the Security Bridge.

18. Click Exit.

Note:
The response file is a Java property file that you can also create and/or modify manually. For more
details, see the “PeopleSoft response file” section.

7.6.5.2 Applying the security settings

To apply the security settings, run the crpsepmsecuritybridge.bat (in Windows) or the
crpsempsecuritybridge.sh file (in UNIX), and use the response file that you created as an
argument. (For example, type crpsepmsecuritybridge.bat (Windows) or crpsempsecurity
bridge.sh (Unix) myresponsefile.properties.)

The Security Bridge application runs. It creates users in Information platform services for the members
of the PeopleSoft roles that you specified in the response file and imports the security settings from
PeopleSoft EPM to the appropriate universes.

7.6.5.2.1 Mapping considerations

During execution mode, the Security Bridge creates a user in Information platform services for each
member of a managed PeopleSoft role.

The users are created to have only Enterprise authentication aliases, and Information platform services
assigns random passwords to these users. As a result, the users cannot log on to Information platform
services until the administrator manually reassigns new passwords or maps the role(s) to Information
platform services through the PeopleSoft Security Plug-in to allow the users to log on by using their
PeopleSoft credentials.
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7.6.5.3 NManaging security settings

You can manage the security settings that you applied by modifying the objects that are managed by
the Security Bridge.

7.6.5.3.1 Managed users

The Security Bridge manages users based on the following criteria:
* Whether or not the user is a member of a managed PeopleSoft role.

* Whether or not the user is a member of the managed Information platform services group.

If you want to enable a user to access PeopleSoft data through universes in Information platform services
, ensure that the user is a member of both a managed PeopleSoft role and the managed Information
platform services group.

+ For members of managed PeopleSoft roles who do not have accounts in Information platform services
, the Security Bridge creates accounts and assigns random passwords to them. The administrator
must decide whether or not to reassign new passwords manually or map the roles to Information
platform services through the PeopleSoft Security Plug-in to allow the users to log on to Information
platform services.

» For members of managed PeopleSoft roles who are also members of the managed Information
platform services group, the Security Bridge updates the security settings that are applied to the
users so that they have access to the appropriate data from the managed universes.

If a member of a managed PeopleSoft role has an existing account in Information platform services ,
but he/she is not a member of the managed Information platform services group, then the Security
Bridge does not update the security settings that are applied to the user. Typically, this situation occurs
only when the administrator manually removes user accounts that have been created by the Security
Bridge from the managed Information platform services group.

Note:

This is an effective method for managing security: by removing users from the managed Information
platform services group, you can configure their security settings to be different from the security settings
that they have in PeopleSoft.

Conversely, if a member of the managed Information platform services group is not a member of a
managed PeopleSoft role, then the Security Bridge does not provide them with access to the managed
universes. Typically, this situation occurs only when PeopleSoft administrators remove users who have
been previously mapped to Information platform services by the Security Bridge from the managed
PeopleSoft role(s).

Note:
This is another method for managing security: by removing users from managed PeopleSoft roles, you
can ensure that the users have no access to data from PeopleSoft.
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7.6.5.3.2 Managed universes

The Security Bridge manages universes through restriction sets, which limit the data that managed
users can access from the managed universes.

Restriction sets are groups of restrictions (for example, restrictions to Query Controls, SQL Generation,
and so on). The Security Bridge applies/updates Row Access and Object Access restrictions for the
managed universes:

+ It applies Row Access restrictions to dimension tables that are defined in PeopleSoft EPM. These
restrictions are user-specific and can be configured to one of the following settings:

»  The user has access to all of the data.

» The user has access to none of the data.

»  The user has access to data based on their row-level permissions in PeopleSoft, which are
exposed through the Security Join Tables (SJT) that are defined in PeopleSoft EPM.

- It applies Object Access restrictions to measure objects based on the fields that are accessed by
the measure objects.

If a measure object accesses fields that are defined as metrics in PeopleSoft, then access to the
measure object is allowed/disallowed depending on whether or not the user can access the referenced
metrics in PeopleSoft. If a user cannot access any of the metrics, then access to the measure object
is denied. If the user can access all of the metrics, then access to the measure object is granted.

As an administrator, you can also limit the data that users can access from your PeopleSoft system by
limiting the number of universes that are managed by the Security Bridge.

7.6.5.4 PeopleSoft response file

The Security Bridge feature of Information platform services operates based on the settings that you
specify in a response file.

Typically, you generate the response file by using the interface that is provided by the Security Bridge
in configuration mode. However, because the file is a Java property file, you can also create or modify
it manually.

This appendix provides information about the parameters that you need to include in the response file
if you choose to generate it manually.

Note:
When you create the file, you must respect the Java property file escaping requirement (for example,
""is escaped as '\I").
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7.6.5.4.1 Response file parameters

The following table describes the parameters that are included in the response file:

The class path for loading the necessary .jar files.
Multiple class paths must be separated by a';' on

both Windows and UNIX.
classpath
The class paths that are needed are for the

com.peoplesoft.epm.pf.jar andthe JDBC
driver .jar files.

The JDBC driver name that is used to connect to
db.driver.name the PeopleSoft database (for example, com.mi-
crosoft.jdbc.sqglserver.SQLServerDriver).

The JDBC connection string that is used to con
nect to the PeopleSoft database (for example,
jdbc:microsoft:sqlserver://vanrdps
ft01:1433;DatabaseName=PRDMO)

db.connect.str

The user name for logging on to the PeopleSoft

db.user.name database.

The password for logging on to the PeopleSoft

db.password database.

The value for this parameter determines whether
the password parameter in the response file is
db.password.encrypted encrypted or not. The value can be set to either
True or False. (If no value is specified, the value
becomes False by default.)

enterprise.cms.name The CMS in which the universes are located.
enterprise.user.name The user name for logging on to the CMS.
enterprise.password The password for logging on to the CMS.
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The value for this parameter determines whether
the password parameter in the response file is
enterprise.password.encrypted encrypted or not. The value can be set to either
True or False. (If no value is specified, the value
becomes False by default.)

The authentication method for logging on to the

enterprise.authMethod CMS.

The managed Information platform services

enterprise.role
group.

Controls the license type when importing users
enterprise.license from PeopleSoft. "0" sets the named user license,
"1" sets the concurrent user license.

The list of managed PeopleSoft roles.

nis aninteger, and each entry occupies a proper-
ty with the peoplesoft.role prefix.

peoplesoft.role.n nis 1 based.

You can use ™' to denote all available PeopleSoft
roles, given that nis 1, and it is the only property
that has peoplesoft.role as the prefix in the re-
sponse file.

The list of universes that you want the Security
Bridge to update.

nis an integer, and each entry occupies a proper-
ty with the mapped.universe prefix.

mapped.universe.n Note:
nis 1 based.

You can use ™' to denote all available universes,
given that nis 1, and it is the only property that
has mapped.universe as the prefix in the re-
sponse file.
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log4j.appender file.File

The log file that is written by the Security Bridge.

*

log4;.

Default log4j properties that are required for log4j
to function properly:

log4j.rootLogger=INFO, file, stdout

log4j.appender.file=org.apache.log4j.RollingFile
Appender

log4j.appender file.layout=org.apache.log4j.Pat
ternLayout

log4j.appender.file.MaxFileSize=5000KB
log4j.appender.file.MaxBackuplndex=100

log4j.appender file.layout.ConversionPattern=%d
[ %-5]1 %c{1} - %m%n

log4j.appender.stdout=org.apache.log4j.Con
soleAppender

log4j.appender.stdout.layout=org.apache.log4;.Pat
ternLayout

log4j.appender.stdout.layout.ConversionPat
tern=%d [ %-5] %c{1} - %m%n

peoplesoft classpath

The class path to the PeopleSoft EPM API .jar
files.

This parameter is optional.

enterprise.classpath

The class path to the Information platform ser-
vices SDK .jar files.

This parameter is optional.
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db.driver.type

The PeopleSoft database type. This parameter
can have one of the following values:

Microsoft SQL Server 2000
Oracle Database 10.1

DB2 UDB 8.2 Fixpack 7
Custom

Custom may be used to specify databases other
than the recognized types or versions.

This parameter is optional.

sql.db.class.location
sql.db.host
sql.db.port
sql.db.database

The location of the SQL Server JDB driver .jar
files, the SQL Server host machine, the SQL
Server port, and the SQL Server database name.

These parameter can be used only if the db.driv-
er.type is Microsoft SQL Server 2000.

These parameters are optional.

oracle.db.class.location
oracle.db.host
oracle.db.port

oracle.db.sid

The location of the Oracle JDBC driver .jar files,
the Oracle database host machine, the Oracle
database port, and the Oracle database SID.

These parameters can be used only if the
db.driver.type is Oracle Database 10.1.

These parameters are optional.

db2.db.class.location
db2.db.host
db2.db.port
db2.db.sid

The location of the DB2 JDBC driver .jar files, the
DB2 database host machine, the DB2 database
port, and the DB2 database SID.

These parameters can be used only if the
db.driver.type is DB2 UDB 8.2 Fixpack 7

These parameters are optional.
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The location, name, and connection string of the
custom.db.class.location custom JDBC driver.

custom.db.drivername These parameters can be used only if the

db.driver.type is Custom.
custom.db.connectStr

These parameters are optional.

7.7 JD Edwards authentication

7.7.1 Overview

To use your JD Edwards data with Information platform services, you must provide the system with
information about your JD Edwards deployment. This information is what allows Information platform
services to authenticate users so that they can use their JD Edwards EnterpriseOne credentials to log
on to Information platform services.

7.7.2 Enabling JD Edwards EnterpriseOne authentication

To allow JD Edwards EnterpriseOne information to be used by Information platform services, Enterprise
needs information on how to authenticate into your JD Edwards EnterpriseOne system.

7.7.2.1 To enable JD Edwards authentication in Information platform services

1. Log on as an administrator to the Central Management Console.
2. From the Manage area, click Authentication.
3. Double-click JD Edwards EnterpriseOne.
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The "JD Edwards EnterpriseOne" page appears. It has four tabs: Options, Servers, Roles, and
User Update.

4. On the Options tab, click Enable JD Edwards EnterpriseOne Authentication check box.

5. Make appropriate changes under New Alias, Update Options, and New User Options according
to your Information platform services deployment. Click Update to save your changes before
proceeding to the Systems tab.

6. Click the Servers tab.

7. In the "JD Edwards EnterpriseOne System User" area, type a database User name and Password
for Information platform services to use to log on to your JD Edwards EnterpriseOne database.

8. Inthe "JD Edwards EnterpriseOne Domain" area, enter the name, host, and port used to connect
to your JD Edwards EnterpriseOne environment, enter a name for the environment and click Add.

9. Click Update to save your changes.

7.7.3 Mapping JD Edwards EnterpriseOne roles to Information platform services

Information platform services automatically creates a group for each JD Edwards EnterpriseOne role
that you map. As well, the system creates aliases to represent the members of the mapped JD Edwards
EnterpriseOne roles.

You can create a user account for each alias that is created.

However, if you run multiple systems, and your users have accounts in more than one of the systems,
then you can assign each user to an alias with the same name before you create the accounts in
Information platform services.

Doing so reduces the number of accounts that are created for the same user in Information platform
services.

For example, if you run a JD Edwards EnterpriseOne test environment and production environment,
and 30 of your users have access to both systems, then only 30 accounts are created for those users.
If you choose not to assign each user to an alias with the same name, then 60 accounts are created
for the 30 users in Information platform services.

However, if you run multiple systems, and user names overlap, then you must create a new member
account for each alias that is created.

For example, if you run your test environment with a user account for Russell Aquino (user name
"raquino”), and you run the production environment with a user account for Raoul Aquino (user name
"raquino”), then you need to create a separate account for each user's alias. If you do not, the two users
are added to the same Information platform services account, and they will not be able to log on to
Information platform services with their own JD Edwards EnterpriseOne credentials.
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7.7.3.1 To map a JD Edwards EnterpriseOne role to Information platform services

Log on as an administrator to the Central Management Console.
From the "Manage" area, click Authentication.

Double-click JD Edwards EnterpriseOne.

In the New Alias Options area, select one of the following options:
- Assign each added alias to an account with the same name

PN~

Select this option if you run multiple JD Edwards EnterpriseOne Enterprise systems with users
who have accounts on more than one system (and no two users have the same user name for
different systems).

+ Create a new account for every added alias

Select this option if you run only one JD Edwards EnterpriseOne, if the majority of your users
have accounts on only one of your systems, or if the user names overlap for different users on
two or more of your systems.

5. In the Update Options area, select one of the following options:
* New aliases will be added and new users will be created

Select this option to create a new alias for every user that is mapped to Information platform
services. New accounts are added for users without Information platform services accounts or
for all users if you selected the Create a new account for every added alias option.

- No new aliases will be added and new users will not be created

Select this option if the role that you want to map contains many users, but only a few of them

will use Information platform services. Information platform services does not automatically create
aliases and accounts for the users. Instead, it creates aliases (and accounts, if required) only for
users when they log on to Information platform services for the first time. This is the default option.

6. In the New User Options area specify how new users are created..

If your Information platform services license is based on users roles, select one of the following
options:

*  New users are created as Bl Viewer

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license agreement.
Users are restricted to access application workflows that are defined for the Bl Viewer role.
Access rights are generally limited to viewing business intelligence documents. This role is
typically suitable for users who consume content through Information platform services
applications.

- New users are created as Bl Analyst
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New user accounts are configured under the Bl Analyst role. Access to Information platform
services applications for all accounts under the Bl Analyst role is defined in the license agreement.
Users can access all applications workflows that are defined for the Bl Analyst role. Access rights
include viewing and modifying business intelligence documents. This role is typically suitable for
users who create and modify content for Information platform services applications.

If your Information platform services license is not based on users roles, select one of the following
options:

*  New users are created as named users.

New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user name
and password. This provides named users with access to the system regardless of how many
other people are connected. You must have a named user license available for each user account
created using this option.

- New users are created as concurrent users.

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time. This
type of licensing is very flexible because a small concurrent license can support a large user
base. For example, depending on how often and how long users access Information platform
services, a 100 user concurrent license could support 250, 500, or 700 users.

The roles that you selected now appear as groups in Information platform services.

7. Click the Roles tab.
8. Under Select a Server, select the JD Edwards server that contains the roles you want to map.

9. Under "Imported Roles", select the roles you want to map to Information platform services and click
<.
10. Click Update.
The roles will be mapped to Information platform services.

7.7.3.2 Remapping consideration

If you add users to a role that has already been mapped to Information platform services, you need to
remap the role to add the users to Information platform services. When you remap the role, the option
to map users as either named users or concurrent users affects only the new users that you added to
the role.

For example, you first map a role to Information platform services with the "New users are created as
named users" option selected. Later, you add users to the same role and remap the role with the "New
users are created as concurrent users" option selected.

In this situation, only the new users in the role are mapped to Information platform services as concurrent
users; the users that were already mapped remain named users. The same condition applies if you
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first map users as concurrent users, and then you change the settings to remap new users as named
users.

7.7.3.3 To unmap a role

Log on as an administrator to the Central Management Console.

From the "Manage " area, click Authentication.

Click the tab for your SAP BusinessObjects Xl Integration for JD Edwards EnterpriseOne solution.
In the "Roles" area, select the role that you want to remove, and click <.

Click Update.

o oODd=

Members of the role will no longer be able to access Information platform services, unless they have
other accounts or aliases.

Note:
You can also delete individual accounts or remove users from roles before you map them to
Information platform services to prevent specific users from logging on.

7.7.4 Scheduling user updates

To ensure changes to your user data for your ERP system are reflected in your Information platform
services user data, you can schedule regular user updates. These updates will automatically synchronize
your ERP and Information platform services users according to the mapping settings you have configured
in the Central Management Console (CMC).

There are two options for running and scheduling updates for imported roles:

» Update roles only: using this option will update only the links between the currently mapped roles
that have been imported in Information platform services. Use this option if you expect to run frequent
updates, and you are concerned about system resource usage. No new user accounts will be created
if you only update roles.

+ Update roles and aliases: this option not only updates links between roles but will also create new
user accounts in Information platform services for new user aliases added to the ERP system.

Note:
If you have not specified to automatically create user aliases for updates when you enabled
authentication, no accounts will be created for new aliases.
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7.7.4.1 To schedule user updates

After you map roles into Information platform services, you need to specify how the system updates
these roles.

1.
2,

Click the User Update tab.
Click Schedule in either the "Update Roles Only" or "Update Roles and Aliases" sections.

Tip:

If you want to run an update immediately click Update Now.

Tip:

Use the "Update Roles Only" option if you would like frequent updates and are concerned about
system resources. It takes the system longer to update both roles and aliases.

The "Recurrence" dialog box is displayed.

. Select an option from the "Run Object" list and provide all the requested scheduling information.

When scheduling an update, you can choose from the recurrence patterns summarized in the
following table:

The update will run every hour. You specify at what time it will

Hourly start, as well as a start and end date.

The update will run every day or run every number of specified
Daily days. You can specify at what time it will run, as well as a start
and end date.

The update will run every week. It can be run once a week or
Weekly several times a week. You can specify on which days and at
what time it will run, as well as a start and end date.

The update will run every month or every several months. You

Monthly can what time it will run, as well as a start and end date.

The update will run on a specific day in the month. You can
Nth Day of Month specify on which day of the month, what time it will run, as well
as a start and end date.

The update will run on the first Monday of each month. You

1st Monday of Month can specify what time it will run, as well as a start and end date.

The update will run on the last day of each month. You can

Last Day of Month specify what time it will run, as well as a start and end date.
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4,

The update will run on a specified day of a specified week of
X Day of Nth Week of the Month | the month. You can specify what time it will run, as well as a
start and end date.

The update will run on the dates specified in a calendar that

Calendar has previously been created.

Click Schedule after you have finished providing the scheduling information.
The date of the next scheduled role update is displayed in the User Update tab.
Note:

You can always cancel the next scheduled update by clicking Cancel Scheduled Updates in either
the "Update Roles Only" or "Update Roles and Aliases" sections.

7.8 Siehel authentication

7.8.1 Enabling Siebel authentication

To allow Siebel information to be used by Information platform services, Enterprise needs information
on how to authenticate into your Siebel system.

7.8.1.1 To enable Siebel authentication in Information platform services

. Log on as an administrator to the Central Management Console.
. From the Manage area, click Authentication.
. Double-click Siebel.

The "Siebel" page appears. It has four tabs: Options, Systems, Responsibilities, and User Update.

On the Options tab, select the Enable Siebel Authentication check box.

. Make appropriate changes under New Alias, Update Options, and New User Options according

to your Information platform services deployment. Click Update to save your changes before
proceeding to the Systems tab.

. Click the Domains tab.
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7. In the Domain Name field enter the domain name for the Siebel system you want to connect to.
8. Under Connection enter the connection string for that domain.

9. Inthe Username area, type a database User name and Password for Information platform services
to use to log on to your Siebel database.

10. In the Password area, enter the password for the user you have selected.
11. Click Add to add the system information to your "Current Domains" list.
12. Click Update to save your changes.

7.8.2 Mapping roles to Information platform services

Information platform services automatically creates a group for each Siebel role that you map. As well,
the program creates aliases to represent the members of the mapped Siebel roles.

You can create a user account for each alias that is created.

However, if you run multiple systems, and your users have accounts in more than one of the systems,
then you can assign each user to an alias with the same name before you create the accounts in
Information platform services.

Doing so reduces the number of accounts that are created for the same user in the program.

For example, if you run a Siebel eBusiness test environment and production environment, and 30 of
your users have access to both systems, then only 30 accounts are created for those users. If you
choose not to assign each user to an alias with the same name, then 60 accounts are created for the
30 users in Information platform services.

However, if you run multiple systems, and user names overlap, then you must create a new member
account for each alias that is created.

For example, if you run your test environment with a user account for Russell Aquino (user name
"raquino”), and you run the production environment with a user account for Raoul Aquino (user name
"raquino”), then you need to create a separate account for each user's alias. If you do not, the two users
are added to the same account, and they will not be able to log on to Information platform services with
their own Siebel eBusiness credentials.

7.8.2.1 To map a Siebel eBusiness role to Information platform services

Log on as an administrator to the Central Management Console.
Click Authentication.
Double-click Siebel eBusiness.

PoOobd-=

In the New Alias Options area, select one of the following options:
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Assign each added alias to an account with the same name

Select this option if you run multiple Siebel eBusiness systems with users who have accounts
on more than one system (and no two users have the same user name for different systems).

Create a new account for every added alias

Select this option if you run only one Siebel eBusiness, if the majority of your users have accounts
on only one of your systems, or if the user names overlap for different users on two or more of
your systems.

In the Update Options area, select one of the following options:
New aliases will be added and new users will be created

Select this option to create a new alias for every user that is mapped to Information platform
services. New accounts are added for users without Information platform services accounts or
for all users if you selected the Create a new account for every added alias option.

No new aliases will be added and new users will not be created

Select this option if the role that you want to map contains many users, but only a few of them
will use Information platform services. The program does not automatically create aliases and
accounts for the users. Instead, it creates aliases (and accounts, if required) only for users when
they log on to Information platform services for the first time. This is the default option.

In the New User Options area specify how new users are created.

If your Information platform services license is based on users roles, select one of the following
options:
New users are created as Bl Viewer

New user accounts are configured under the Bl Viewer role. Access to Information platform
services applications for all accounts under the Bl Viewer role is defined in the license agreement.
Users are restricted to access application workflows that are defined for the Bl Viewer role.
Access rights are generally limited to viewing business intelligence documents. This role is
typically suitable for users who consume content through Information platform services
applications.

New users are created as Bl Analyst

New user accounts are configured under the Bl Analyst role. Access to Information platform
services applications for all accounts under the Bl Analyst role is defined in the license agreement.
Users can access all applications workflows that are defined for the Bl Analyst role. Access rights
include viewing and modifying business intelligence documents. This role is typically suitable for
users who create and modify content for Information platform services applications.

If your Information platform services license is not based on users roles, select one of the following
options:
New users are created as named users.

New user accounts are configured to use named user licenses. Named user licenses are
associated with specific users and allow people to access the system based on their user name
and password. This provides named users with access to the system regardless of how many
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other people are connected. You must have a named user license available for each user account
created using this option.

* New users are created as concurrent users.

New user accounts are configured to use concurrent user licenses. Concurrent licenses specify
the number of people who can connect to Information platform services at the same time. This
type of licensing is very flexible because a small concurrent license can support a large user
base. For example, depending on how often and how long users access Information platform
services, a 100 user concurrent license could support 250, 500, or 700 users.

7. Click the Roles tab.
8. Select the domain that corresponds to the Siebel server you want to map roles for.
9. Under "Available roles", select the roles you want to map and click >.
Note:
You can use the Search Roles Begin With: field to narrow your search if you have a large number

of roles. Enter the characters that the role or roles begin with followed by the wildcard (%) character,
and click Search.

10. Click Update.
The roles will be mapped to Information platform services.

7.8.2.2 Remapping consideration

To enforce group and user synchronization between Information platform services and Siebel, set the
Force user synchronization.

Note:
In order to select Force user synchronization you must first select New aliases will be a